## CONTENTS

### PREFACE 18

### PART 1: GAMEPLAY 19

#### 1. INTRODUCTION 19

#### 2. GETTING STARTED 20

##### 2.1. INSTALLATION 20
- 2.1.1. Minimum System Requirements 20
- 2.1.2. The Installation Process 21
- 2.1.3. File Locations 21
- 2.1.4. Resolving Issues 21
- 2.1.5. Uninstalling the Game 22
- 2.1.6. Game Updates 22
- 2.1.7. Game Forums 23
- 2.1.8. Help and Feedback 23
- 2.1.9. Error Handling 24

#### 3. UNDERSTANDING THE GAME INTERFACE 24

##### 3.1. MAIN MENU 24
- 3.1.1. Settings 24
- 3.1.2. Preferences 25

##### 3.2. NEW GAME 25
- 3.2.1. Choose Side 26
- 3.2.2. Difficulty 26
- 3.2.3. Computer Bonus 27

##### 3.3. OPTIONS 27
- 3.3.1. Multiplayer Options 28
- 3.3.2. View 28
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferences</td>
<td>28</td>
</tr>
<tr>
<td>Artificial Intelligence</td>
<td>30</td>
</tr>
<tr>
<td><strong>Advanced Options</strong></td>
<td>30</td>
</tr>
<tr>
<td>View</td>
<td>30</td>
</tr>
<tr>
<td>Map Text</td>
<td>31</td>
</tr>
<tr>
<td>Preferences</td>
<td>31</td>
</tr>
<tr>
<td>Scripts</td>
<td>32</td>
</tr>
<tr>
<td><strong>In-Game Interface</strong></td>
<td>35</td>
</tr>
<tr>
<td>Left Hand Buttons</td>
<td>35</td>
</tr>
<tr>
<td>Top Row Buttons</td>
<td>36</td>
</tr>
<tr>
<td>Right Hand Buttons</td>
<td>44</td>
</tr>
<tr>
<td>Unit Display</td>
<td>44</td>
</tr>
<tr>
<td>Information Panel</td>
<td>45</td>
</tr>
<tr>
<td><strong>Further Interface Information</strong></td>
<td>48</td>
</tr>
<tr>
<td>National Colors</td>
<td>48</td>
</tr>
<tr>
<td>Glossary of Abbreviations</td>
<td>48</td>
</tr>
<tr>
<td>Symbols On The Map</td>
<td>48</td>
</tr>
<tr>
<td>Terrain Symbols</td>
<td>49</td>
</tr>
<tr>
<td>Resource Symbols</td>
<td>50</td>
</tr>
<tr>
<td>Miscellaneous Symbols</td>
<td>50</td>
</tr>
<tr>
<td>Combat Interface Definitions</td>
<td>51</td>
</tr>
<tr>
<td>Hiding the Interface</td>
<td>52</td>
</tr>
<tr>
<td>Target Types</td>
<td>52</td>
</tr>
<tr>
<td>Evasion</td>
<td>53</td>
</tr>
<tr>
<td>Unit Symbols</td>
<td>54</td>
</tr>
<tr>
<td>Zoom</td>
<td>56</td>
</tr>
<tr>
<td>Right Clicking on a Unit</td>
<td>57</td>
</tr>
<tr>
<td>Reinforcing Units</td>
<td>57</td>
</tr>
<tr>
<td>HQ Attachments</td>
<td>58</td>
</tr>
<tr>
<td>Indicator Sprites</td>
<td>58</td>
</tr>
<tr>
<td>Major Powers’ Flags</td>
<td>58</td>
</tr>
<tr>
<td>Forced March/Naval Cruise</td>
<td>58</td>
</tr>
<tr>
<td>HQ Highlights</td>
<td>59</td>
</tr>
<tr>
<td>Zone of Control Highlights</td>
<td>59</td>
</tr>
</tbody>
</table>
4. 1861 BLUE AND GRAY TUTORIAL

4.1. TURN 1

4.1.1. Select the Campaign
4.1.2. Pop Up Messages
4.1.3. Confederate Turn 1
4.1.4. Surveying the Scene
4.1.5. Decisions
4.1.6. New Units
4.1.7. The Top Left Sidebar
4.1.8. Land Movement
4.1.9. The War at Sea
4.1.10. Research
4.1.11. Ending the Turn

4.2. UNION TURN 2

4.2.1. The European Danger
4.2.2. The Convoy Map
4.2.3. Suspended Convoys
4.2.4. The Advance Continues
4.2.5. The Eastern Theater
4.2.6. Research
4.2.7. Diplomacy
4.2.8. Purchasing Units
4.2.9. Your Turn End

4.3. SUMMER 1861

4.3.1. Crushing the Missouri State Guard
4.3.2. West Virginia
4.3.3. Focus on the Objective
4.4. GENERAL TIPS
4.4.1. Battle for Victory 84
4.4.2. Swapping Units 85
4.4.3. Forced March 85
4.4.4. HQ Settings 85
4.4.5. Transports 86
4.4.6. Reinforcements 87
4.4.7. Elite Reinforcements 88
4.4.8. Rail Movement 89
4.4.9. Upgrading Units 89
4.4.10. Beware of Partisans 90
4.4.11. Next Steps 91

5. GAME ESSENTIALS  91
5.1. KEY AREAS OF GAMEPLAY 91
5.2. HOTKEYS 91
5.3. MAJOR AND MINOR POWERS 92
5.4. INDICATORSprites 93
5.5. ORDERS 93
5.6. UNIT MODES 95
5.7. ZONES OF CONTROL 96
5.8. COMBAT 97
5.9. RAIDING 98
5.10. CONQUERING COUNTRIES 98
5.11. FIGHTING SPIRIT 99
5.12. HQS 99
5.13. SUPPLY RULES 100
5.13.1. General Notes on Supply 100
5.13.2. Viewing Supply 101
5.13.3. Damage to Resources 101
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.14. Partisans</td>
<td>101</td>
</tr>
<tr>
<td>5.15. Maintaining Units' Combat Effectiveness</td>
<td>102</td>
</tr>
<tr>
<td>5.16. Decision Events</td>
<td>102</td>
</tr>
<tr>
<td>5.17. Politics and Diplomacy</td>
<td>102</td>
</tr>
<tr>
<td>5.18. Weather</td>
<td>103</td>
</tr>
<tr>
<td>5.18.1. Rain</td>
<td>103</td>
</tr>
<tr>
<td>5.18.2. Mud</td>
<td>104</td>
</tr>
<tr>
<td>5.18.3. Sandstorms</td>
<td>104</td>
</tr>
<tr>
<td>5.18.4. Snow</td>
<td>104</td>
</tr>
<tr>
<td>5.18.5. Frozen</td>
<td>104</td>
</tr>
<tr>
<td>5.18.6. Storms</td>
<td>104</td>
</tr>
<tr>
<td>5.18.7. Ice</td>
<td>105</td>
</tr>
<tr>
<td>5.19. The Research Mechanism</td>
<td>105</td>
</tr>
<tr>
<td>5.20. Manual Upgrades</td>
<td>105</td>
</tr>
<tr>
<td>5.21. Automatic Upgrades</td>
<td>107</td>
</tr>
<tr>
<td>5.22. Automatic Industrial Mobilization</td>
<td>108</td>
</tr>
<tr>
<td>5.23. Military Production</td>
<td>108</td>
</tr>
<tr>
<td>5.24. Further Gameplay Tips</td>
<td>108</td>
</tr>
<tr>
<td>5.25. Ending a Turn</td>
<td>110</td>
</tr>
<tr>
<td>5.26. Saving a Game</td>
<td>110</td>
</tr>
<tr>
<td>5.27. Exiting the Game</td>
<td>110</td>
</tr>
<tr>
<td>5.28. Winning the Game</td>
<td>110</td>
</tr>
<tr>
<td>5.29. Support</td>
<td>110</td>
</tr>
<tr>
<td><strong>6. MOVEMENT AND COMBAT</strong></td>
<td><strong>111</strong></td>
</tr>
<tr>
<td>6.1. Basics</td>
<td>III</td>
</tr>
<tr>
<td>6.1.1. Turn Activities</td>
<td>111</td>
</tr>
<tr>
<td>6.1.2. Turn Lengths</td>
<td>111</td>
</tr>
<tr>
<td>6.1.3. Visibility</td>
<td>112</td>
</tr>
<tr>
<td>6.2. Moving Units</td>
<td>112</td>
</tr>
<tr>
<td>6.2.1. Indicator Sprites</td>
<td>112</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>6.2.2. Dynamic Movement</td>
<td>113</td>
</tr>
<tr>
<td>6.2.3. Specifying Controlled Movement Paths</td>
<td>113</td>
</tr>
<tr>
<td>6.2.4. Unit Spotting Ranges During Movement</td>
<td>113</td>
</tr>
<tr>
<td>6.2.5. Surprise Contact</td>
<td>114</td>
</tr>
<tr>
<td>6.2.6. Zones of Control</td>
<td>115</td>
</tr>
<tr>
<td><strong>6.3. LAND MOVEMENT</strong></td>
<td>116</td>
</tr>
<tr>
<td>6.3.1. Regular Movement</td>
<td>116</td>
</tr>
<tr>
<td>6.3.2. Rail Movement</td>
<td>116</td>
</tr>
<tr>
<td>6.3.3. Forced March</td>
<td>117</td>
</tr>
<tr>
<td>6.3.4. Swapping Units</td>
<td>117</td>
</tr>
<tr>
<td>6.3.5. The Effect of Terrain on Land Movement</td>
<td>117</td>
</tr>
<tr>
<td>6.3.6. Hex Ownership</td>
<td>118</td>
</tr>
<tr>
<td><strong>6.4. NAVAL MOVEMENT</strong></td>
<td>119</td>
</tr>
<tr>
<td>6.4.1. Regular Movement</td>
<td>119</td>
</tr>
<tr>
<td>6.4.2. Naval Cruise</td>
<td>119</td>
</tr>
<tr>
<td>6.4.3. Surface Raiders</td>
<td>120</td>
</tr>
<tr>
<td>6.4.4. Transport Movement</td>
<td>120</td>
</tr>
<tr>
<td>6.4.5. Amphibious Transports</td>
<td>121</td>
</tr>
<tr>
<td>6.4.6. Amphibious Transports (Long Range)</td>
<td>124</td>
</tr>
<tr>
<td>6.4.7. Submarine Movement</td>
<td>124</td>
</tr>
<tr>
<td>6.4.8. Oceans, Coasts and Rivers</td>
<td>125</td>
</tr>
<tr>
<td><strong>6.5. COMBAT</strong></td>
<td>127</td>
</tr>
<tr>
<td>6.5.1. Combat Predictions</td>
<td>127</td>
</tr>
<tr>
<td>6.5.2. Combat Results</td>
<td>127</td>
</tr>
<tr>
<td>6.5.3. Fighting Spirit Bonus</td>
<td>127</td>
</tr>
<tr>
<td>6.5.4. Land Combat</td>
<td>128</td>
</tr>
<tr>
<td>6.5.5. Naval Combat</td>
<td>131</td>
</tr>
<tr>
<td>6.5.6. Naval Mines</td>
<td>133</td>
</tr>
<tr>
<td>6.5.7. Purchasing Units</td>
<td>135</td>
</tr>
<tr>
<td>6.5.8. New Unit Arrivals</td>
<td>138</td>
</tr>
<tr>
<td>6.5.9. Reinforcing Units</td>
<td>139</td>
</tr>
<tr>
<td>6.5.10. Upgrading Units</td>
<td>140</td>
</tr>
<tr>
<td>6.5.11. Renaming Units</td>
<td>142</td>
</tr>
<tr>
<td>6.5.12. Disbanding Units</td>
<td>142</td>
</tr>
</tbody>
</table>
# 7. ADVANCED GAMEPLAY CONCEPTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.1. General Unit Characteristics</td>
<td>143</td>
</tr>
<tr>
<td>7.2. Combat Target Values</td>
<td>143</td>
</tr>
<tr>
<td>7.3. Headquarters Attachments</td>
<td>144</td>
</tr>
<tr>
<td>7.3.1. HQ Modes</td>
<td>145</td>
</tr>
<tr>
<td>7.4. Building Fortifications</td>
<td>146</td>
</tr>
<tr>
<td>7.5. Surrendering Nations</td>
<td>147</td>
</tr>
<tr>
<td>7.5.1. Surrendering Due to Losing the Capital</td>
<td>147</td>
</tr>
<tr>
<td>7.5.2. Alternative Capitals</td>
<td>147</td>
</tr>
<tr>
<td>7.5.3. Fighting on from Exile</td>
<td>148</td>
</tr>
<tr>
<td>7.5.4. Liberating Capitals</td>
<td>148</td>
</tr>
<tr>
<td>7.5.5. Surrendering Due to Low Fighting Spirit</td>
<td>148</td>
</tr>
<tr>
<td>7.6. Capturing Enemy Supply Centers</td>
<td>149</td>
</tr>
<tr>
<td>7.7. Plunder</td>
<td>149</td>
</tr>
<tr>
<td>7.8. Victory Conditions</td>
<td>150</td>
</tr>
<tr>
<td>7.9. The Game Engine’s Turn Sequence</td>
<td>150</td>
</tr>
<tr>
<td>7.10. Collecting Military Production Points</td>
<td>151</td>
</tr>
<tr>
<td>7.11. Supply</td>
<td>151</td>
</tr>
<tr>
<td>7.12. Resource Definitions</td>
<td>153</td>
</tr>
<tr>
<td>7.12.1. Major Powers’ Capitals</td>
<td>153</td>
</tr>
<tr>
<td>7.12.2. Industrial Centers</td>
<td>153</td>
</tr>
<tr>
<td>7.12.3. Primary Supply Centers</td>
<td>153</td>
</tr>
<tr>
<td>7.12.4. Secondary Supply Centers</td>
<td>153</td>
</tr>
<tr>
<td>7.12.5. Minor’s Capitals</td>
<td>153</td>
</tr>
<tr>
<td>7.12.6. Key Resources</td>
<td>154</td>
</tr>
<tr>
<td>7.13. Maximum Resource Strengths</td>
<td>154</td>
</tr>
<tr>
<td>7.13.1. Connected Resources</td>
<td>154</td>
</tr>
<tr>
<td>7.13.2. Unconnected Resources</td>
<td>154</td>
</tr>
<tr>
<td>7.13.3. Captured but Unconnected Enemy Resources</td>
<td>155</td>
</tr>
<tr>
<td>7.15. Besieging Resources</td>
<td>155</td>
</tr>
</tbody>
</table>
7.16. Port Supply to Land Forces 155
7.17. Artillery with Zero Supply 156
7.18. Raiding when at Zero Supply 156
7.19. Damage to Resources 156
7.20. Industrial Modifier 156
7.21. Unit Production 157
7.22. Reinforcement Costs 159
7.23. The Cost of Upgrading Units 159
7.24. Decision Events 159
7.25. Factors Influencing Combat Effectiveness 160
  7.25.1. Experience 160
  7.25.2. Factors Influencing Action Points 161
  7.25.3. Roads and Supply 161
  7.25.4. HQ Supply 162
  7.25.5. The Supply Value of Low Strength HQs 162
  7.25.6. Reinforcing HQs 162
  7.25.7. Raising HQs’ Minimum Supply Value 162
  7.25.8. Boosting HQ Supply 163
  7.25.9. HQ Supply During Amphibious Invasions 163
7.27. Supply and Action Points Table 164
7.28. Supply & Reinforcements Table 164
  7.28.1. Reinforcing Damaged HQs 165
  7.28.2. Low Supply & Attrition Losses 166
7.29. Morale and Readiness 166
  7.29.1. Morale Losses Due To Movement 167
  7.29.2. Unit Attacks Inflicting Morale Losses 167
  7.29.3. Unit Readiness and Its Effect on Combat 168
  7.29.4. The Effect of Entrenchment on Combat 169
  7.29.5. Gaining Entrenchment 170
  7.29.6. Combat Losses 171
  7.29.7. Variability in the Combat Results 173
7.30. SUPPLY VALUES
7.30.1. Land Units 173
7.30.2. Naval Units 174

8. UNIT TYPES

8.1. LAND UNITS
8.1.1. Target Types 174
8.1.2. Default Maximum Strength 175
8.1.3. Headquarters 175
8.1.4. Regiment 176
8.1.5. Brigade 176
8.1.6. Division/Mountain Division 176
8.1.7. Corps 177
8.1.8. Rangers 177
8.1.9. Marines 177
8.1.10. Engineers 178
8.1.11. Indians 178
8.1.12. Cavalry Units 179
8.1.13. Partisans 179
8.1.14. Field Artillery 180
8.1.15. Siege Artillery 180
8.1.16. Railroad Battery 180
8.1.17. Forts 181
8.1.18. Armored Train 181

8.2. NAVAL UNITS
8.2.1. Resisting Amphibious Invasions 182
8.2.2. Raiding Ports 182
8.2.3. Battleships 183
8.2.4. Cruisers 183
8.2.5. Ironclads 183
8.2.6. Monitors 183
8.2.7. Ships of the Line 184
8.2.8. Frigates 184
8.2.9. Gunboats 184
8.2.10. River Ships 184
8.2.11. Submarines 185
8.2.12. Torpedo Boats 185
8.2.13. Transports 186
8.2.14. Amphibious Transports 186
8.2.15. Amphibious Transports (Long Range) 186
8.2.16. Using Transports and Amphibious Transports 187

9. Research 187

9.1. Introduction 187

9.1.1. In Brief: The Research Mechanism 189

9.2. In Depth: The Research Mechanism 189

9.2.1. Progression every Turn 189
9.2.2. Research Breakthroughs 190
9.2.3. Catch Up Bonus 190
9.2.4. Spying & Intelligence 191
9.2.5. Examples 191

9.3. Viewing Progress 192

9.4. Progressing to the Next Level 193

9.5. Research Limits 193

9.6. Research Categories 193

9.7. Applying Manual Upgrades 194


9.8.1. Infantry Equipment 194
9.8.2. Skirmishers 195
9.8.3. Scouts 195
9.8.4. Cavalry Equipment 195
9.8.5. Field Artillery 196
9.8.6. Heavy Mortars 196
9.8.7. Mobility 196
9.8.8. Buoyancy Tanks 197
9.8.9. Naval Weapons 197
9.8.10. Ironclads 197
9.8.11. Naval Engines 198
9.8.13. Fort Modernization 198

9.9. AUTOMATIC UPGRADES 199
9.9.1. Corps Organization 200
9.9.2. Field Telegraph 200
9.9.3. Leadership 200
9.9.4. Infantry Tactics 200
9.9.5. Cavalry Tactics 201
9.9.6. Naval Tactics 201
9.9.7. Amphibious Warfare 201
9.9.8. Experimental Submarines 202
9.9.9. Experimental Balloons 202
9.9.10. Spying & Intelligence 202
9.9.11. Logistics 203
9.9.12. Production Technology 203
9.9.13. Industrial Technology 204

10. POLITICS AND DIPLOMACY 205
10.1. ALIGNMENT STATUS & MOBILIZATION VALUES 205
10.1.1. Non-Cooperative Majors 205
10.1.2. Minor Combatants 205
10.2. THE DIPLOMATIC MECHANISM 206
10.3. CONTESTED DIPLOMACY 207
10.4. IMPENDING WAR ENTRY 208
10.5. BELLIGERENCE 208
10.6. THE WIDER IMPACT OF DECLARATIONS OF WAR 209
PART 2: DESIGNING YOUR OWN CAMPAIGNS

1. INTRODUCTION

1.1. FIRST THINGS FIRST

1.2. USING THE EDITOR

1.2.1. Editor Help File

1.2.2. The Information Panel

2. MENU BUTTONS

2.1. FILE

2.1.1. File → Creating a New Campaign

2.1.2. File → Open Default Campaign

2.1.3. File → Open User Campaign

2.1.4. File → Saving a Campaign

2.1.5. File → Import Data

2.1.6. File → Export Data

2.1.7. File → Export Map Positions (F6)

2.1.8. File → Export Dates (F7)

2.1.9. File → Exit

2.2. EDIT

2.2.1. Edit → Undo

2.2.2. Edit → Redo

2.2.3. Edit → Lock and Unlock Scroll

2.2.4. Edit → Change Video Mode (F3)

2.2.5. Edit → Refresh Fonts (F4)

2.2.6. Edit → Refresh Bitmaps (F5)

2.3. MAP

2.3.1. General Map Drawing Tips

2.3.2. Map → Edit Hex Layer

2.3.3. Map → Edit Terrain Layer

2.3.4. Map → Edit River Layer

2.3.5. Map → Edit Road Layer

2.3.6. Map → Edit Rail Layer
2.3.7. Map → Edit Resource Layer 221
2.3.8. Map → Edit Symbol Layer 221
2.3.9. Map → Edit Text Layer 221
2.3.10. Map → Edit Unit Layer 221
2.3.11. Map → Edit Weather Layer 221
2.3.12. Map → Edit Naval Layer 222
2.3.13. Map → Edit Map Size 222
2.3.14. Map → Shift Contents 222
2.3.15. Editing Layers 223
2.3.16. Map → Draw 223
2.3.17. Map → Select Item(s) 224
2.3.18. Map → Remove Item(s) 226
2.3.19. Map → Generate Full Map Screenshots (F8) 226
2.3.20. Map → Draw Map Control Values (F9) 227
2.3.21. Map → Draw Land Connection Values (F11) 227
2.3.22. Map → Draw Naval Connection Values (F12) 227

2.4. Campaign 227
2.4.1. Campaign → Edit Campaign Data 227
2.4.2. Campaign → Edit Country Data 230
2.4.3. Setting Key Resources 235
2.4.4. Alphanumeric sort 235
2.4.5. Urban Resources 235
2.4.6. Add/Remove Capitals 236
2.4.7. Campaign → Edit Country Data → Edit Unit Build Data 237
2.4.8. Campaign → Edit Country Data → Edit Unit Cost Data 237
2.4.9. Campaign → Edit Country Data → Edit Production Delay Data 238
2.4.10. Campaign → Edit Country Data → Edit Combat Target Data 238
2.4.11. Campaign → Edit Country Data → Edit Research 239
2.4.12. Campaign → Edit Country Data → Edit Diplomacy 243
2.4.13. Campaign → Edit Country Data → Edit Production Queue 245
2.4.14. Campaign → Edit Country Data → Edit Strength/Reinforce/Reformation Data 246
2.4.15. Campaign → Edit Country Data → Edit Resource Data 246
2.4.16. Campaign → Edit Major Country IDs Data 247
2.4.17. Campaign → Edit Weather Data 247
2.4.18. Campaign → Edit Weather Data → Advanced 248
2.4.19. Campaign → Edit Turn/Economic Data 249
2.4.20. Campaign → Edit Defense Bonus Data 249
2.4.21. Campaign → Edit Movement Cost Data 250
2.4.22. 1. Editing Zone of Control Effects 251
2.4.23. Campaign → Edit Combat Data 251
2.4.24. Campaign → Edit Naval Damage Data 252
2.4.25. Campaign → Edit Morale Data 252
2.4.26. Campaign → Edit Penalties/ Bonuses Data 252
2.4.27. Campaign → Edit AI Scripts 253
2.4.28. Campaign → Edit Event Scripts 253
2.4.29. Campaign → Replicating Layers 253

2.5. Go To → Select Map Position 253

2.6. View 253

2.6.1. View → Mini-Map 253
2.6.2. View → Text 254
2.6.3. View → Sprite Indexes 254
2.6.4. View → Grid 254
2.6.5. View → Borders 254
2.6.6. View → All Layers 254
2.6.7. View → National Colors 254
2.6.8. View → Double Selection Columns 255

2.7. Preferences 255

2.8. Language 255

2.9. Mods 255

2.10. Help 255

2.11. Menu Buttons - Second Row 255

2.11.1. Zoom In/Out 256
3. SCRIPTS, THE AI & GENERAL ADVICE

3.1. EDITING EVENT SCRIPTS

3.1.1. Updating Scripts
3.1.2. Script Templates
3.1.3. Script Flags
3.1.4. Fallsafe Dates
3.1.5. Condition Positions
3.1.6. Convoy
3.1.7. Resource
3.1.8. Supply
3.1.9. Strength
3.1.10. Unit
3.1.11. Free Unit
3.1.12. Partisan
3.1.13. Territory
3.1.14. Annexation
3.1.15. Surrender #1
3.1.16. Surrender #2
3.1.17. War Entry
3.1.18. Mobilization #1
3.1.19. Mobilization #2
3.1.20. Mobilization #3
3.1.21. Mobilization #4
3.1.22. Belligerence
3.1.23. Loop
3.1.24. Victory
3.1.25. Popup
3.1.26. Fighting Spirit
3.1.27. Decision

3.2. EDITING ARTIFICIAL INTELLIGENCE SCRIPTS

3.2.1. Guard
3.2.2. Fortification
3.2.3. Offensive
3.2.4. Amphibious
3.2.5. Transport 269
3.2.6. Amphibious Minor 270
3.2.7. Transport Minor 270
3.2.8. Fleet 270
3.2.9. Purchases 270
3.2.10. Diplomacy 270
3.2.11. Research 270

3.3. Suggestions For Creating a New Campaign 270
3.3.1. Develop a Design 271
3.3.2. Customize Your Campaign 271
3.3.3. Add Your Own Media 273
3.3.4. Playtest Your Campaign 274

3.4. Further Advice & Information 275
3.4.1. Text on the Map Edge 275
3.4.2. Unused Terrain Sprites 275
3.4.3. Design Parameters 275
3.4.4. Testing the AI in Game 276

4. BEYOND THE CIVIL WAR 277
4.1. Unused Units 277
4.2. Convoy Raiders 279
4.3. Research Changes 279

5. CREDITS 280
Fury software 280
Matrix Games 281
PREFACE

Welcome to Strategic Command: American Civil War, where we are taking you back to one of the greatest conflicts of the 19th century!

You will be fighting on our biggest map yet, and the base game comes with six grand campaigns, covering the Civil War from the first shot to the last:

- 1861 Blue and Gray
- 1861 Manassas to Appomattox
- 1862 Scott’s Great Snake
- 1862 Trent War (Alternate History: What if the UK recognized the Confederacy?)
- 1863 Lee Rides North
- 1864 Make Georgia Howl

This game introduces a new addition to the Fury Software team, in the shape of Ryan O’Shea who has designed all the campaigns and written this Manual as well as the all important Strategy Guides! Ryan is a passionate student of this war and his knowledge of its history shines throughout this release.

In addition to thanking Ryan, we would also like to thank Bill Macon who has now joined our team to help with programming.

This game also comes with the same Editor that the official campaigns were designed in, so we look forward to seeing many Mods being developed too.

We hope you have fun playing the game, and of course we do welcome your comments and feedback to help us improve it further!

Hubert Cater, President
“IF IT IS WORTH A BLOODY STRUGGLE TO ESTABLISH THIS NATION, IT IS WORTH ONE TO PRESERVE IT.”

Oliver P. Morton, Governor of Indiana during the Civil War.

1. INTRODUCTION

When the guns thundered around Fort Sumter on the morning of April 12th, 1861, many believed that the rebellion of the seven Southern states would be a mere ninety day affair. Instead, the bloodless battle would be only the first act in what would become the bloodiest conflict to be fought by the United States, a war that forever changed the history of the nation.

In the weeks that followed Fort Sumter’s surrender, the Southern Confederacy would grow from seven states to eleven, and tense standoffs would be seen on the fields and in the halls of state legislatures in an attempt to sway the dwindling numbers of border states onside. Native American tribes would become entangled in the great conflict, some even splitting as members sought to join the ranks of the blue and the gray. In a matter of months, the nation that thirteen years before rode into Mexico City with just 20,000 men now had a million under arms.

The Civil War would herald the beginning of a new era of technological development. For the first time, railroads would be used to organize and transport thousands of men to the battlefield. The telegraph would enable commanders to communicate more quickly with their subordinates. Off the coast of Virginia, the steam-powered ironclad would render the world’s sailing ships obsolete, while experiments with balloons, submarines and machine guns showed what was to come.

Nor was this a solely American affair. Union diplomats persuaded the great powers of Europe to keep out of the war, while the Confederacy gambled on the
idea of King Cotton in an attempt to secure an ally. French Emperor Napoleon III took advantage of the USA’s distraction to launch a military intervention in Mexico, while Spain attempted to reclaim parts of their former empire by occupying the Dominican Republic and fighting a war in the eastern Pacific.

In *Strategic Command American Civil War*, you will take the place of Presidents Abraham Lincoln or Jefferson Davis during these turbulent times. On a map stretching from Maryland to New Mexico, from Canada to the Caribbean, you will lead your troops in one of history’s greatest battles. Victory will come from wisely managing resources and men, fighting on many fronts on land, on the rivers, and at sea. Investment in new technology, careful handling of diplomacy with the powers of Europe, and the use of sound military strategies will be key, but with them, your triumph is assured.

Our Editor can also be used to design your own campaigns, which can be a very fulfilling thing to do. Our games have a thriving modding community and this Editor means you can dive in too! Either to make slight modifications to the official campaigns to suit your own tastes, or to make totally new ones. Details on how to use it are included in Part 2, *Designing Your Own Campaigns*.

---

2. GETTING STARTED

2.1. INSTALLATION

2.1.1. Minimum System Requirements

**CPU:** 2 GHz Processor  
**RAM:** 2 GB  
**OS:** Windows Vista/7/8/10  
**Video Card:** 128 MB DirectX compatible with 32-Bit Color supporting at least 1024 x 768 pixels in height and width. The program will terminate with an error message if your current system does not support these requirements. Please check the Control Panel → Display Options to see if your video settings can be changed.  
**Sound Card:** 16-Bit DirectSound compatible  
**HD:** 1.5 GB free Hard Disk space
2.1.2. The Installation Process

Please ensure that your system meets the minimum requirements listed above.

If you purchased from the Slitherine or Matrix site you will have been provided a download link for the games installer.

Have your Serial Number ready as you will need to enter it as part of the installation process. The Serial Number is included in the order receipt for downloads, or printed on the disk or box for hard copies.

To install the game, either double click on the installation file you downloaded or insert the game’s disk into your drive. Follow all on-screen prompts to complete installation.

Click Finish to close the installer and you are now ready to play!

2.1.3. File Locations

Files will be installed to two separate locations.
The master files and campaigns that come with the game will be installed in the Program Files directory here, unless you change it during installation:

C:\Program Files\Matrix Games\Strategic Command American Civil War

However, all user files, including saves and custom campaigns will be stored in your folder:

\User\Documents\My Games\Strategic Command American Civil War

Where User is the name of your log-in.

Warning: Do not move any files from one location to the other, and certainly do not delete any from the main installation location.

Tip to Modders! When launching the Editor, it has 2 ‘Open Campaigns’ buttons, one for default campaigns and one for custom user made campaigns. In game however, all campaigns will be listed in the same ‘Select Campaign’ screen no matter where they might be located.

2.1.4. Resolving Issues

If you have experienced any issues with installation or when trying to launch or play Strategic Command it is recommended to run the installation utility and/or the game as an Administrator. Either logging in with an Administrator account or using the following steps can achieve this:
1. Right clicking the Shortcut
2. Select Properties
3. On the Shortcut tab select Advanced
4. Then Select the Run as Administrator checkbox.

Should you encounter any problems with the installation or game itself, please visit our Help Desk at www.matrixgames.com/helpdesk or post in our Support Forums at www.matrixgames.com. Please provide as much detail on your issue as you can.

### 2.1.5. UNINSTALLING THE GAME

Please use the Add/Remove Programs option from the Windows Control Panel or the Uninstall shortcut in the game's Windows START menu folder to uninstall the game. Uninstalling through any other method will not properly uninstall the game.

### 2.1.6. GAME UPDATES

In order to maintain our product excellence, Matrix Games releases updates containing new features, enhancements, and corrections to any known issues. All our updates are available free on our website and can also be downloaded quickly and easily by clicking on the Check for Update link in your Game menu or by using the Update Game shortcut in your windows START menu folder for the game.

We also periodically make beta (preview) updates and other content available to registered owners. Keeping up with these special updates is made easy and is free by signing up for a Matrix Games Members Club account. When you are signed up, you can then register your Matrix Games products in order to receive access to these game related materials. Doing so is a simple two step process:

Sign Up for a Matrix Games Members Club account – this is a one time procedure; once you have signed up for a Matrix account, you are in the system and will not need to sign up again.

Go to www.matrixgames.com and click the Members' hyperlink at the top. In the new window, select Register Now and follow the on-screen instructions. When you're finished, click the Please Create my New Account button, and a confirmation e-mail will be sent to your specified e-mail account.
Register a New Game Purchase – Once you have signed up for a Matrix Games Member account, you can then register any Matrix Games title you own in your new account. To do so, log in to your account on the Matrix Games website. Click Register Game near the top to register your new Matrix Games purchase.

If you purchased your game while already logged in, it will be automatically registered for you. We strongly recommend registering your game as it will give you a backup location for your serial number should you lose it in the future.

Once you’ve registered your game, when you log in to the Members’ section you can view your list of registered titles by clicking my Games. Each game title is a hyperlink that will take you to an information page on the game (including all the latest news on that title).

Also on this list is a Downloads hyperlink that takes you to a page that has all the latest public and registered downloads, including patches, for that particular title. You can also access patches and updates via our Games Section at www.matrixgames.com/games, once there select the game you wish to check updates for, then click the Downloads link at the top of the game page.

Certain value content and additional downloads will be restricted to Members Club members. So it is always worthwhile to sign up there. Remember, once you have signed up for a Matrix Games Members Club account, you do not have to sign up again. At that point you are free to register for any Matrix Games product you purchase. Thank you and enjoy your game!

2.1.7. GAME FORUMS
For game related questions and discussions, please visit our Discussion Forum at Matrix Games. We really appreciate feedback, and want to hear from you!

Our forum is also a good place to meet up with other players, to arrange games, discuss changes and see what mods players are producing.

2.1.8. HELP AND FEEDBACK
The best way to contact us if you are having a problem with one of our games is through our help Desk.

Our Help Desk has FAQs as well as a dedicated support staff that answer questions within 24 hours, Monday through Friday. Support questions sent in
on Saturday and Sunday may wait 48 hours for a reply. Visit our help Desk by going to http://www.matrixgames.com/helpdesk

2.1.9. ERROR HANDLING

Should the game ever crash, an “ERROR” folder is created.

The contents of this folder can be found in the following folder with your user name substituted for <USERNAME>:

C: \Users\<USERNAME>\Documents\My Games\Strategic Command American Civil War

If applicable, an ERROR.sav file is created and placed in this folder (i.e., the last known turn and game status before the crash). An errorlog.txt file is also placed in this folder. These files may be helpful for identifying and fixing problems that might arise, and may be sent to support@furysoftware.com for evaluation.

3. UNDERSTANDING THE GAME INTERFACE

3.1. MAIN MENU

When the Main Menu comes up, select the option you wish from the choices available to change settings, start or continue a game against the AI, or to play Multiplayer.

3.1.1. SETTINGS

**Sound Volume** – move the slider to adjust the volume of sound effects. Sliding it to the far left will turn game sounds off.

**Music Volume** – move the slider to adjust music volume. Sliding it to the far left will turn music off.

**Video Mode** – here you can amend the game resolution, and also switch on/off the Full Screen option.

**Mods** – click this to view any downloaded graphical or sound mods. Tick the box on the right to select one; clicking again will deselect it. Press OK when done.
Installing Mods – these must be installed in the USER folder for the game, e.g. Users\<username>\Documents\My Games\Strategic Command American Civil War\Mods

Mods must be installed in the following format:
- Users\<username>\Documents\My Games\Strategic Command American Civil War\Mods\<modfoldername>
- Users\<username>\Documents\My Games\Strategic Command American Civil War\Mods\<modfoldername>\Bitmaps
- Users\<username>\Documents\My Games\Strategic Command American Civil War\Mods\<modfoldername>\Interface etc.

3.1.2. PREFERENCES

Interface Tips – This turns tips on/off when hovering with your mouse over a button.
Alternate Date Format – Changes the format, e.g. from 12. April 1861 to April 12. 1861.

3.2. NEW GAME

Select New Game from the Main Menu to start playing against the AI.

When New Game is selected, a Select Campaign dialog appears which lists the Campaign Name and Start Date for all available campaigns. This dialog orders major campaigns first, followed by any mini-campaigns and then any user made campaigns, should there be any.

As each campaign is selected, additional campaign information is provided for that campaign in the panel on the right that includes:

- Turn Length (Seasonal or Daily)
- Which side Starts
- Turn sequence (Alternate or Simultaneous)
- Whether Production is Normalized*
- The name(s) of the campaign’s creator(s)
- The campaign’s name and a short description
**Normalized Production** ensures that production per time period is more balanced in campaigns with variable seasonal turn lengths. Its effect will be to increase production in winter turns and decrease it in summer turns.

Click on **Play Campaign** to start a selected campaign, **Victory** to review the campaign’s Victory Conditions, or **Cancel** to exit to the Main Menu.

### 3.2.1. Choose Side

When playing against the AI, you will have the option to play as either the Union or Confederate side, and you can select to have one or more of the Majors on your side played by the AI.

Units belonging to any Majors that are set to be controlled by the AI will appear darkened, as though they have already moved. This is just a visual indicator to show that they are AI controlled.

Even if you have set a Major to be AI controlled, there is nothing stopping you from moving any of its units, conducting research, diplomacy etc., the AI will take over any unmoved units and management of affairs once you press end turn.

You can swap sides during a game too! Simply when it’s your turn, go to the Options screen, click to play the opposite side and the AI will immediately take over. You can also turn on or off the AI control of friendly Majors at any time. All of these can be changed an unlimited number of times during a game.

**Note:** A minimum of one Major on your chosen side must be under your control. We strongly recommend that either the Union or Confederacy is under human control, as the entry of other Majors is considered a rare event in the game.

### 3.2.2. Difficulty

Choose a setting to align with the level of challenge you wish to face when playing against the AI.
The Difficulty level defaults to Intermediate, with no bonuses or penalties to the Computer. Use the up/down arrows to choose between Green; Novice; Intermediate; Veteran and Expert.

Higher settings will reward the AI with greater plunder when they conquer countries. Some scripted events will also only occur at the higher difficulty levels, as a way of providing a greater challenge to skilled players.

In addition, the Difficulty levels provide bonuses to the AI’s Spotting, Experience and Military Production Points (MPPs). They do not influence combat formulas.

**Note:** Difficulty Settings can be changed during a game against the AI. So if you find things too easy, or too difficult, modify the settings and continue!

### 3.2.3. Computer Bonus

The Difficulty settings can be fine tuned by clicking on the Computer Bonuses buttons beneath to change the AI’s Spotting, Experience and MPP (i.e. income) bonuses.

After you’ve finished making your selections click on OK to proceed. You will now be taken to the Options screen.

### 3.3. Options

When you start a new game, or load a saved turn, you will be presented with an Options dialog to select basic and advanced game options.

The text for activated options will appear in yellow, deactivated ones in gray. Once a game has begun some options cannot be changed, and these will appear in a darker gray.

Once you have finished reviewing and changing any options from their default settings as desired, click OK to start the game.
3.3.1. Multiplayer Options

In Multiplayer this screen is slightly different as on the right hand side instead of the Artificial Intelligence options, there is a button to turn on/off Quick Animation in Multiplayer Replays. If this is turned on then the replays of your opponents’ turns will be faster. Pressing Pause/Break on your keyboard will pause the replay, and it will continue on pressing Pause/Break for a second time.

**Note:** There is no compulsion to amend any settings, as you can just click OK to play with the default settings.

3.3.2. View

**3-D Units** – Choose to display either three-dimensional unit sprites or NATO counters.

**National Colors** – Display the map with National Colors on/off.

**Last Turn Summary** – Displays a summary of major events that occurred in the last player’s turn. The summary is broken down into three main categories: Combat, Military, and Research. Combat damage reports include convoy raiding and strategic bombing results. Military activity reports include diplomatic results.

**Messages** – Turn the display of scripted messages on/off.

3.3.3. Preferences

**Fog of War** – Play each turn with limited visibility of enemy units on the map.

Full visibility is given to enemy units that are adjacent to a friendly unit; Partial visibility is given to any unit that is located within the spotting range of a friendly unit or resource, while all remaining enemy units are hidden from view unless your units spot them.

Every unit type has a Spotting Range (Land) for spotting enemy land units, and another, Spotting Range (Naval) for enemy Naval units. This is the distance at which they can automatically see enemy units, apart from Silent Submarines, as these won’t be automatically spotted.

The location of enemy Defenses (or “Forts”) will always be known to the other player, as they are immobile and many of them were built before the
beginning of the war. Details such as morale and strength will only be visible when a friendly unit is adjacent to them, just like any other unit.

On land, most infantry units have a Spotting Range of 1 hex and cavalry can spot 3 hexes, while at sea it is normally 1 hex.

Fog of war will also hide resource strengths, the research the enemy has achieved, unit honors, unit production, convoy information, the current balance of MPPs, and Industrial Modifiers.

**Note:** If a Multiplayer game finishes when either one side has attained its Victory Conditions, or time has run out and a stalemate has been reached, passwords are set to null so that items not previously visible under Fog of War can be viewed by both sides.

**Weather** – Play the game with realistic weather effects that affect unit movement and combat.

The map is divided into unique Weather Zones consisting of Temperate, Arid, Frozen or Desert climates. The weather can change in each zone once a turn in accordance with that zone’s settings, the season and the previous turn’s weather.

The current weather in a hex is displayed at the bottom left of the screen. If the weather is fine then merely the Weather Zone type will be shown, e.g. Temperate.

The weather in the various zones can be seen while scrolling the map. The map hexes themselves will also change slightly to reflect the current weather, such as brown hues for Mud, whitened frostings for Snow, and rough seas for Storms at sea. These visuals will also help you to identify changes in the weather.

**Undo Moves** – This option allows you to undo a move providing that move hasn’t disclosed any previously unseen enemy units. It also cannot be used to undo an attack.

**Retreats** – enable/disable the ability for low strength units to retreat when attacked.
3.3.4. Artificial Intelligence

**Show Moves/Combat** – Turn the display of combat during the AI’s turn on/off.

**Quick Animation** – Selecting this speeds up the AI’s turns though you will observe less detail while it is carrying out its actions.

**Messages (AI Turn)** – if unticked, you will not see the Messages that only appear in the AI’s turn.

**Border Style** – Select White, Orange or Black national borders.

**Land Counter Style** – Select your choice of unit bases for land and air units.

**Naval Counter Style** – Select your choice of unit bases for naval units.

Click OK to proceed, Advanced to see further options, or Cancel to return to the Main Menu.

**Note:** Once a unit has expended all its Action Points, it will display a darkened base irrespective of the option chosen above.

3.4. Advanced Options

3.4.1. View

**HQ Attachment Highlights** – Clicking on an HQ highlights in green all the units under that particular HQ’s command. Additionally, when an attached unit is selected, the parent HQ is highlighted in green. If the HQ is in Auto-Assist or Manual Mode then clicking on it highlights in blue any potential units that can be attached to it.

**HQ Names** – Hide or show names on HQ units on the map.

**Enemy Target Highlights** – Clicking on a unit highlights in red all enemy units and resources within its range that can potentially be attacked from its current location.

**Estimated Losses Highlights** – Clicking on a unit displays the predicted combat odds above units that it can attack from its current position.

**Unit Experience Medals** – Hide or show unit experience medals in the unit information box in the lower left of the screen. If this is unticked then the unit experience will show in numeric form.

**Unit Strength Values** – Hide or show unit strength values on the map.

**Resource Strength Values** – Hide or show resource strengths on the map. These include all ports, mines, oil fields, cities and capitals.
Unit / Resource Research Levels – Hide or show research values for units and resources on the map.

Borders – Display the map with national borders on/off.

Fighting Spirit Bars – Hide or display Fighting Spirit Bars in game. These show the current Fighting Spirit status for all Majors.

3.4.2. Map Text

Show Text – If unticked then the Map Text will be hidden.

Show Fighting Spirit Objectives – With this ticked, locations whose capture will provide Fighting Spirit boosts or penalties will be shown with the phrase FS Objective.

Show Key Resources – With this ticked, Key Resources like Capitals, Industrial Centers etc will be labeled as such on the map.

Hide Text During Map Scroll – Hiding the text while scrolling speeds up the scrolling.

Fade In Text After Scroll – If ticked, this will slow the return of text to the screen.

Show Text With Faded Outline – Ticking this will add an outline effect to Map Text.

Scroll(s) Before Text Hides – Here you can set how many scrolls/nudges with the mouse it will take before the Map Text hides. This can be set to a maximum of 50 steps.

3.4.3. Preferences

Research – Untick this to play the game without Research. By default, if a campaign designer has enabled Research in the Editor then it will be selectable as a game option. If Research has not been enabled by the designer then it cannot be enabled here.

Diplomacy – Untick this to play the game without Diplomacy. By default, if a campaign designer has enabled Diplomacy in the Editor then it will be selectable as a game option. If Diplomacy has not been enabled by the designer then it cannot be enabled here.

Production Delay – Leave this ticked to play the game with realistic military production time delays for all unit purchases rather than “instant” builds. The
production delay option means you have to plan ahead and anticipate your future requirements.

**Note:** This option does not apply to Partisans or the three types of Transport, as these appear instantly even if you are playing with a Production Delay. Also, units in the Production Queue at the start of a campaign will arrive on or after the scheduled date regardless of what you decide here.

**Soft Build Limits** – Tick this to play the game with flexible build limits for Major countries to accommodate those “what ifs” of history. By default, a campaign imposes “hard” limits that restrict unit builds to pre-established force pool limits. Each specific unit type for each country will have a certain number of allowable builds.

“Soft” build limits allow you to surpass those limits, but with a penalty applied to each additional unit purchase that exceeds the pre-set limit.

The cost penalty is cumulative for each additional unit. So for example, the penalty may be 10% for the first extra unit, 20% for the second extra unit, and so on. Since reinforcement costs are directly related to current unit costs, the cost penalty is also applied to regular and elite reinforcements.

**Right-Click Unit Action Menu** – If enabled then right-clicking on units will bring up a choice of actions. These are also on the left hand side of the lower information panel. If this is disabled then right-clicking will cancel/deselect the current selection.

**Disable Game End Date** – Tick this to play past the campaign’s default end date. Any Victory scripts set to run only at that date will not fire, however those that are set to run at any time once in game conditions are satisfied will still fire as expected.

### 3.4.4. Scripts

When Scripts is selected from the Advanced options dialog, a dialog appears which lists event names by script type.

A flag (“X”) at the far right of each event name can be used to toggle the event on or off by clicking in its box. If a script is turned off then it won’t show an “X” and it won’t be highlighted.

Scripts that are turned off won’t occur during the game.
These selections can be changed during a game against the computer. For a Hotseat game, changes can only be made when starting the game, never during one.

Changes to activate or deactivate scripts cannot be made in PBEM games, as both parties need to play using exactly the same campaigns in order to avoid any changes that aren't open and agreed by both sides.

The script flags are quite useful for customizing each game for variability, or for providing a handicap if one is desired.

Those that have the letters “DE” in front of them are connected to Decision Events, so it will be best to refer to the list of these in the relevant campaign’s Strategy Guide before turning any off.

By toggling the flags on or off, you can easily customize some elements of a campaign without having to modify it in the Editor.

Note that the flagship 1861 Blue and Gray campaign includes several special Decision Events that control major gameplay elements, such as partisans and European entry, that can be turned on or off with a single click:
- **DE 1000: Disable to Play Without European Entry** turns on or off all events associated with the mobilization of the UK, France and Spain.
- **DE 1001: Disable to Play Without Partisans** turns on or off all events that will spawn partisan units on the map or damage resources. For game balance, if these are turned off, the Union will receive a small MPP penalty when it occupies certain parts of the Confederacy, to represent the costs of garrisons in those areas.
- **DE 1002** and **DE 1003: Disable to Hide All Historical Popups** turns on or off all historical popup events, which have no impact on gameplay but are included as a matter of historical interest, such as the Formation of the predecessor of the Red Cross.
- **DE 1004: Disable to Remove all Strategic Advice Popups** turns on or off all ‘strategic advice’ popups, messages intended to give you advice as you play. These do not directly impact gameplay.
- **DE 1005: Disable to Hide Diplomatic Warning Popups** turns on or off a set of messages that inform players when the UK, France and Spain reach the mobilization threshold of 30%, and every 10% thereafter. These do not directly impact gameplay.

Click OK to return to the Advanced options when done.

### 3.4.4.1. Options in Multiplayer

Unlike a game against the AI where you have the option to change settings during the game, all Multiplayer games have some of their set-up options, e.g. Fog of War, Undo Moves and Weather, locked in place for the duration of the game.

However, things that will not affect the balance of the game itself, such as the icons displaying, can be modified at any time during the game.

### 3.4.4.2. Taskbar Icon

When playing, a *Strategic Command* Taskbar icon is added to the system tray located at the bottom right hand corner on most systems.
If playing against the AI, the icon will flash when the AI has finished its turn.

Note that you can generally use Alt-Tab to switch out of a game, so you can do something else while you are waiting for the AI, but you cannot switch back until the AI has finished. The game is not frozen; it is just completing its tasks before it will pop back up. Waiting for the Taskbar icon to start flashing will avoid any delay.

3.5. The In-Game Interface
3.5.1. Left Hand Buttons

The flags of the active Major countries on your side show at the top left of the screen. Beneath each one’s flag you will see the number of Military Production Points (MPPs) it currently has available, followed by its Mobilization %:

If a Major’s flag is selected then its flag, name and MPP status will appear in the top row starting from the top left corner, to signify that it is this country that is currently selected.

Clicking on the smaller flags (not the large one in the top left corner) will take you to that country’s capital on the map. Right clicking on the flag will bring up the Production table which shows units currently scheduled to be available for deployment during the game.

Hovering your mouse over the smaller flags will display more information on that Major, including its Fighting Spirit value, Industrial Modifier and the Majors it is currently at war with.

Major countries whose Mobilization % is less than 100% cannot yet play an active role in the war, though you can move their units, conduct research, and make some preparations for when they will enter the war.
3.5.2. Top Row Buttons

3.5.2.1. War Maps

In order to attack a neutral country it is necessary to declare war on it.

To do this select the War Maps button at the top of the screen or use the \textbf{Ctrl-M} Hotkey. This will bring up a map which shows flags in the locations of the capitals for all countries that haven’t yet surrendered. Countries currently at war with you will display a pair of crossed sabers instead of a flag.

Click on the \% button to view the Mobilization status of any neutrals. This shows how close they are to joining one side or the other, with pro-Union countries (a term that here extends to other entities that function as countries in the game, such as border states) being highlighted in blue and pro-Confederate countries in red.

Unless declared war upon, or entering the war via a scripted event, when countries reach 100% they will join the relevant side at the end of their opposing side’s turn.

3.5.2.2. How to Declare War

Select which of your Majors is declaring war by clicking on their flag in the bottom left beneath the map display.

Now click on the target country’s flag on the map itself. Icons displaying the targeted country’s resources at the bottom of the screen will now appear, showing an indication of the potential worth of conquering this country.

\textbf{Tip!} If you click on the map it will zoom in. This can be very useful when the flags are close together.

To make the declaration of war, now click on the Declare War button at the bottom left. A warning message will come up, where you can either confirm the declaration or cancel it. Click on Close to return to the main game screen.

As declarations of war can trigger political reactions, any applicable ones from your declaration of war will now take place.

Only Majors that are at 100% Mobilization can declare war, and you cannot declare war on any Majors that are on your side.
Note: Some nations represented on the map cannot be attacked or otherwise interacted with for historical reasons (such as Guatemala or the Dakota Territory). The declare war button will be grayed out if one of these nations is selected.

3.5.2.3. The Strategy Map and Convoy Map
While in the War Maps area, you can also review the Strategy Map and Convoy Map by clicking on their relevant buttons on the right.

The Strategy Map is a zoomed out map of the theater covered by the campaign, showing the locations of all friendly units, and all known locations of enemy units. If you click on the Strategy map you will return to the gaming area, in the location of the map where you clicked.

Click on Close to return to the previous screen, and then Close again to exit the War Maps area.
3.5.2.4. Purchase

Units may be purchased at any time during your turn by selecting Purchase from the button at the top of the screen, or using the Ctrl-P Hotkey.

Select the Major’s flag that you wish to purchase units for at the top. Under the Select Country heading, both that Major and any Minors subordinate to it will show.

You can review the various unit types available for each country by clicking on them in the Select Unit column.

If the unit type is available for production and you have sufficient MPPs it will be shown in white text. If you do not have sufficient MPPs then the text will be gray, while if it is not currently available it will be shown in red. This could be due to the Build Limit not yet having been reached, or because the date when this unit type becomes available for purchase hasn’t yet been reached.

If the latter is the case, when you click on any units in red the date when it will become available for purchase will be displayed underneath the unit icon.

The number in brackets to the right of each unit type represents the number that can be purchased, while the right hand number under the heading PD represents the Production Delay.

The Production Delay is the number of months it will take from purchase for the unit to be prepared and ready for battle.

So in the example overleaf, the Union can purchase 18 more Divisions, and after purchasing 1 we will have to wait 3 months before it will be ready to be deployed:

A graphical representation of the selected unit type appears in the top middle of the screen, along with the MPP cost of the unit. Available MPPs are shown in the top right, so you can consider whether this purchase is within your budget.

Named units are shown to the right of this column. With HQ units, the commander’s rating is shown in brackets after its name, with higher numbers representing better commanders.

Tip! Excluding Partisans, Land units that are destroyed at supply 5 or higher are cheaper to buy back and will be ready in half the indicated time. The names of these units will have an asterisk after their name, and it is strongly
recommended to purchase these units first. In all default American Civil War campaigns, this ability only extends to those units that have names (such as Divisions), and not to unnamed units such as Artillery.

The Combat Values of all unit types are shown on the right hand side of the screen, so you can review these when considering which to purchase.

In the bottom right of the screen any available upgrades for the selected unit will be shown. Clicking on the up arrow(s) to apply these will increase both the cost and Combat Values of the unit, and this will be reflected both underneath the unit icon and also in the Combat Values area above.

When you have made your selection, click on the Purchase button in the bottom center to purchase the unit.

When you have completed reviewing this screen and/or making purchases, click Close at the bottom right to leave this area.
3.5.2.5. Production

To view units that are currently scheduled to arrive during the game, click on the Production button in the bottom right. This will show all units due to arrive for the selected Major and its Minors, their arrival dates and location (if applicable). To select a different Major, click on its flag at the top.

Note: Units due to deploy by script, e.g. ones mentioned in Decision Events, will not appear in the Production table.

When you’ve finished reviewing this area, click OK at the bottom to return to the previous screen.

3.5.2.6. New Units

When new units are available for deployment this button will be highlighted, whereas when none are available, or if there are no viable locations to deploy any units, then it is grayed out.

When the button is highlighted, click on it to bring up the details of any units that are now available for deployment. If there is more than one unit available, select the one you wish to deploy and click OK.

Units can generally only deploy in their home country, so the screen will automatically take you to the Capital of the country whose unit you have selected to deploy. Unlike previous entries in the Strategic Command series, in American Civil War units can only be deployed in Cities, Major Cities, and Capitals.

The locations where you can deploy this unit will be highlighted as per the example below:

Left click on one of the highlighted hexes to deploy the unit.

It isn’t necessary to deploy any or all new units this turn, and if you don’t wish to deploy them just
click Cancel. However, there is rarely anything to be gained from delaying deploying any units, so it is generally recommended to deploy units in the turn they become available.

3.5.2.7. DIPLOMACY
Select Diplomacy or use Ctrl-D to bring up the Diplomacy dialog. This is where you can attempt to influence neutral powers to swing your way.

Every Major that has entered the war has a number of chits, and these can be invested for a cost in MPPs. Each invested chit then has a small % chance per turn of swinging the targeted country towards your side. The more chits you invest, the greater the % chance.

In the countries list on the left hand side, neutral Majors will be listed first, followed by all neutral Minors, in alphabetical order. Note that the term “countries”, here and elsewhere in this manual, extends to other powers such as the border states and Indian tribes.

To the right of their name will be an icon denoting their leaning and which Major with the same leaning they would be subordinate to if they were to enter the war. For instance, Osage shows the Union flag as it would be a Union Minor were it to join the Union’s side in the war.

The % column shows their current Mobilization value towards the side that the icon denotes.

Select the flag of the Major that you wish to carry out some diplomacy. Its flag will now have a green border around it. Your available MPPs and Diplomacy chits (Influence Remaining) are shown in the top right.

Now click on a country that you may wish to attempt to influence. The cost of investing against a given country will be displayed, and this will vary as neutral Majors are more expensive to invest diplomacy in than Minors.

The % chance of a diplomatic success per chit per turn is shown in the middle of the screen. If multiple chits have been invested, whether by one or more of your Majors, then a cumulative % chance of success will be shown. This is the % chance of success every turn.

To invest a diplomacy chit, click on the “up” button in the middle of the screen, and click Yes on the confirmation message that comes up to proceed.
Note: if you are designing your own campaign, it is possible to limit the number of chits that may be invested into a particular country, representing a nation’s historic neutrality or reluctance to enter the war. This feature is not used in American Civil War’s default campaigns.

You can also declare war from the Diplomacy screen. To do this, select the Major that is to declare war, click on the country you wish to attack, and then press the Declare War button at the bottom. Confirm your declaration by clicking Yes.

Click on OK to return to the main game screen.

3.5.2.8. Influencing Major Powers
Neutral Major powers can be influenced diplomatically, but they will not switch sides. Thus Union diplomacy against the UK could at best help to slow the UK’s entrance into the war, perhaps to the point that they never enter the war on either side, but the UK will never become pro-Union.

3.5.2.9. Research
Research may be conducted at any time during game play by clicking on the Research tab or pressing Ctrl-R.

Only Major countries can conduct research, and there are two types of research categories: Manual and Automatic. Manual categories occupy all of the left hand column, Automatic the right hand column.

Manual categories mean that you apply the research successes individually to your units and resources by upgrading them. This allows you to decide where these upgrades are most needed and to target your income accordingly where it matters.

Automatic categories mean that you benefit immediately from successes in those categories without having to manually upgrade any units or resources.

Selecting one of the Major country flags at the top of the Research dialog will set the screen to display that country’s research fields.

Available MPPs for investment are shown at the top right, along with the current number of MPPs invested. At the bottom right you can see the maximum number of MPPs that can be invested in research at any period of the game.
To the right of each category you can see in order:

- The cost per chit
- The number of chits currently invested
- Up/Down buttons for investing or reclaiming chits.
- Your current level of research*
- The maximum level that can be attained*

* If these appear in red then the maximum level has already been attained.

To invest in a category, click on the yellow “up” button. If this isn’t showing in yellow then no research is possible in this category. You can invest as many chits into a category as are allowed, providing you have sufficient MPPs. If a category isn’t available for research, then its name will appear as N/A.

### 3.5.2.10. Research Tooltips

Providing Interface Tips is turned on, hover your mouse over the name of each research category and a description of that category will appear in the panel at the bottom left.

Those categories that are already invested in will appear with a black outline surrounding the category name box. If progress has been made towards researching the next level, then a green bar will be present within that box, giving a visual representation of progress.

By hovering your mouse over the names of the categories that you are currently researching, you will see your current research progress as a %.

### 3.5.2.11. Reclaiming Chits

To reclaim an invested chit, click on a yellow “down” button. You will regain 50% of the chit’s cost in MPPs. It is best to only do this in extreme situations where MPPs are desperately needed for other tasks.

### 3.5.2.12. The Research Table

Select Table at the bottom of the screen to bring up the Research Table dialog. This table summarizes the current research levels attained by all friendly Majors. If Fog of War is turned off then enemy research levels will also be displayed.
Tip! See The Research Mechanism in Chapter 8 for more details on how research works.
Click on OK at any time to return to the Game Menu.

3.5.2.13. REPORTS
Click on the Reports button to see charts, tables and graphs displaying income, losses and overall investment in categories such as Research and Diplomacy since the start of the game.

3.5.3. RIGHT HAND BUTTONS
End Turn – click this red button to end your turn.
Options – this brings up the Options screen.
Info – This brings up the following buttons:
  Hotkeys – this brings up a list of the game’s Hotkeys.
  User Manual – this brings up the Game Manual.
  Strategy Guide – this brings up the campaign’s Strategy Guide.
  Victory – this brings up the campaign’s Victory Conditions.
Save – save the turn. This allows you to continue at a later time.
Quit – to exit the game.

3.5.4. UNIT DISPLAY
All friendly units and any enemy units adjacent to yours will display information on and around their graphical representation.

  From the left there is the Activation icon, then their strength, and to the right of their strength value their research upgrade levels, if applicable, will be displayed.

  These research numbers are in order from left to right, so its first upgrade category will show on the left, with a second or third if applicable showing to its right.

  As a unit gains experience, white dots representing each full experience point will appear above its strength value:
3.5.5. INFORMATION PANEL

This panel at the bottom of the screen will display unit, terrain and resource information as you hover your mouse over features on the map.

Click on the mini-map in the middle of this panel to jump to different parts of the map. This is a very quick and useful way of moving around the playing area.

Providing you don’t have anything selected on the map, the panels to either side of the mini-map will display information on the hex your mouse is currently hovering over.

If you select a unit by left-clicking on it, or if you merely hover your mouse over it (providing you don’t already have one selected) then information on that unit will be displayed in the left hand panel.

With one of your units selected, if you hover your mouse over an enemy unit then providing it is within your attack range, information on the enemy unit will display in the right hand panel.

If you hover your mouse over an enemy held resource whose strength is hidden by Fog of War, the display will show the MPP value per strength point of this resource. This gives you an idea as to the value of the resource, without giving away its actual strength.

3.5.5.1. COMBAT PREDICTIONS
With a friendly unit selected and the mouse hovered over an enemy unit in attack range, the mini-map will disappear and be replaced by a Combat Predictions panel. This shows the likely casualties should you attack this unit with your currently selected unit. In the example below the prediction is for the attacker to suffer 4 points of damage and the defender 6.

Given the unpredictable nature of combat, actual results may vary by 1 damage point in either direction.

The Combat Predictions panel also displays factors impacting on the combat result, such as launching a Prepared Attack and attacking across a river. These are both included in the example above, where they are represented by a pair of muskets for the Prepared Attack, and a wavy symbol for attacking across a river.

The abbreviations shown in the panel represent the following (some of which will definitely not be seen in any of our official American Civil War campaigns):

- SA Soft Attack
- IA Infantry Attack
- CA Cavalry Attack
- ARTA Artillery Attack
- FA Fort Attack
- ATA Armored Train Attack
- TA Tank Attack
- FTRA Fighter Attack
- BMRA Bomber Attack
- BA Balloon Attack
- ICA Ironclad Attack
- WA Wooden Ship Attack
- CVA Carrier Attack
- SUA Sub Attack
- TRNA Transport Attack
- AAA Anti-Aircraft Attack
- RESA Resource Attack
- SD Soft Defense
<table>
<thead>
<tr>
<th>ID</th>
<th>Infantry Defense</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD</td>
<td>Cavalry Defense</td>
</tr>
<tr>
<td>ARTD</td>
<td>Artillery Defense</td>
</tr>
<tr>
<td>FD</td>
<td>Fort Defense</td>
</tr>
<tr>
<td>ATD</td>
<td>Armored Train Defense</td>
</tr>
<tr>
<td>TD</td>
<td>Tank Defense</td>
</tr>
<tr>
<td>FTRD</td>
<td>Fighter Defense</td>
</tr>
<tr>
<td>BMID</td>
<td>Bomber Defense</td>
</tr>
<tr>
<td>BD</td>
<td>Balloon Defense</td>
</tr>
<tr>
<td>ICD</td>
<td>Ironclad Defense</td>
</tr>
<tr>
<td>WD</td>
<td>Wooden Ship Defense</td>
</tr>
<tr>
<td>CVD</td>
<td>Carrier Defense</td>
</tr>
<tr>
<td>SUD</td>
<td>Sub Defense</td>
</tr>
<tr>
<td>TRND</td>
<td>Transport Defense</td>
</tr>
<tr>
<td>AAD</td>
<td>Anti-Aircraft Defense</td>
</tr>
<tr>
<td>RESD</td>
<td>Resource Defense</td>
</tr>
</tbody>
</table>

### 3.5.5.2. Information Panel Buttons

Above the panels are some handy buttons for making your gaming easier!

In the middle are Previous and Next unit buttons. Use these to scroll through your forces. These buttons scroll by unit type, so for example, if you have a Naval unit selected, the next/previous unit will be another Naval unit.

**Note:** These buttons will not work for AI controlled units on your turn.

The buttons alongside the Previous and Next unit buttons will also display tool-tips if you hover your mouse over them. Many of these are alternatives to either using the game’s Hotkeys, or to save you having to right-click on units or resources to carry out actions.

The Upgrade and Reinforce buttons on the right hand side are among the most useful. If you select one and then hover your mouse over your units, the tool icon will change to orange and a cost (in MPPs) will display for upgrading or reinforcing them, depending on the one selected. This is the quickest way of upgrading or reinforcing large numbers of units.
3.6. Further Interface Information

3.6.1. National Colors

Each Major and their associated Minors has a unique color on the map that represents the territory they control.

When units are selected, their names will also appear in their respective National Color, and this has the advantage of showing at a glance which Major a Minor is subordinate to, i.e. Choctaw unit names are in gray, matching their status as a Minor to the Confederacy.

<table>
<thead>
<tr>
<th>Confederacy</th>
</tr>
</thead>
<tbody>
<tr>
<td>UK</td>
</tr>
<tr>
<td>France</td>
</tr>
<tr>
<td>Spain</td>
</tr>
<tr>
<td>Union</td>
</tr>
<tr>
<td>Mexico</td>
</tr>
</tbody>
</table>

3.6.2. Glossary of Abbreviations

**IM** – Industrial Modifier

**FS** – Fighting Spirit

**FS Objective** – Fighting Spirit Objective

**MPPs** – Military Production Points

3.6.3. Symbols On The Map

Each type of terrain or resource can have several different properties depending upon its type. These can be movement penalties, defense bonuses or penalties, and additionally for resources, supply and income values.
### 3.6.4. Terrain Symbols

<table>
<thead>
<tr>
<th>Terrain</th>
<th>Symbol</th>
<th>Terrain</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>River</td>
<td><img src="image1" alt="River" /></td>
<td>Bush</td>
<td><img src="image2" alt="Bush" /></td>
</tr>
<tr>
<td>Major River</td>
<td><img src="image3" alt="Major River" /></td>
<td>Field</td>
<td><img src="image4" alt="Field" /></td>
</tr>
<tr>
<td>Lake</td>
<td><img src="image5" alt="Lake" /></td>
<td>Bocage</td>
<td><img src="image6" alt="Bocage" /></td>
</tr>
<tr>
<td>Major Lake</td>
<td><img src="image7" alt="Major Lake" /></td>
<td>Oasis</td>
<td><img src="image8" alt="Oasis" /></td>
</tr>
<tr>
<td>Marsh</td>
<td><img src="image9" alt="Marsh" /></td>
<td>Desert</td>
<td><img src="image10" alt="Desert" /></td>
</tr>
<tr>
<td>Forest</td>
<td><img src="image11" alt="Forest" /></td>
<td>Depression</td>
<td><img src="image12" alt="Depression" /></td>
</tr>
<tr>
<td>Jungle</td>
<td><img src="image13" alt="Jungle" /></td>
<td>Road</td>
<td><img src="image14" alt="Road" /></td>
</tr>
<tr>
<td>Hill</td>
<td><img src="image15" alt="Hill" /></td>
<td>Dirt Road</td>
<td><img src="image16" alt="Dirt Road" /></td>
</tr>
<tr>
<td>Mountain</td>
<td><img src="image17" alt="Mountain" /></td>
<td>Rail</td>
<td><img src="image18" alt="Rail" /></td>
</tr>
<tr>
<td>High Mountain</td>
<td><img src="image19" alt="High Mountain" /></td>
<td>Navigable River</td>
<td><img src="image20" alt="Navigable River" /></td>
</tr>
</tbody>
</table>

**Note:** Empty islands do not contain a source of supply and cannot serve as a base, so if any exist on a map then units should not land in these islands as they will become stranded there.
3.6.5. Resource Symbols

<table>
<thead>
<tr>
<th>Resource</th>
<th>Image 1</th>
<th>Image 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oil</td>
<td><img src="image1" alt="Image" /></td>
<td><img src="image2" alt="Image" /></td>
</tr>
<tr>
<td>Capital</td>
<td><img src="image3" alt="Image" /></td>
<td><img src="image4" alt="Image" /></td>
</tr>
<tr>
<td>Mine</td>
<td><img src="image5" alt="Image" /></td>
<td><img src="image6" alt="Image" /></td>
</tr>
<tr>
<td>Major Capital</td>
<td><img src="image7" alt="Image" /></td>
<td><img src="image8" alt="Image" /></td>
</tr>
<tr>
<td>Settlement</td>
<td><img src="image9" alt="Image" /></td>
<td><img src="image10" alt="Image" /></td>
</tr>
<tr>
<td>Fortress</td>
<td><img src="image11" alt="Image" /></td>
<td><img src="image12" alt="Image" /></td>
</tr>
<tr>
<td>Town</td>
<td><img src="image13" alt="Image" /></td>
<td><img src="image14" alt="Image" /></td>
</tr>
<tr>
<td>Major Fortress</td>
<td><img src="image15" alt="Image" /></td>
<td><img src="image16" alt="Image" /></td>
</tr>
<tr>
<td>Fortified Town</td>
<td><img src="image17" alt="Image" /></td>
<td><img src="image18" alt="Image" /></td>
</tr>
<tr>
<td>Fortification</td>
<td><img src="image19" alt="Image" /></td>
<td><img src="image20" alt="Image" /></td>
</tr>
<tr>
<td>City</td>
<td><img src="image21" alt="Image" /></td>
<td><img src="image22" alt="Image" /></td>
</tr>
<tr>
<td>River Port</td>
<td><img src="image23" alt="Image" /></td>
<td><img src="image24" alt="Image" /></td>
</tr>
<tr>
<td>Major City</td>
<td><img src="image25" alt="Image" /></td>
<td><img src="image26" alt="Image" /></td>
</tr>
<tr>
<td>Port</td>
<td><img src="image27" alt="Image" /></td>
<td><img src="image28" alt="Image" /></td>
</tr>
</tbody>
</table>

3.6.6. Miscellaneous Symbols

**Convoy Routes** – active Union convoys are shown in blue, Confederate ones in red, and all inactive convoys in white. Here are some Confederate convoys heading from Blockade Runner ports in the Bahamas to the Confederacy:

**Raiding Locations** – place naval units on these locations to damage your opponent’s economy.

**Loops** – units placed on these locations will transfer to a new location after a short delay, as per the description on the map.
Information – these hexes are important for certain game effects. Mousing over them will provide further details.

Stars – these hexes are important for certain game effects. In the default campaigns, red stars indicate the locations of Victory Objectives that will determine who wins the game.

Flags – these hexes are important for certain game effects, usually related to the mobilization of that nation.

State Borders – marks the locations of state borders on the game map. This has no direct impact on gameplay.

3.6.7. Combat Interface Definitions

Across River Combat Penalty – 20% Reduction in Readiness when units attack across a River.

Across Major River Combat Penalty – 35% Reduction in Readiness when units attack across a Major River. This applies to both the 'Major River' terrain feature, and the large navigable rivers (made up of Land+Sea hexes, such as the Mississippi).

Hidden Attacker Readiness Bonus – 15% boost in Readiness for hidden units that the enemy stumbles upon without having seen them first.

Prepared Attack Readiness Bonus – 40% boost in Readiness for units attacking before moving (50% if the attacking unit is attached to an HQ with a Rating greater than or equal to 8). Note that this has been significantly increased when compared with our previous games.
3.6.8. HIDING THE INTERFACE

Press F4 on your keyboard to hide the Interface. Press it again or deselect a unit or resource and the Interface will reappear.

3.6.9. TARGET TYPES

Every unit has Attack and Defense values relating to the following Target Types:

- Soft
- Infantry
- Cavalry
- Artillery
- Fort
- Armored Train
- - (this is an unused slot)
- - (this is an unused slot)
- - (this is an unused slot)
- Balloon
- Ironclad
- Wooden (Ship)
- - (this is an unused slot)
- Sub
- Transport
- - (this is an unused slot)
- Resource

Each unit also has the following values:

- Spotting (Land)
- Spotting (Naval)
- Action Points
- Operational Range
- Intercept Range
- Escort Range
- Attack Range
- Min Shells
- Max Shells
- De-Entrenchment
- De-Moralization
- Interceptions
- Escorts
- Attacks
- % Attacking
- % Defending
- Raid Multiplier (MPPs)
- Enemy FS Losses (Per Raid)
- Attack
- Defense
- Defense Bonus
- Max Entrench

### 3.6.10. Evasion

Some unit types can evade damage when they are engaged in combat. For example, ships will not receive any damage when bombarding most land units, while some units will have a small chance of evading damage when they are attacked.

Here are the unit types affected, including their % chance to avoid suffering casualties for every combat they are engaged in. Note that some research categories may increase these percentages.

<table>
<thead>
<tr>
<th>WHEN ATTACKING</th>
<th>% EVASION CHANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Artillery, Siege Artillery, Railroad Batteries, Defenses, Blockhouses and Armored Trains</td>
<td>100%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>WHEN BOTH ATTACKING &amp; DEFENDING</th>
<th>% EVASION CHANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rangers</td>
<td>25%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>WHEN DEFENDING</th>
<th>% EVASION CHANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transports (not Amphibious)</td>
<td>10%</td>
</tr>
<tr>
<td>Submarines</td>
<td>0% (25% with the Buoyancy Tanks upgrade)</td>
</tr>
</tbody>
</table>
3.6.11. **UNIT SYMBOLS**

Not all the units listed here are available in every campaign.

<table>
<thead>
<tr>
<th>UNIT TYPE</th>
<th>3-D SYMBOL</th>
<th>NATO ICON</th>
</tr>
</thead>
<tbody>
<tr>
<td>HQ</td>
<td><img src="image" alt="HQ Icon" /></td>
<td><img src="image" alt="HQ Icon" /></td>
</tr>
<tr>
<td>Regiment</td>
<td><img src="image" alt="Regiment Icon" /></td>
<td><img src="image" alt="Regiment Icon" /></td>
</tr>
<tr>
<td>Brigade</td>
<td><img src="image" alt="Brigade Icon" /></td>
<td><img src="image" alt="Brigade Icon" /></td>
</tr>
<tr>
<td>Division</td>
<td><img src="image" alt="Division Icon" /></td>
<td><img src="image" alt="Division Icon" /></td>
</tr>
<tr>
<td>Corps</td>
<td><img src="image" alt="Corps Icon" /></td>
<td><img src="image" alt="Corps Icon" /></td>
</tr>
<tr>
<td>Mountain Division</td>
<td><img src="image" alt="Mountain Division Icon" /></td>
<td><img src="image" alt="Mountain Division Icon" /></td>
</tr>
<tr>
<td>Rangers</td>
<td><img src="image" alt="Rangers Icon" /></td>
<td><img src="image" alt="Rangers Icon" /></td>
</tr>
<tr>
<td>Marines</td>
<td><img src="image" alt="Marines Icon" /></td>
<td><img src="image" alt="Marines Icon" /></td>
</tr>
<tr>
<td>Engineers</td>
<td><img src="image" alt="Engineers Icon" /></td>
<td><img src="image" alt="Engineers Icon" /></td>
</tr>
<tr>
<td>Indians</td>
<td><img src="image" alt="Indians Icon" /></td>
<td><img src="image" alt="Indians Icon" /></td>
</tr>
<tr>
<td>Cavalry Brigade</td>
<td><img src="image" alt="Cavalry Brigade Icon" /></td>
<td><img src="image" alt="Cavalry Brigade Icon" /></td>
</tr>
<tr>
<td>Cavalry Division</td>
<td><img src="image" alt="Cavalry Division Icon" /></td>
<td><img src="image" alt="Cavalry Division Icon" /></td>
</tr>
<tr>
<td>Cavalry Corps</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>Partisans</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td>Blockhouse</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td>Field Artillery</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td>Siege Artillery</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td>Railroad Battery</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td>Defenses</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td>Armored Train</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td>Balloons</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td>Battleship</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td>Cruiser</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td>Ironclad</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td>Monitor</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td>Ship of the Line</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td>Frigate</td>
<td>![F]</td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>Gunboat</td>
<td>![G]</td>
<td></td>
</tr>
<tr>
<td>River Ironclad</td>
<td>![R]</td>
<td></td>
</tr>
<tr>
<td>River Timberclad</td>
<td>![T]</td>
<td></td>
</tr>
<tr>
<td>River Gunboat</td>
<td>![R]</td>
<td></td>
</tr>
<tr>
<td>Submarine</td>
<td>![S]</td>
<td></td>
</tr>
<tr>
<td>Torpedo Boat</td>
<td>![T]</td>
<td></td>
</tr>
<tr>
<td>Troop Transport</td>
<td>![T]</td>
<td></td>
</tr>
<tr>
<td>Amphibious Transport</td>
<td>![A]</td>
<td></td>
</tr>
<tr>
<td>Amphibious Transport (LR)</td>
<td>![A]</td>
<td></td>
</tr>
</tbody>
</table>

### 3.6.12. Zoom

Use your mouse scroll wheel to zoom in or out. There are three zoom settings, and the default setting is the first level.

Zoom out to the next level for a grander view of the scene, and again to the third level to see the whole map. All unit Activation symbols are shown at all levels.

When fully zoomed out, you can either continue with the scroll wheel to return to the first level of zoom, or you can just click on the screen to return to the middle level.
Try these now, and while the default level is best for most things, they can all be useful at different times. For instance, being fully zoomed out makes it easier to spot units in other parts of the map that you may wish to move.

### 3.6.13. Right Clicking on a Unit

Do this to carry out one of the following tasks. Note that not all will be applicable for all unit types:

- Reinforce
- Elite Reinforcements
- Upgrade
- Unload (from a Transport or Amphibious Transport)
- Rail Move
- Transport*
- Amphibious Transport*
- Long Range Amphibious Transport*
- Disband
- Sack/Replace with (for HQs, to change commanders)
- Rename
- Properties (to see Combat Values and Honors gained from service)
- Set Mode
- Auto; Auto-Assist; Manual (for HQs)
- Hunt or Silent (for Submarines)

* When an applicable unit is adjacent to a place where it can embark in a Transport then a number will appear in brackets. This shows the number of available Transports of each type.

### 3.6.14. Reinforcing Units

- Units cannot be reinforced in the same turn as they move or attack.
- All Naval units can only be repaired in port, and (with the sole exception of Torpedo Boats) they can only receive a maximum of 5 strength points per turn.
3.6.15. HQ ATTACHMENTS

- HQ command ranges default to 3 but they can be increased via research.
- HQs have three modes: Auto, Auto-Assist and Manual. The default setting is Auto.
- Select a HQ and any units attached to it will be highlighted in green. If the HQ is set to either Auto-Assist or Manual then any units that can potentially be attached are in blue.

3.6.16. INDICATOR SPRITES

- Any unit that has not yet used up any of its potential movement is considered active and will display a flashing sprite on its lower section.
- Units that have moved but that still have Attacks and are in range of attacking an enemy unit will also display a flashing sprite on its lower section.
- Units that have moved with action points remaining but with no attacks remaining, will have a faded unit activation symbol flash.
- Units that have no Action Points or attacks remaining, are darkened to indicate that no further movement is possible.
- Units that have Attacks remaining but have exhausted all their Action Points and have no valid targets within range will have their Attacks set to zero, and they will be darkened to indicate that no further movement/attacks are possible.

3.6.17. MAJOR POWERS’ FLAGS

- Left clicking on a Major Power’s flag on the panel at the top left of the screen will center the map on that nation’s capital.
- Right clicking on the flag will access that country’s Production Table dialog.

3.6.18. FORCED MARCH/NAVAL CRUISE

Click on any applicable unit a second time and it will highlight the relevant option according to its unit type, e.g. Divisions can Force March, ships can Cruise.
3.6.19. HQ HIGHLIGHTS
With this switched on, when one of your units is selected, the HQ it is attached to will have a thicker ring around it. In the example left, the two units immediately to the north and northeast of the selected HQ are commanded by that HQ, while the unit west of it is not.

3.6.20. ZONE OF CONTROL HIGHLIGHTS
The ‘hatched’ green highlights indicate enemy Zone of Control (ZoC) reducing your Action Points if you move into, through or out of that hex. The ‘hatched’ orange highlight indicates how far you could move if the enemy ZoC was eliminated. This can be helpful in letting you know how far you could advance if the ZoC were removed.

3.6.21. ELITE HQ HIGHLIGHTS
HQs with a rating greater than or equal to 8 will increase the Prepared Attack bonus of all units under their command by 10%. These HQs will be marked by an orange border around their counter.

3.6.22. SLEEP MODE
You can set a unit in Sleep Mode if you do not intend to move it, and if you don’t wish to see its indicator sprite flashing on the War Maps, nor for it to be included when you cycle through units using the Page Up/Page Down keys on your keyboard.

To do this, right-click on the unit and select the Sleep option. Please note that this unit will remain in Sleep Mode in subsequent turns unless you again right click and deselect Sleep.
As they cannot move, fortress Defenses have been set to begin in Sleep mode by default in the official campaigns.

Units can also be put into sleep for one turn via the Sleep Tool mouse hover and pressing the space bar instead of a left mouse button click. This is indicated with a black dot instead of a white dot.

3.6.23. Undo Moves

To undo moves by Land units press Ctrl-Z.

Note that Naval units cannot undo their moves. This stops them from being able to repeatedly search the map for the enemy until they find them.

3.6.24. Fog of War Shroud

The limits of your current visibility can be easily seen as hexes beyond the spotting range of your units and resources are darkened:

This shroud effect will automatically adjust as the situation changes, so moving units will remove the shroud from all affected hexes. This means that you can be certain, at least on land, whether or not any enemy units are within any unshrouded hexes. At sea, there is always the possibility that enemy Submarines may be present if they are in Silent Mode.

For all types of selected units, you will notice that their potential unit movement path is highlighted as you move the cursor around the map, including the applicable movement penalty costs as shown in the image below where for the selected Union Brigade it would cost 2 Action Points to move into Lewisburg.
3.6.25. Front Line
The Front Line effect places a border around your territory, updating automatically as you advance or get pushed back. Together with the Fog of War Shroud it provides you with an immediate understanding of the situation at a glance.

3.6.26. Partisan Locations
To see where Partisan activity can be expected, pressing the ‘P’ key on your keyboard will show all likely partisan trigger points, though only for countries that are currently at war.

To prevent Partisans from appearing it will suffice to have a unit in either that hex or an adjacent one.

Note, regular Partisan logos indicate partisans that will be added to the map, while those shown with a red circle and a line through them represent locations where Partisans will only reduce the strength of resources.

4. 1861 Blue and Gray Tutorial
Here we will give you some advice and explanations that will be useful for your first few turns when playing the 1861 Blue and Gray campaign.

The focus of this chapter isn’t to explain all the game’s features, they are explained in more depth elsewhere, it is simply to help you get started and have some fun.

Our advice is to use this section first to get a feel for the game, move onto the Game Essentials chapter for a greater understanding of the game’s concepts, and then delve in deeper should you feel the need!
4.1. TURN 1

4.1.1. SELECT THE CAMPAIGN

With the game opened up, from the Main Menu go to Single Player, select the 1861 Blue and Gray campaign and then click on Play Campaign.

From the Choose Side dialog, leave the Difficulty level at Intermediate (0%) and the Computer Bonuses at +0. For greater challenge, try the higher settings later once you’ve got a good understanding of how to play.

For the purposes of this Tutorial we are going to play as the Union. Because the Confederacy has the first move in this campaign, click on the button labeled Union to select that side to play. This will give control of the Confederate opponent to the AI. Then click on OK to proceed.

The Options screen will now come up. Click on OK to start the game as the Union.

4.1.2. POP UP MESSAGES

Once the game has loaded, the first thing you will see is a Pop Up message telling you that the Confederacy has bombarded Fort Sumter and that the American Civil War has begun. We are now at war!

It is best to read this and all subsequent messages that appear from time to time during the game as they will contain important information.

Left click on the screen to remove this message once you’ve finished reading it. This and all subsequent messages that you’ll see of this type in the game are not set to disappear by themselves, this is to ensure that you are in control and never miss an important message!

4.1.3. CONFEDERATE TURN 1

Once you have dismissed the Fort Sumter Pop Up, the Confederate AI will play its first turn. As neither side has much of an army, it is likely that they will be concentrating on research and recruitment, and we will not see any combat this turn.
At the end of the AI’s turn, several Pop Ups will appear telling us about some important events in the game. First, there is a chance that the Confederacy will choose to sell its cotton stockpile, which will provide them with some Military Production Points (MPPs, which are used to purchase units, conduct research and many other things).

Much more important to us will be the secession of Virginia, which will now become Confederate territory, and Maryland’s decision to side with the Union. Both of these states are predetermined to join their respective sides. As we shall soon see, this is not the case with all the border states. A riot will also occur in Baltimore, temporarily damaging the city.

Once you have seen and clicked through each of those events, the AI’s turn will end, and your turn will begin.

4.1.4. Surveying the Scene

Your first turn will begin with two more Pop Up messages, one from us, the developers, encouraging you to check out the game’s Strategy Guide, and another from General Winfield Scott, Commanding General of the Army, telling you that you will receive an additional 200 MPPs for the next ten turns as weapons are imported from Europe.

Tip! The game’s Strategy Guide can be accessed from one of the buttons in the top right corner of the screen. Among other useful information, it contains a copy of every advice Pop Up in the game, so you do not need to memorize these messages.

Once you have read and clicked through these messages, you will receive your first decision event of the game. Decision events are a special type of event that allows you to make either a YES or NO choice to a given situation. Some of them can have a very significant impact on the progression of the war, so it is always a good idea to read them carefully and review your position before making your choice.

This decision event is asking whether or not you would like to order the Union Army to occupy the state of Missouri and seize the St Louis Arsenal. This is one of the more important choices you will make in the game, so it would be a good idea to look at the map and see the current situation first. To do that, click on the ‘View Map’ button, third from the left.
The game map will now center on the city of St Louis MO (the two letter code following every city's name indicates the state it is located in, in this case, MO for Missouri). Scroll around a little using your mouse. To do this, simply move your mouse in the direction you wish to scroll the map.

Try the G and H hotkeys to toggle the map grid on/off and Hide/Show units respectively.

Take some time to review the map. At the bottom of the screen are Information Panels showing information relevant to the hex your mouse is hovering over, such as its owner, terrain type, any movement penalties and its Max Entrenchment value if applicable.

The mobilization value of any country will also be shown in the left hand panel when you hover over a land hex, as will its owner, political leaning and any special rules particular to its terrain type. Any country at 100% Mobilization, e.g. the Union, is considered to be fully active in the war.

**Note:** The term ‘country’ in *American Civil War* is used to refer to all independent entities, including border states such as Missouri, and Indian tribes such as the Osage.
If you hover over a unit, then information specific to that unit will appear in the left hand panel. Normally, you will also be able to select a unit by clicking on it, at which point information about that unit will remain in that panel until the unit is deselected. However, as there is a Decision Event awaiting an answer, this is not currently possible.

Scroll around the map with the mouse cursor and notice that as you hover over hexes belonging to different countries you’ll see that they will have varying Mobilization values.

Text colors in the Information Panel will show as white for units on your side and yellow for enemy units. The text for units on either side that have low Supply, Readiness or Morale will display those fields in gray.

### 4.1.5. Decisions

After scrolling across the map, you will have observed that General Fremont is leading a small force near the town of Alton IL, and that you also have a few scattered units in Kansas. We are now ready to return to the Decision Event we saw earlier, so click on the button labeled ‘Click to return to Decision’.

Before we make our decision, we should also look at the Notes that come with the Decision, which you can do by clicking the ‘Notes’ button. In this case, the Notes are telling us that if we say YES to this Decision, Missouri will never secede and join the Confederacy, but will also result in Kentucky shifting towards the Confederacy. Saying NO will mean that Missouri will remain neutral, but will likely join the Union towards the end of 1861. The historical actions in this situation are also given, and as we can see, YES is the answer that will result in a historical outcome.

You may recall that at the end of the first Confederate turn, Virginia seceded and joined the Confederacy, while Maryland chose to remain with the Union. Those results are predetermined and will occur in every game, and the same is true for the states of Arkansas, Tennessee and North Carolina, which are all still currently neutral but will join the Confederacy over the coming turns. Unlike those five states, Missouri and Kentucky may join either the Union or Confederacy depending on the actions both sides take early in the game: if
either state is more than 0% mobilized in favor of the Confederacy, it will secede and immediately become Confederate territory.

Of the two, Missouri is by far the more important as it contains significantly more towns (which generate MPPs) and commands the approaches to the Western territories and Kansas, so we should do everything possible to prevent it from seceding. Fortunately, the Decision’s Notes inform us that saying YES to this Decision will guarantee that Missouri will never secede, so we will click OK to close the Notes, and then click the ‘Yes’ button to make our decision.

Two events will then pop up, informing us that Kentucky is upset with our decision, and Missouri’s Governor Jackson will raise the Missouri State Guard to oppose us.

Before we can deal with him however, we will be offered another Decision, asking whether we would like to evacuate the forts in the Indian Territory (modern day Oklahoma). This choice is less important than the Missouri one was, asking us merely whether we would like to deploy two Regiments in the Indian Territory or in Kansas. As units deployed in Kansas can be used against Governor Jackson in Missouri, we will say YES to this Decision as well. As it turns out, YES was also the historical response, and considering the Union won the war historically, we can’t go too wrong copying that!

4.1.6. NEW UNITS

Once both Decision Events have been answered, you will be presented with the New Units menu. This allows you to deploy new units on the map. Currently, we have three Brigades available to be deployed, representing some of Lincoln’s 75,000 volunteers (and don’t worry, they won’t desert after 90 days!). Notice that the first one is labeled ‘Washington DC, Union’. This means that this unit can only be deployed in Washington DC. The others may be deployed in any Union city, major city or capital.
When you click OK, the map will center on Washington DC, and the five hexes in and around the city will be marked green, indicating hexes in which you are allowed to deploy the unit (the hex to the southwest is owned by the Confederacy, so you cannot deploy units there).

Left click to place the unit in one of those hexes, or right click to cancel and be taken back to the screen showing the units that can be deployed. Units may be deployed in any order, and you are not required to deploy all units in a given turn (though we strongly recommend that you do deploy all of your units whenever possible).

As our capital city is currently undefended, we are going to deploy all three Brigades in and around Washington DC.

4.1.7. The Top Left Sidebar

At the top left of the screen is a sidebar showing the flags of your Majors, the Union and Mexico.

Under each flag are shown the available Military Production Points (MPPs) followed by the Major’s current Mobilization Level. The Union will be 100% Mobilized, while Mexico will be 0%. Mexico is extremely unlikely to enter the war and will not generate any MPPs until they do, so we can ignore them for now.

Right click on the Union flag and you will see the units that the Union currently has due to deploy during the campaign. Their exact arrival dates are shown beneath each unit. If you click on the Mexican flag at the top of the table it will show you the units that they are due to receive (although in this case, they will not have any).

Note that this table does not include those units that are still currently mobilizing or due to arrive via later events, including any triggered by Decision Events.

Once you’ve finished looking, click OK.

We are now going to head back to the Union, so left click on the Union flag on the sidebar at the top left of the screen to center the map on the Capital,
Washington DC. This is a quick and handy way of moving around the map, as you can select any of your Majors’ flags to be taken to their capital. Then scroll the map to the west until you see your armies at the border with Missouri.

The reason for going here is that we are going to begin the war by attacking the Missouri State Guard!

4.1.8. Land Movement

Before we launch our first attack, let’s look at land movement and how you can seize territory from the enemy.

Whenever an active unit has been selected with a left mouse click, its allowable movement range is highlighted on the map as shown below:

Then, depending upon the current mouse position the highlighted movement path will display the total movement cost. This includes all associated terrain penalties as well as any additional penalties if attempting to move near enemy units that are exerting a Zone of Control.

You can then move the unit by left clicking on a highlighted hex that you wish it to move to. Then if you release the unit by right clicking with your mouse or clicking on another unit, it will commit that move. At this point Fog of War will update to potentially reveal any enemy units that couldn’t be seen from your original position but can be seen now.

A unit can move multiple times until it has used up all its Action Points. However note that your unit will only retain its full spotting distance the first time it commits its move, so any subsequent movements that turn will be at greater risk of bumping into previously unseen enemy units.

Once a unit has used up all its Action Points the counter underneath the unit image will have darkened, and it no longer shows an Activation sprite at
the bottom left of the counter. These changes signify that this unit has used up all its Action Points for this turn and can do nothing more until next turn.

We will begin our occupation of Missouri by moving our Cavalry Brigade onto the river hex northwest of St Louis (hex 92,71) and then deselect it by right clicking. This will allow it to spot the nearby area and make sure there are no enemy units that may ambush us. Cavalry have a spotting range of 3 hexes, while infantry only have a spotting range of 1, so using cavalry to scout the area ahead is essential to avoiding ambush.

The extent to which you can see is shown by the Fog of War shroud. The limits of your current visibility can be easily seen as hexes beyond the spotting range of your units and resources are darkened by the shroud, and this shroud automatically adjusts in line with the situation. After moving your cavalry, you can see that the shroud has retreated, revealing that the town of Washington MO, and nearby hexes, are empty of enemy units.

Having confirmed that the area is clear, we can then move our Cavalry again, this time to occupy St Charles. We will also move our Infantry as far west as it may go this turn, and send General Fremont to occupy St Louis.

We have another Cavalry Brigade, this one located in Lawrence KS, which we can send to occupy Missouri from the west. When you are finished, the situation in Missouri may look like this:
4.1.9. The War at Sea

Now we’re going to move to the east to review the Union’s fleet. You may wish to zoom out one level using the scroll wheel on your mouse to better see where all its vessels are located.

The Union has two Frigates at Boston MA, another Frigate in Key West FL and a Gunboat in Fort Pickens FL (near Pensacola). Many more ships will arrive in the coming turns, including a large fleet of Gunboats. To see these, click on Purchase at the top of the screen and then click on Production in the bottom right to see what units are already under production and when they are set to be available for deployment.

Currently our Navy does not have much to do, as the Confederates do not begin the game with any ships and are not yet receiving any convoys from overseas. Both of these will soon change, but for now it would be a good idea to get our ships in a position to begin blockading the Confederacy for when the time comes.

Scroll the map up to Boston, and locate the Frigate *Niagara*, which will be located in hex 179,33. Boston is far away from the Confederate coast, and any ships left up here won’t have much to do, so let’s move the *Niagara* down to a more useful position.

Selecting the *Niagara*, we can see that it can move 14 hexes this turn, which would allow it to sail as far south as Rhode Island. Now left click on it again. You’ll notice that the hexes around it have turned orange. This is because it is now in Cruise Mode, which allows it to move double its normal distance for a cost of 1 supply point.

Now left click on a destination hex, heading south to somewhere near the coast of New Jersey, and then do the same with the other Frigate in Boston, the *Mississippi*. The other Frigate and Gunboat we identified earlier, can be left where they are for the time being. Leaving them in port will ensure they are at maximum supply and readiness when we do need them.

Note that it’s best not to use Cruise Mode every turn, as it does use up supply, but once or twice on an outbound mission will get you to your destination much faster.

**Tip!** You can select a movement path by holding down *Ctrl* on your keyboard and then left clicking on a hex you wish to pass through. The unit
won’t actually move until you either release the **Ctrl** button and then left click on your final destination, or you left click with **Ctrl** held down on the most distant point you can reach.

**Note:** The names of naval units generally denote a number of vessels, using the name of a historic vessel to give them historical flavor.

### 4.1.10. **Research**

We currently have 200 MPPs available to spend. Especially early in the game it is a very good idea to consider doing some research. The Civil War was a time of dramatic technological development, with armored trains, ironclad warships, submarines and many other weapons making their battlefield debut during the conflict, and it is very likely that the side better able to utilize these new technologies will win the war.

Select Research from the bars along the top, or use **Ctrl-R** to bring up the Research dialog.

The dialog that opens has a tab for each Major: the Union and Mexico (though Mexico has no MPPs, and thus will be unable to conduct research unless they enter the war). Categories in green are currently being researched, and by hovering over a category you will see an explanation of it in the bottom left corner.

The Union starts with some advanced research levels, such as Amphibious Warfare and Logistics in the right hand column.

In the top right you can see your available MPPs, as well as the total that has already been invested in research. At the bottom right you can see the maximum amount that can be invested at any one time.

While we have a wide range of research options to choose from, four technologies deserve the greatest attention: **Infantry Equipment**, **Corps Organization**, **Production Technology** and **Industrial Technology**. **Infantry Equipment** will increase the attack and defense stats of our infantry units (which will make up most of our army), and the latter two will reduce the costs of units and increase our MPP production respectively, but unfortunately all three cost 250 MPPs to invest in (fortunately, we already have the maximum two chits invested in **Industrial Technology**, but we will have to wait until subsequent turns for the other two).
One technology that we can afford to, and certainly should invest in, is *Corps Organization*. Developing this technology will allow us to build Corps units, which are significantly more powerful than the Regiments and Brigades we currently have on the map, or the Divisions currently available to purchase (we will discuss them more later).

Ensure that you have the Union’s flag selected at the top of the dialog box, then click on the up arrow next to *Corps Organization* and then click Yes on the confirmation box that appears, so as to agree to making the investment for a cost in MPPs. The Research screen now shows 1 chit in *Corps Organization*.

Select Table at the bottom to bring up the Research Table dialog. This shows the current level for all technologies for all your Majors.

Click on Close when done.

### 4.1.11. Ending the Turn

Once you’ve completed all actions this turn, select **End Turn** or **Ctrl-E** to finish the turn.

There will now be some end of turn events, including the secession of one or more of Arkansas, Tennessee and North Carolina, the arrival of new units in Missouri and Baltimore, and Pop Ups informing you of other events that are happening.

The Union will then collect MPPs, providing you with income that you will be able to spend next turn. (If Mexico was in the war, it would also collect some MPPs at this stage).

The Confederate AI opponent will now carry out its turn. If you like to watch its move but get called away, then pressing Pause/Break on your keyboard will pause the AI’s turn. Press it again for the turn to continue.

### 4.2. Union Turn 2

#### 4.2.1. The European Danger

![Great Britain Extends Belligerent Status to the Confederacy in Response to the Blockade]

---

Great Britain Extends Belligerent Status to the Confederacy in Response to the Blockade
At the end of the second Confederate turn, you will receive some bad news: the British have recognized the Confederacy as a belligerent power (though President Lincoln’s threat of war prevented them from formally recognizing the CSA as an independent nation), and have begun trading with the rebels (unofficially, of course). Now would be a good time to view the War Maps screen and see the international situation at large, so after you have deployed the two available units (the Frigate must go in Boston, while the Brigade can be placed at any city, though again Washington DC is a good choice), select the War Maps button at the top of the screen, or use the Ctrl+M hotkey.

This will bring up a zoomed-out map, and you can zoom in by left-clicking anywhere on it.

Press the % button in the bottom left to show Mobilization Levels for all countries.

You’ll see that the Union is at 100% Mobilization. Because the Union is already at war with the Confederacy, the Confederacy’s icon is represented by a pair of sabers.
Most countries are neutral, including ten Indian tribes, Mexico and the three European powers: the UK, France and Spain. The British recognition of the Confederacy’s belligerency has increased their Mobilization to approximately 10% (it varies from game to game).

By selecting a country that is currently neutral, and then clicking Declare War, you are able to declare war on that country, immediately bringing it into the war on the opposing side (if a border state is attacked, it will immediately join the Union or Confederacy and cease to be an independent state). In American Civil War, there are few instances where a declaration of war is preferable to simply waiting for that country to join the fight of its own accord, and we generally advise against doing so.

**Note:** Some nations in the game, including the Comanche, Western Territories, Guatemala and Honduras, are considered to be permanently neutral and cannot be declared war on normally.

You are encouraged to regularly check the Mobilization of the European powers, as when one of them reaches 75% Mobilization, they will formally recognize the independence of the Confederacy, and are virtually certain to enter the war thereafter. European powers have extremely powerful armies and navies, so as the Union you should do everything you can to reduce their Mobilization whenever possible (and Confederate players are encouraged to try to bring them in!).

### 4.2.2. The Convoy Map

From the War Map, you can access the Convoy Map by clicking on the ‘Convoy Map’ button.

This map shows the convoy routes between countries with similar leanings, as both the convoy sender and recipient have to have the same political leaning of either Union or Confederate. Country flags are displayed for each source nation with a convoy event.

Union-aligned countries have a blue border around their flag and Confederate-aligned countries have a red border. Active convoys are shown with either a red line if the convoy is Confederate, or a blue line if the convoy is Union, while inactive convoys belonging to either side are represented by white convoy lines.
The map also displays the location of friendly units that are capable of raiding convoys. This can be useful in showing you where they need to move to from their current positions in order to raid.

Left clicking on a source country’s flag provides information about its convoy event. For countries with active convoys the convoy event name is shown. If it is a friendly convoy, or if Fog of War is off, then the number of MPPs being transferred and the Seasonal Reduction Value are also displayed.

The Seasonal Reduction Value represents the fact that some convoy routes are affected by the weather and will then work at less than 100% efficiency. They may even be shut down during the winter due to ice. When this is so they will display a white line to represent that they are inactive.

**Note:** In *1861 Blue and Gray*, all convoys operate at 100% efficiency in all seasons.

For countries with inactive convoys, the convoy event name, current Mobilization Values and trigger requirements for the convoy are displayed. If the Fog of War option is selected, for enemy convoys only the convoy event name is displayed. Note that convoys may be activated or inactivated as countries’ Mobilization Values change, and every country’s status can be monitored via the War Maps button as mentioned previously.

**Note:** The Union can send MPPs via the Convoy Map to Mexico if Mexico enters the war. The default setting is that none will be sent without your permission, so via this screen you may wish to set the % of Union income, up to the maximum permissible, that the Union can provide to Mexico.

**Tip!** For convoys between Major powers, you can adjust how much will be transferred each turn. The transfer amount will remain the same until you change it via the Convoy Map, where an Up/Down arrow for the selected convoy can be used to adjust the transfer value.

### 4.2.3. Suspended Convoys

If a Convoy route passes through a friendly port while en route to its destination, and the port is either captured or damaged to below strength 5, then the Convoy will be temporarily suspended. This means that the Convoy recipient will not receive any income from that Convoy until the port’s strength has returned to at least 5, or the relevant port has been recaptured.
Land convoys, such as the one from the Utah Territory to the Union (which activates in 1862), can be broken if enemy forces capture any of the hexes that the convoy passes through. This means that as the Confederacy advances into New Mexico, the hexes near Santa Fe NM are likely to be hotly contested because without them the Union will lose considerable income from the Utah goldfields.

The same applies to the Confederate Blockade Runner convoy that runs from Bermuda to Elizabeth City NC via Fort Hatteras. If the Union can capture Fort Hatteras then this will cut off that Blockade Runner route, reducing the income the Confederacy receives.

4.2.4. The Advance Continues
As a result of the British Mobilization, a convoy has begun running from the British islands in the Caribbean to the Confederacy. Close the Convoy Map and War Maps screens, and locate your two Frigates that we moved last turn to the coast of New Jersey.

Every warship in the game, with the exception of river warships and Submarines, can raid enemy convoy routes. To do this, they must first be set to Raider mode, which can be done by right-clicking on them and choosing Set Convoy Mode -> Raider. Then, as we did last turn, set both Frigates to Naval Cruise and move them south towards the British convoy. Unfortunately this convoy is too far away to be reached this turn, so it would be a good idea to instead move them to the Port of Fort Monroe VA. This will allow them to replenish the supply points they have used in their recent Cruises. Moving one of them to the hexes marked in red off the coast will allow them to blockade the Confederate city of Norfolk VA, which will reduce that city’s supply (and thus, Confederate income).

Tip! Units set to Raider mode will use one supply point each turn that they
are actively raiding an enemy convoy route. When they are not located on or adjacent to a convoy route, they will not use this supply point, so you can safely set ships to Raider even when they are not yet actively raiding.

Once this is done, you should also continue moving your units in Missouri towards the state capital Jefferson City.

4.2.5. THE EASTERN THEATER

Last turn we deployed several units around Washington DC, and it is now time to use these units to begin the advance towards Richmond. The Eastern Theater is very likely to be a place where the war is won or lost, so it is important to seize every advantage we can in this region.

One of the first things we can do here is capture Alexandria VA, which the port of Washington has spotted and is currently empty. Alexandria occupies a valuable strategic position, commanding the approaches to Washington DC and representing the junction of three of Virginia’s most important rail lines.

Send all three Brigades, and the Armored Train that arrived in Baltimore, to occupy the ground near Alexandria and ensure this key location is firmly under your control.

4.2.6. RESEARCH

This turn we also have a significant stockpile of MPPs (likely around 950). While there are a wide range of things we can do with these, Research again deserves our greatest attention. The Union is able to conduct up to 4000 MPPs of Research at any one time, and we are nowhere close to that limit at this stage. Investing in two chits of Infantry Equipment, and a second chit in Corps Organization, will set us up well for the future, so these are strongly advised.

4.2.7. DIPLOMACY

Now would be a good time to look at the Diplomacy menu, which you can open by either clicking the Diplomacy button at the top of the screen, or using the Ctrl+D hotkey.
The Diplomacy menu allows you to declare war on other nations, or invest in diplomatic chits with the aim of swaying them to your side. Each Diplomatic chit costs 100 MPP if invested in a minor nation, or 200 MPP if invested in a major. Only the Union and Confederacy can make diplomatic investments, and each is limited to five chits, each giving a 3% chance of a “hit”. A successful diplomatic “hit” will move that nation 7-10% towards your side (with a small chance of an even greater swing for minor nations), and use up one chit.

Three main categories of nations are available for diplomatic investment: European powers, border states, and Indians. European powers are by far the most powerful, and the Confederacy is likely to invest in them later in the game. If we invest in them, each chit we invest will counter the effect of one chit invested by our opponent (so if both sides invest two chits, then neither side will ever receive a diplomatic “hit”), and if we invest in more chits than the Confederacy does, a diplomatic hit would reduce their mobilization (to a minimum of 0% - the Europeans can never become pro-Union).

Border states - only Kentucky in this game, but Missouri as well if we said NO to the Decision on Turn 1 - don’t have any military forces of their own, but bringing them onto your side can bring significant benefits, including the ability to deploy new units in their cities. If you intend to use diplomacy to influence border states, it is essential that you do so as soon as possible, for they will choose sides quickly (almost certainly before the end of 1861).

When a border state is more than 0% pro-Confederate, it will immediately secede and join the Confederacy, so it is always a good idea to keep a close
watch on them. In this case, Kentucky is currently only 6% pro-Union, and would secede if the Confederates scored even one diplomatic hit, so it may be a good idea to make a diplomatic investment now and reduce the risk. For the purposes of this Tutorial however, we will assume that no investment is made.

**Tip!** The Confederate AI will attempt to influence border states in some games, and will do so without warning.

Indian tribes can also be influenced, with the Creek, Cherokee and Pueblo being most easily influenced to the Union side. Each will bring one Indians unit (similar in strength to a Cavalry Brigade) to the fight, and in the case of the former two, we recommend you say NO to the Decision to evacuate the Indian Territory forts if you intend to attempt to influence the Indians to join your side.

### 4.2.8. Purchasing Units

Though you will continue to receive new units from your Production Queue and from events for the next several turns, these will not be anywhere near
sufficient for the task of conquering the Confederacy and putting an end to this rebellion. As a result, it is important to begin Purchasing Units as soon as you possibly can. Beginning in the third or fourth turn, and continuing until at least the end of 1861, we strongly recommend that more than half of each turn’s income be devoted to new unit purchases each turn.

To open the Purchase screen, click the Purchase button at the top of your screen, or use the Ctrl+P hotkey.

To the left of the center of the screen will be a list of possible units that can be purchased. Some will be listed in red text, indicating that you cannot build these at this time, and you can click on them to see the reason why (for instance, you cannot build a Submarine until you have researched Experimental Submarines technology). Units listed in gray can be built, but you do not have enough MPPs available to purchase them currently. Units listed in white can be purchased right now.

The Division is a more powerful infantry unit than the Brigade, and in time Divisions should form the backbone of our army. Build one now by clicking Division on the Select Unit list, and then clicking Purchase. The ‘PD’ stands for ‘Production Delay’ and is measured in months. For a Division the delay is three months, which means we will be able to deploy our new Division in August 1861.

**Note:** You can choose the name of a unit when you purchase it. Divisions are named after their commanding generals, so be sure to choose a good one! Division commander names do not have any gameplay effects.

4.2.9. YOUR TURN END

Once you have purchased a Division, check that you have moved all of your units for this turn, and then End your Turn.

At the end of your turn, you will be offered a Decision to send General Butler to either Fort Monroe VA or Washington DC. We strongly encourage you to say YES to this Decision, as the Confederates are sure to capture Fort Monroe if you do not defend it.

You will also receive messages informing you that General McClellan has taken command of the forces in eastern Ohio, and that the Confederate capital has moved to Richmond.
4.3. SUMMER 1861

4.3.1. CRUSHING THE MISSOURI STATE GUARD

At the beginning of turn three, your forces should be converging on Jefferson City, and it is time to defeat the Missouri State Guard once and for all. (It is worth noting that in this game we have been very lucky with the weather in Missouri - if you are unfortunate enough to have mud delay your advance, this may not be possible until turn four).

Select one of the units near Jefferson City, and move it into a hex adjacent to the Missourian unit in the city. Then hover with your mouse over the Missourian Regiment in Jefferson City.

When you hover over an enemy unit with one of yours selected that can attack it, the Information Panel at the bottom of the screen will display an estimate of the losses if you do decide to attack:

---

You will also see the estimated losses appear over the Missourian unit, in this instance 1:1, with the number on the left being the attacker’s expected losses, that on the right the defender’s. Actual results may vary by 1 in either direction, so it is possible that you will suffer 2 strength point losses instead of 1, and if you are very lucky you may suffer none at all.

Attacks by land units work as follows:

- Units that attack before moving receive a Prepared Attack Bonus (this is not possible this turn, but should be taken advantage of whenever possible).
- This increases their Readiness by 40% for this attack, making their attack more effective.
- All land units apart from Artillery have to be in a hex adjacent to the target to attack.

Now we are going to attack the Regiment, so with your unit remaining selected, left-click on the enemy unit. This will launch your attack.

Now attack the same Missourian unit with as many other units as you can in the same way, by moving them adjacent to the unit and then clicking on the target.

Casualties are to be expected as some of our forces are attacking across a River, which reduces your attack’s effectiveness by 25%.

If a unit’s Readiness, and therefore its potential combat effectiveness, is below 50% then this can be easily seen without having to click on any units because the number representing its unit strength will look fainter. Keep an eye out for enemy units with fainter strength numbers as all other things being equal, they will be more vulnerable to attack.

In addition, if you hover your mouse over the enemy unit to view its details in the Information Panel, its Readiness value will show in gray rather than in yellow:

Don’t worry if you didn’t destroy the Missouri State Guard Regiment this turn. Its combat effectiveness, even if it is reinforced in the Confederacy’s turn, will now be significantly lower after all your attacks and because our units are now next to Jefferson City, when we attack next turn all our attacks will benefit from the Prepared Attack bonus.

If however you did manage to destroy the Missouri State Guard Regiment, be sure to occupy Jefferson City. At the end of the turn, Missouri will surrender and become a part of the Union.

**Note:** The Missouri State Guard is a special case where a nation will be annexed into the Union upon
its surrender. When other nations, such as the Indian tribes, surrender, they will simply become occupied territory and can be liberated if a friendly army recaptures their capital.

4.3.2. West Virginia
As we saw at the end of last turn, General McClellan has now arrived in Ohio along with several Brigades of volunteers, ready to march into West Virginia. This is something we should do promptly, as right now the Confederacy is underprepared, and if we move quickly enough it may be possible to secure the entire state (or technically speaking, half of the state: at this point in history, West Virginia was still a part of the state of Virginia).

Securing West Virginia will provide us with several advantages. Capturing enemy resources also reduces enemy income, thus reducing their ability to resist. In addition, West Virginia is a very defensible position once it has been occupied, with the Appalachian Mountains severely limiting the Confederacy’s ability to send forces into the state from the east, so we will likely only require a few Brigades to maintain our control over the state.

Later in the game it will also be possible for West Virginia to secede from Virginia and formally rejoin the Union as the 35th state in the Union. Doing so would improve our Fighting Spirit, and put us one step closer to winning the war.
4.3.3. **FOCUS ON THE OBJECTIVE**

The key to winning the war is to focus on what matters, and to avoid putting any effort into attacks that won’t contribute to victory. Although our industrial base is superior to the Confederacy’s, we will not be able to launch overwhelming attacks in every direction at once. Concentrating on one or two fronts that hold promise will ensure that you are not spreading your forces too thin, and a local advantage gained in one theater can always be exploited and turned into further gains elsewhere.

It is also important to remember that this rebellion will take time to crush, and your initial priority should be preparing your economy and the nation for the struggle ahead. Research and production should be your primary goals for the remainder of 1861, as Divisions and eventually Corps are significantly more powerful than the Brigades currently available. Monitors and soon Ironclads will drastically shift the balance of power at sea, so construction of new warships will be essential if your blockade has any hope of cutting the Confederacy off from the outside world.

As your new armies begin deploying, do not neglect the Western Theater when organizing your forces. Though Kentucky is currently neutral, it will likely enter the war by the end of 1861, and as soon as it does you can expect Confederate forces in Tennessee to attempt to gain control of the state.

By the beginning of 1862 you should have assembled a new and powerful army ready to go on the offensive, and once you are able to you should not hesitate to do so. There are many ways to achieve victory: do you march directly on Richmond, or perhaps attempt to seize control of the Mississippi River? Perhaps a bold amphibious landing at New Orleans will be the masterstroke that cripples the Confederacy? Whatever route you choose, we wish you the very best. Good luck, Mr President!

4.4. **GENERAL TIPS**

4.4.1. **BATTLE FOR VICTORY**

If you can predict that enemy units will have lower supply and/or readiness in the following turn, e.g. by cutting them off from friendly resources, then it is
often better to delay attacking them until your next turn when you will find that the expected combat losses will be much more favorable.

Generally it is best to badly damage or destroy a small number of enemy units, rather than to spread your attacks over a wide front. Battered units will take time to recover, and will be more vulnerable in subsequent turns than others because even if they recover their losses via reinforcements, for a few turns their Morale and Readiness will be lower than other units, all other things being equal.

4.4.2. Swapping Units

You may at times wish to swap the location of two units. To do this, left click on a unit that you have not yet moved or attacked with. Then press and hold Shift on your keyboard and hover your mouse over an adjacent friendly unit that has also not yet moved.

You will notice that your mouse cursor changes to a double headed black arrow. When this is showing, you are ready to swap the position of two units, all you need to do now is to left click on one of them and they will swap places.

4.4.3. Forced March

One method of quickly moving land units is to use Forced March.

Left click on a land unit twice and providing it is a unit capable of Forced March, has a supply value of 5 or more and it is not adjacent to an enemy unit, it will be able to move 50% further than usual. However, the exhaustion caused by this will reduce the unit’s morale by 50-65%. It will then take several turns to rest and recover its morale, and until it has done so its combat effectiveness will be reduced quite significantly.

Note: A unit using Forced March will not be able to attack or capture enemy resources, and Artillery doing this will have their supply of shells reduced to 1.

4.4.4. HQ Settings

One thing you can do during the game is to change which units are commanded by your HQs.
When you click on an HQ, notice that units attached to its command are highlighted in green. These are the units that receive a leadership bonus based on the HQ's command rating.

By right clicking on an HQ and selecting Set Mode from the drop down menu, attachments for that HQ may be set to Auto, Auto-Assist or Manual.

When in Auto-Assist or Manual Mode, you can change a unit's attachment or detachment status, e.g. to change which units are commanded by a HQ.

Click on the HQ so that the units attached to it are highlighted in green. To detach a unit, right click on a unit highlighted in green and select Detach. To attach one right click on one highlighted in blue and select Attach (the colors denote whether or not they are already attached).

This isn't something you should need to do very frequently, but at times it will come in useful, especially when you don't have enough HQs for all your units and a decisive battle must be won!

4.4.5. Transports

Units can be rapidly moved by sea (or river) by using transports.

In the 1861 Blue and Gray campaign three types of transport are available for use:

- Regular
- Amphibious
- Amphibious (LR)

The first is for moving troops between friendly ports, whereas the Amphibious Transport is for making landings on hostile shores.

Embarking units in any type of Transport costs Military Production Points (MPPs), with the Amphibious Transports being more expensive than regular ones. Additionally, each country has a limit on how many it can use at any one time of any particular type of transport.
When it comes to launching invasions, Amphibious Transports have the ability to attack prior to unloading the embarked unit, which means that in many situations any targeted units can be attacked twice. Note however that this is an era before specially-designed landing craft, so it may be safer to land your forces first and then march to the target.

Units will lose 1 supply point per turn that it is in the Amphibious Transport, reducing its combat effectiveness so it is best to only embark in an Amphibious Transport as close as possible to when you will want to launch the invasion.

To embark, your unit will need to be in or adjacent to a friendly Port, although Marines can embark in an Amphibious Transport from any coastal hex. Right click on the unit and click on the type of Transport you wish to put the unit in. Say Yes to the confirmation message advising you of the MPP cost.

A regular Transport can then move in this turn, though an Amphibious Transport cannot move until the following turn unless level 1 in Amphibious Warfare has been researched.

Once the Transport has reached its destination it can unload, either by right clicking on the Transport and selecting unload, or by left-clicking on a highlighted destination hex. The embarked unit will then disembark, and it is now ready for action, albeit with limited Action Points in the turn it disembarks.

4.4.6. REINFORCEMENTS

Reinforcing units that have received significant damage is generally best before their next combat, as otherwise their fighting performance will be reduced and they will risk being destroyed.

Damaged units can be reinforced by right-clicking on them and selecting Reinforce, expending some MPPs to do so, but losing some unit experience in the process.

Or you can use the Reinforce tool. This is located second from the right, on the right side of the panel at the bottom of the screen:
With this selected, any unit you click on that can be reinforced, will be reinforced to the maximum possible provided that you have MPPs available to do so. It’s a very quick way of reinforcing large numbers of units, and the MPP cost shows above the unit when you hover over it, so you can decide if you wish to spend the cost or not.

Note that a unit cannot carry out any other actions that turn if reinforcing. An exception is if the unit has swapped position with another, as it can reinforce after swapping.

Reinforcing a unit uses all of its Action Points and completes its turn. When you reinforce naval units, you will see that, with the exception of Torpedo Boats, they can only receive a maximum of 5 strength points per turn.

4.4.7. Elite Reinforcements

As units engage in combat they will increase in experience, and successful actions will lead to greater experience gains. If a unit has any full experience bars then this will be represented by white dots above the unit’s strength. Experience icons will also display in the Unit Info Panel, e.g. a full US flag for Union units, as in the example below:

In this example the Union unit has 1 experience point. Elite Reinforcements can be purchased at a rate of one per turn, up to the maximum number of experience bars that a unit has, and you can do this by right clicking on the unit and selecting Elite Reinforcements.

If your unit already has strength points equal to the number of full experience bars, then further reinforcement won’t be possible, i.e. if a unit has one experience point and is already at strength 11, then it cannot receive any Elite Reinforcements.

In addition to the normal restrictions on reinforcing units as explained above, there are some additional requirements for receiving Elite Reinforcements:
- It must not be adjacent to an enemy unit
- Its supply level must be 6 or greater
- Its strength must be at least 10

4.4.8. Rail Movement
If you do want to transfer your Artillery, or other units, rapidly from one front to another then moving them by Rail is the quickest way of doing so.

Rail Movement represents the rapid relocation of a unit over a long distance via railroad, for a cost in MPPs, and it will be the only action the unit can carry out this turn.

To Rail Move a land unit (including Balloons), right click on it and select Rail Move. You will then be presented with a dialog box informing you of the cost if you proceed.

Saying Yes does not yet commit you to Rail Movement, but by doing so potential destination hexes will then be highlighted. Left click on the one you wish to travel to, or right click anywhere on the map click to cancel.

To be able to move by Rail, land units must have a supply value of at least 5 and be on a railroad that is linked to at least one resource with a strength of at least 5. This will provide the opportunity to move the unit to any connected resource on the railroad that also has a strength of at least 5.

4.4.9. Upgrading Units
If you go to the Research tab along the top of the screen, you’ll see two columns of research categories.

Those on the left hand side represent Manual Research fields, those on the right Automatic ones. What this means in practice is that to benefit from the Manual ones, when you attain research successes in these fields you will have to manually upgrade relevant units to benefit from it.

No such action is required to benefit from the Automatic ones, as your economy or armed forces will automatically improve as a result of research successes in any of these areas.

Upgraded units are better able to either attack, defend or move than their equivalents without upgrades. So when you attain a research success in a
Manual category, developing level 1 in say Infantry Equipment or Naval Engines, right click on the unit you wish to upgrade with the relevant category.

A cost will be incurred in MPPs for upgrading, but the unit will now benefit from better combat factors in whatever way is relevant to that unit type and research category, e.g. Infantry Equipment will give your infantry better Attack and Defense factors against land target types. If you are playing with 3-D counters you will also notice that the infantry unit is now represented by a slightly different graphic. Click on OK to proceed.

Note: Larger and more advanced units, such as Corps and Ironclads, will tend to benefit from research advancements by a greater amount per level than older or smaller units. If you cannot afford to upgrade all of the units in your army at once, prioritize your better units first!

4.4.10. Beware of Partisans

As you advance, one thing to beware of is that Confederate partisans may appear and liberate areas if you leave them empty of troops. To ensure that you don’t accidentally trigger any partisans by moving a unit away from an area where they might appear, press P on the keyboard and you will be able to see the areas you need to keep garrisoned, as in the example below:

To prevent partisans from appearing it will suffice to have a unit in the same or an adjacent hex to the areas where they can trigger.

If you see Partisan icons elsewhere with a red diagonal line through them, they represent places that if left unguarded will trigger partisan activity that will reduce the strength of your resources, but without deploying a Partisan unit on the map. While this is naturally less serious than having a Partisan unit appear on the map, it will lead to lower income and supply in that area.

Note: Other countries also generate Partisans if occupied, including the Union.
4.4.11. Next Steps

Now that we’ve given you a start, refer to the 1861 Blue and Gray Strategy Guide for further information and advice on playing and winning this campaign. This can be accessed either via the Launcher or from one of the buttons at the top right of the screen while playing.

For more information on game features, the next chapter on Game Essentials should be your next step.

If you have any further questions you can search this Manual for the answer, but if you get stuck or would like to share your opinion on anything please visit our forum at Matrix Games.

5. Game Essentials

5.1. Key Areas of Gameplay

There are five key areas of gameplay to consider during your turn, and considering each of them in the following sequence will ensure that nothing important is missed out:

- **Read any Reports** – To help you assess the situation
- **Orders** – Move, Attack, Reinforce Units
- **Politics and Diplomacy** – Declare War, Monitor Developments, Invest in Diplomacy
- **Research** – Invest Research Chits
- **Military Production** – Purchase Units, Deploy New Arrivals

5.2. Hotkeys

G – Turn the map hex grid on or off.
H – Temporarily hide all units on the map.
L – Display the last turn’s summaries for reference.
P – Show the location of potential enemy Partisan activity.
R – Show reinforceable units, as these will show a green unit strength number.
S – Show the level of supply your forces currently receive, along with a prediction of how much they will receive if venturing into enemy territory if you press S again.
U – Show upgradeable units and resources, displayed by a green research level number.
Page Up/Down – Select the previous or next active unit that has not yet moved.
To Set a Path – hold down Ctrl then select a route.
Space - this deselects a currently selected unit.
Shift – Select this to see how far a Carrier that hasn’t yet moved can attack.
← ↑ → ↓ – Scroll map left, right, up or down.
+/− Map zoom controls
Ctrl-D – Diplomacy
Ctrl-E – End Turn
Ctrl-I – Reports
Ctrl-M – Maps
Ctrl-N – New Units
Ctrl-O – Options
Ctrl-P – Purchase Units
Ctrl-Q – Quit
Ctrl-R – Research
Ctrl-S – Save
Ctrl-Z – To undo moves by Land units (Naval units cannot undo their moves).

5.3. Major and Minor Powers

- Major Powers (the Confederacy, UK, France, Spain, Union and Mexico) collect income in Military Production Points (MPPs), can carry out diplomacy, research, produce units, and declare war.
- All other countries are Minor Powers which when they enter the war are subordinate to one of the Major Powers, for whom they provide income. Minor countries can often be reinforced by purchasing new units, though their owning Major will have to pay for them.
• Each Major Power and their associated Minor allies has a unique color on the map, a ‘National Color’ that represents the territory controlled by that particular Major.

5.4. Indicator Sprites

• Any unit that has not yet used up any of its potential movement is considered active and will display a flashing sprite on its lower section.
• Units that have moved but that still have Attacks and are in range of attacking an enemy unit are set to indicate the normal unit activation symbol flashing.
• Units that have moved with Action Points remaining but with no attacks remaining, will have a faded unit activation symbol flash.
• Units that have no Action Points or attacks remaining, are darkened to indicate that no further movement is possible.
• Units that have Attacks remaining but have exhausted all their Action Points and have no valid targets within range will have their Attacks set to zero, and they will be darkened to indicate that no further movement/attacks are possible.

5.5. Orders

Actions use Action Points (APs) which determine their movement range.

Dynamic Movement – Units that haven’t used up all their Action Points can continue to move until they have done so, even if deselected and reselected again later.

Surprised Units – are those that bump into previously unseen enemy units during their movement. They can defend themselves but naval units in Cruise Mode land units will automatically lose any remaining APs, Submarines will have any remaining APs halved, and other units will have their remaining APs divided by 5.

Mouse Hovering – Hovering the mouse over a unit will display its unit info at the bottom left hand corner of the screen, in the game information area.

Move/Attack – Left click on the unit to see its potential movement range. Enemy units can be attacked by moving adjacent to them (if not already so)
and left clicking on them with your attacking unit selected. Units like artillery have longer ranges so they don’t need to move adjacent to the target before attacking. Each Attack uses up one AP, and naval units that engage in combat will have their remaining APs halved.

**Passing through** – Naval units that pass through an opponent’s naval units have a 50% chance of losing 1 strength point for every enemy unit they pass through.

**Specify a Movement Path** – Press Ctrl on your keyboard and left click to select individual way-points. This can be very useful when trying to avoid accidentally passing through any Naval Minefields!

**Moving Artillery into Empty Enemy Resources** – Press Ctrl and rather than bombard the enemy held resource, the Artillery unit will be able to move in and capture the resource.

**Forced March** – Left click on a land unit twice and providing it is a unit capable of Forced March, it has a supply value of 5 or more and it is not adjacent to an enemy unit; it will be able to move twice as far as usual but for a cost in Morale (which reduces its combat effectiveness). It will not be able to attack or capture enemy resources when doing this, and Artillery doing this will be reduced to 1 shell.

**Cruise** – Left click on a naval unit twice and providing it has a supply value of 5 or more it will be able to move double their normal movement distance but for the loss of 1 supply point. It will not be able to attack when doing this. Regular Amphibious Transports and Submarines are the only naval units that cannot Cruise.

**Rail Move** – Right click on a land unit with a supply factor of at least 5 that is in or adjacent to a railroad that is linked to at least one resource with a strength of at least 5. This will provide the opportunity to move the unit for a cost in MPPs to any connected resource on the railroad that also has a strength of at least 5. In previous games in the series, this function was known as ‘Operate’ or ‘Operational Movement’.

**Swap** – Select one unit, press Shift and select an adjacent unit you wish to swap it with. There is a Morale penalty for doing so, and both units will have a maximum of 1 Action Point after swapping. Unless the swapped units have
already done so, they will still be free to attack or reinforce. Providing they aren’t adjacent to any enemy units they can be upgraded.

**Sleep** – Right click a unit you do not intend to use for a while and select this option. This will prevent its icons from flashing and also remove it from the sequence when cycling through unactioned units using the Page Up/Down Hotkeys.

**Transports** – Use these to move troops by sea between friendly ports.

**Amphibious Transports** – Use these to move troops by sea to land on hostile shores. All units apart from Marines have to be loaded in friendly ports. Enemy naval units and Fortress Defenses will fire on Amphibious Transports that halt in an adjacent hex, even if only temporarily prior to landing. Note that neutral Majors cannot embark units into Amphibious Transports.

**Landing Casualties** – Units unloading from Amphibious Transports may suffer landing casualties, potentially losing a proportion of their strength, especially when landing in bad weather. With Amphibious Transports, the lower their supply value, the higher their landing casualties are likely to be.

**Reinforcing Units** – Increase unit strength up to their maximum (5 or 10 depending on unit type) though some experience will be lost in the process, and supply can limit the ability to do this. Note that naval units (with the sole exception of Torpedo Boats) can only receive a maximum of 5 strength points per turn.

**Elite Reinforcements** – Increase experienced units’ strength by 1 point per turn, up to 3 strength points above their maximum, depending on the number of full experience bars they have.

**Upgrading Units** – To increase their combat factors.

**Renaming Units** – Customize unit names, though names within each type must be unique.

**Disbanding Units** – Do this to recoup some MPPs, though Naval units cannot do this, nor can Land units adjacent to enemy units, nor any Forts. Note that only units belonging to Major countries can disband.

### 5.6. Unit Modes

Right clicking on some units can bring up options to change their Mode, thus providing some extra options for their use. The options for Submarines must be chosen before they either move or attack.
HQ – Auto, Auto-Assist or Manual. The last two are options for manually controlling which units are under a HQ's command. Refer to the full Game Manual for details.

Artillery, Forts, Railroad Batteries – Auto or Silent. Silent means that they will not provide counter-battery fire, which can help to keep their location secret. (Note that Forts are exempt from usual Fog of War rules and their location can always be seen by both sides)

Submarines – Hunt to increase movement range; Silent to increase your chances of not being seen. Changing from Hunt to Silent Mode or vice versa can only be done before the Submarine moves or attacks. Silent Mode does not mean that the Submarine is literally submerged the entire time, it is better to think of it as being cautious and submerging at times of greater risk.

All other Surface Vessels – See the section on Raiding below:

5.7. Zone of Control

Most units exert a zone of control hindering enemy movement in adjacent hexes. To determine the extent of the zone of control exerted, all units are assigned a category:

- Front Line Units are Divisions, Corps, Mountain Divisions, Marines, Blockhouses, Defenses, and all naval units except for Submarines, Naval Mines, and all types of Transport.
- Support Units are all remaining land units apart from HQs and Balloons.
- No Zone of Control Units are HQs, Balloons, Submarines, Naval Mines and all types of Transport.
- Damaged Units: units below strength 5 do not exert any Zone of Control.
- Naval Units in Port do not exert a Zone of Control.

One Front line unit will exert a Zone of Control, and this means that all enemy units moving into, or within, one hex of it will have to pay an extra Action Point to do so, while it will require two Support units to have the same effect.
5.8. Combat

- There are two main categories of units: Land and Naval, and these are further divided into sub-categories, called Target Types, each of which has different statistics.

- Target types are Soft (i.e. weak), Infantry, Cavalry, Artillery, Fort, Armored Train, Balloon, Ironclad, Wooden (Ship), Transport, and Resource.

- Each unit has unique Attack and Defense values when combating each of these target types, so a quick comparison of capabilities can be seen by looking at a unit’s properties and comparing its attack value against a Soft target with that unit’s defense against the attacking unit’s target type.

- Combat results are affected by unit Readiness and their relevant combat factors. Readiness is based on their units’ Strength, Morale, HQ support (based on the HQ’s rating and experience). Supply is a major factor in unit Morale.

- Entrenchment provides some protection from losses, with greater entrenchment providing more protection. Entrenchment is reduced by enemy attacks and automatically lost when leaving a position, being regained at the start of your next turn, at a rate of 1 Entrenchment level per turn. Units in Fortifications and Fortresses gain Entrenchment levels faster.

- Location is also a factor, as terrain and resources generally provide bonuses while attacks across rivers and/or after having moved are less effective.

- Weakened units may automatically retreat when attacked, but the attacker's losses will be halved when this happens.

- Land units will be less likely to retreat from Resources, Fortifications and Fortresses.

- Units gain experience from combat and experienced units will be able to avoid some losses in future combats, while in general inflicting higher casualties on the enemy. It isn’t necessary to have full experience points in order for this to help, as some experience is better than none.
Experienced units are to be prized and are frequently best used as spearheads or to launch effective counter-attacks.

- Most units can gain up to a maximum of 3 experience points, although some, including fortress Defenses, small ships and armored trains are limited to 1.
- HQs gain experience from the units under their command, with successful operations providing more experience and raising their effectiveness as commanders.
- HQs, Balloons and Transports cannot attack.
- Naval Units lose 1 Supply point every time they are engaged in combat.

5.9. RAIDING

- Raiding enemy convoy lines is a good way of reducing their income and Fighting Spirit. Naval units, except Submarines, can do this by moving either on, or adjacent to, enemy convoy lines. Right click on the unit, select Select Convoy Mode and then click on Raider. This raiding option can be switched in the same way by right clicking on the unit and de-selecting Raider.
- Naval units cannot raid if an enemy surface vessel is adjacent to them (note that Submarines and Transports cannot prevent raiding). Either sink this unit or move away to a better raiding position.
- At the end of your turn all raiding takes place, and its effects are worked out by the game engine, no micro-management is required.

5.10. CONQUERING COUNTRIES

A country will surrender if all their Capitals have been captured and enough of their current land forces have been destroyed. The nationality of the unit occupying the surrendering country’s Capital determines who the country surrenders to, and they will receive Plunder in MPPs providing the country surrenders by direct conquest rather than by an in-game event.

Note: In our previous games, the surrender of a country would result in the Unit Morale of the victors rising temporarily, and the allies of the defeated nation suffering a similar penalty. This feature is not used in American Civil War.
5.11. Fighting Spirit

Note: In our previous games, this mechanic was referred to as “National Morale”.

- Fighting Spirit represents a Major Powers’ willingness to fight, and will be reduced when their resources are captured, casualties are suffered and key locations are taken.
- If Fighting Spirit falls to zero then the Major Power will surrender, so maintaining Fighting Spirit is important.
- Capturing resources belonging to enemy Majors, destroying enemy land units while their supply is less than 5, and sinking enemy ships at sea irrespective of their supply value, will also provide boosts to your Fighting Spirit.
- Taking key locations marked as Fighting Spirit objectives will either boost the occupier’s Fighting Spirit or penalize their opponent’s, sometimes both. Plan your strategies accordingly as taking these locations will assist your efforts to win the war.
- If a Major surrenders due to having low Fighting Spirit then no Plunder is gained by the other side.

5.12. HQs

- HQ units are probably the most important in the game as not only do they provide supply, but they also provide combat bonuses to units under their command. In particular, HQs with a rating greater than or equal to 8 will increase the Prepared Attack bonus of units under their command by 10%.
- By default HQs command 5 units within 3 hexes, though this can be increased by researching Field Telegraph.
- Weakened HQs are less effective at both providing supply and boosting units under their command with combat bonuses.
- HQs have a minimum supply value of 3, even if they are at low strength.
- They can only be reinforced in stages, so if damaged it is wise to start reinforcing them as soon as possible. Or move them to safety if they are in extreme danger.
5.13. Supply Rules

Units receive supply from friendly resources and HQs, and unit supply is a major factor in determining combat effectiveness.

5.13.1. General Notes on Supply

- Resources which provide the most supply are Major Capitals and Major Ports, as they can provide supply values of up to 12.
- These are followed by other Capitals, Industrial Centers, Primary Supply Centers and Ports, which can potentially provide supply up to 10.
- Secondary Supply Centers and Minor’s Capitals provide supply up to a maximum of 5.
- Connection to any other friendly resource (by way of a connected chain of friendly-controlled hexes) from all of the above except for Ports will raise the connected resources to their maximum strength and supply levels. So advancing into enemy territory to cut off their troops and resources from these Key Locations can reduce enemy income, and lead to the destruction of these enemy forces at lower supply. This will help because units at lower supply are less effective and much easier to destroy!
- Captured enemy resources will generally provide less supply than friendly ones.
- The supply benefit of resources decreases with distance by 1 per hex in clear terrain.
- The rate of decrease will be greater in non-clear terrain, as such terrain is an impediment to good supply. For example, placing units in large forests, mountains or marshes, unless they are close to a nearby supply source, will generally be a bad move.
- Roads negate the effect of terrain on supply, so keeping units on or near roads is recommended.
- Oil and Mine resource types do not provide supply to any units.
- Units in low supply cannot be reinforced as well as those in higher supply, while those lacking any supply cannot be reinforced at all.
- Naval units can only be reinforced in port and, with the exception of Torpedo Boats, they can only receive a maximum of 5 strength points per turn.
- Naval units can only be fully supplied in port, though they will gain some supply from being in the proximity of friendly ports, the benefit decreasing with distance.

5.13.2. Viewing Supply
Press S on your keyboard to view current supply levels. Press it again to view a prediction of supply in the next turn, including in currently enemy territory, should you seize that territory this turn.

5.13.3. Damage to Resources
- Resources can be damaged by bombing, shore bombardment, partisan activity, scripted events and also by scorched earth when resources change hands.
- Resources damaged by any of the above will automatically repair by 1 strength point at the start of their owning side’s turn. No micro-management of this is necessary.
- Any resource except for a Major’s Capital or a Fortress that has 2 or more enemy units adjacent to it will have their resource strength reduced by 1 point per turn until it reaches 0. If there aren’t 2 enemy units present then the resource regains strength by 1 point per friendly turn, i.e. deterioration happens in enemy turns, and regaining strength only occurs in friendly turns. Gunboats and all types of river ships, being small vessels, cannot reduce the strength of enemy ports in this manner.
- The presence of an enemy unit adjacent to a port will prevent that port from providing supply to any friendly land units. Destroying the enemy unit or driving it away will enable that port to provide supply again.

5.14. Partisans
Partisan activity can be prevented by keeping units in or adjacent to their spawning hexes. Partisans may simply damage resources, or launch full scale uprisings which will place a Partisan unit on the map. These units deploy at strength 8, always have a minimum supply level of 3, and in difficult terrain front line combat units may be needed to deal with them.
5.15. Maintaining Units’ Combat Effectiveness

- Keep them in good supply.
- Have an HQ commanding them, with the best available in the most important sectors.
- Reinforce units after they have suffered casualties to the maximum as soon as possible.
- Strengthen with Elite Reinforcements if they are available and you can afford the cost.
- After reinforcing, especially from serious casualties, if possible rest the unit away from the front line for a few turns before committing it to combat again.
- Research the Automatic Upgrade categories as some of these will improve unit morale.
- The liberation of friendly countries that had been conquered, and the loss of friendly countries that surrender, will provide temporary bonuses or penalties to unit morale and readiness. So try to liberate anywhere that falls, and not to lose too many allies!

5.16. Decision Events

During the game you will be asked to make strategic decisions, called Decision Events, where you will be given information and prompted to choose either Yes or No. Further details on these events can be found in the Strategy Guide in the Manuals folder, or you can access the guide from a button on the top right of the screen while playing.

5.17. Politics and Diplomacy

- Major Powers can declare war by going to the War Maps, selecting the country you wish to declare war with, and then selecting the flag of the country you wish to declare war on. All active Minors subordinate to either Major will automatically become at war with that country too.
- It is also possible to see via the War Maps the Mobilization level of every neutral country, by clicking on the % button.
Neutral Majors only produce a proportion (relative to their Mobilization level) of their production capability, while neutral Minors only provide income via Convoys.

**Note:** in the default *American Civil War* campaigns, a special rule applies preventing neutral Majors from collecting ANY income, to represent their general lack of desire to involve themselves in the Civil War, although if certain conditions are met, they can still send some MPPs via convoys.

Every Major has a certain number of chits which can generally be invested wherever desired, although some nations are not eligible targets for diplomatic efforts (such as Guatemala).

Every diplomacy chit invested has a 3% chance of moving the target country towards your side by 7-10% if it is a Major power, with a 10% chance of that swing being 20-30% if the targeted country is a Minor.

If both sides are investing in a country, only the one with the most chits invested can swing the target country, and only their chits in excess of their opponent’s will count towards achieving a diplomatic breakthrough.

Unlike with Research, players who reclaim an invested diplomacy chit will not regain any of the MPPs invested in it.

Once a country has reached 90% Mobilization it will automatically enter the war within a few turns.

### 5.18. WEATHER

Weather effects on an individual unit are generally based on the weather in the unit’s starting location and not its destination location. Exceptions relate to Amphibious landings.

#### 5.18.1. RAIN

Balloons cannot spot enemy units, though movement is possible. Rail Movement is still allowed.
5.18.2. MUD
AP values are halved, with all units having a minimum of 1 AP.

5.18.3. SANDSTORMS
Balloons cannot spot enemy units, though movement is possible. Rail Movement is still allowed.

5.18.4. SNOW
- Rail movement is allowed.
- Attack values are halved for all unit types.
- Balloons cannot spot enemy units.
- There is no AP penalty for crossing snowed over enemy-held river hexes.
- No amphibious loading is allowed from a snowed port hex.
- No amphibious unloading is allowed onto a snowed coastal hex.

5.18.5. FROZEN
- Rail movement is allowed.
- Attack values are halved for all unit types.
- There is no AP penalty for crossing frozen enemy-held river hexes.
- No amphibious loading or unloading is allowed from or onto a frozen coastal or port hex.
- No transport loading or unloading is allowed from or into a frozen port hex.

5.18.6. STORMS
- Attack values are halved for all naval unit types.
- Naval units not within one hex of a friendly port or on a coastal sea hex (i.e. those fully at sea) may suffer some weather damage. This may be just a reduction in unit morale, or it could involve the ship losing strength.
- Note that due to the weaker construction of nineteenth century ships, storms are much more dangerous in American Civil War compared to our previous games. Be careful!
5.18.7. Ice
Naval units trapped in ice can only move 1 hex until they are clear of the ice.

5.19. The Research Mechanism

- For every chit invested, progress will be made at the end of each side’s turn towards reaching their next levels of research.
- Per turn increments to achieve the next level in a technology field average 4% per turn, in reality between 2-6% per chit.
- Research automatically succeeds in gaining the next level on reaching 100% progress, though there is a small chance of a breakthrough speeding up your progress by an extra 15-25% every turn. Researching Spying and Intelligence can speed up this process.
- Chits can be recouped at 50% of their original cost.
- Costs rise with unit upgrades, generally by 10% per level of upgrade, though some like Skirmishers only cost 5% and others like infantry Scouts cost 20%.

The notes which follow explain the benefits of each level of upgrade, firstly for Manual Upgrades, then for Automatic Upgrades.

- To benefit from Manual Upgrades, right click on a unit once the research has been achieved and select Upgrade. You can upgrade some or all of the potential upgrades available.

5.20. Manual Upgrades

**Infantry Equipment** – increases the Attack and Defense values for all non-Engineer Infantry units against all other land units. This bonus is larger when applied to larger formations of infantry: Regiments, Brigades and Rangers receive +0.5 per level, Divisions, Marines and Mountain Divisions +1, and Corps +2.

**Skirmishers** – increases the Demoralization inflicted by all non-Engineer infantry. Regiments and Brigades receive a +5% bonus per level, all other infantry receive +10%.

**Scouts** – increases Spotting radius of all infantry except Regiments and Engineers, by 1 hex.
**Cavalry Equipment** – increases the Attack and Defense values for all Cavalry units against all other land units. Cavalry Brigades and Indians receive a bonus of +0.5 per level, Cavalry Divisions and Cavalry Corps receive +1.

**Field Artillery** – increases the Attack values of Field Artillery against all land units by +1 per level, their De-entrenchment value by +0.5 per level, and their Demoralization value by +5% per level.

**Heavy Mortars** – increases the Fort Attack values of Siege Artillery and Railroad Batteries by +1 per level, their De-entrenchment value by +0.5 per level, and their Demoralization value by +5% per level.

**Mobility** – increases the Action Points of Field and Siege Artillery by +1 per level.

**Buoyancy Tanks** – grants Submarines the ability to dive and avoid enemy attacks, with a 25% chance.

**Naval Weapons** – increases the Attack values of all warships except Submarines, against Forts, Ironclads, Wooden Ships and Transports, with these increases per level being larger for larger ships. This technology also increases the Attack values of Gunboats against all types of land units, by +0.5 per level, and the Demoralization value of all warships except submarines by +5% per level.

**Ironclads** – increases the Defense values of ironclad warships against all naval units. Battleships, Cruisers and Ironclads receive +2 per level, while Monitors, Torpedo Boats and River Ironclads receive +1.

**Naval Engines** – increases the Action Points of all naval units except Submarines, by +2 per level.

**Armored Trains** – increases the Defense values of Armored Trains against all land units by +1 per level, and their Action Points by +2 per level.

**Fort Modernization** – increases the Defense values against all land and naval units for Blockhouses by +1 per level and for Defenses by +1.5 per level. Defenses also receive +1.5 Ironclad Attack per level.

**Lighthouses** – increases the naval spotting range of Ports by +2.
5.21. AUTOMATIC UPGRADES

**Corps Organization** – increases the Build Limit of Corps by +4 per level, and their Action Points by +0.5 per level. Level 1 is required in order to purchase Corps.

**Field Telegraph** – increases the number of units your HQs can command and their command range by +1 per level.

**Leadership** – increases the command rating of HQs by +1 per level, and their Action Points by +0.5 per level.

**Infantry Tactics** – improves the Unit Morale of all infantry units except Rangers and Engineers by +10% per level. Divisions, Mountain Divisions, Corps and Marines also receive +0.5 Artillery Defense per level, and all infantry units except Regiments also receive +0.5 Naval Defense per level.

**Cavalry Tactics** – improves the Unit Morale of all cavalry units (including Indians) by +10% per level. Also increases the build limit of Cavalry Divisions by +1 per level, and the Naval Defense of all cavalry units except Indians by +0.5 per level.

**Naval Tactics** – increases the Unit Morale of all naval units by +10% per level, and increases the amount of MPP loss that raiding warships inflict on enemy convoys.

**Amphibious Warfare** – increases the build limits of Amphibious Transport (LR)s and Marines by +1 per level, and +2 for regular Amphibious Transports. It also increases the Action Points of Amphibious Transports by +1 (+2 for LRs), and the Infantry and Fort Attack values of Marines by +0.5 per level.

**Experimental Submarines** – this increases the Build Limit, and Wooden, Ironclad and Transport Attack values of Submarines. Level 1 is required in order to purchase Submarines.

**Experimental Balloons** – this increases the Build Limit, Spotting Range and Action Points of Balloons. Level 1 is required in order to purchase Balloons.

**Spying and Intelligence** – this provides a +1% chance per turn, per level, of spotting enemy units, while also speeding up research by providing intelligence on the enemy’s own developments.

**Logistics** – this reduces rail movement and regular Transport costs by 10%, while also increasing all types of Transports’ Build Limits for Majors and their
respective Minors. HQ’s minimum supply values also increase by +1 per level. This also increases the Action Points of Armored Trains by +1 per level.

**Production Technology** – this decreases unit production costs by 5%.

**Industrial Technology** – this increases a Major’s home production by 10%.

### 5.22. Automatic Industrial Mobilization

Some Union resources only start producing MPPs when activated by events.

### 5.23. Military Production

- Providing they have sufficient MPPs, each Major Power can purchase units belonging to their own country, and also for their subordinate and active Minors.
- There is a Production Delay of 1-12 months before these units will be ready for deployment. This depends on unit type and the longer build times represent naval units.
- Land units that were destroyed in combat while they had a supply value of 5 or more can be repurchased at reduced cost and with a shorter Production Delay. In the default *American Civil War* campaigns, this only applies to named units.
- Certain technologies allow you to build additional units of certain categories, most notably *Corps Organization* allowing the production of additional Corps units.
- Units can only be deployed in their home countries at or adjacent to friendly cities, major cities or capitals that are connected by friendly hexes to the Capital or an Industrial Center.

### 5.24. Further Gameplay Tips

Here are some general thoughts on things to consider every turn:

- Reinforce or move to safety any battered units, replacing them if they were defending key positions.
- Look for any other key positions that aren’t currently defended, but are threatened by the enemy, and see if you can place or move units to defend them.
Now make your moves and attacks. Some useful things to know are that:

- Units that attack before moving will generally have more effect.
- Units attacking across rivers suffer a penalty, so try to cross elsewhere if possible.
- Use your Cavalry, infantry with the Scouts upgrade, or Balloons to reconnoiter before advancing deep into enemy territory. Note that in *American Civil War*, most land units only have a spotting range of 1, making this more important than ever if your army is to avoid enemy ambush!
- Maintain Cavalry units near the front line when launching offensives so that they can exploit any successes.
- Damaged units need reinforcements and good supply to recover.
- Keep your HQs, artillery, balloons and any other support units close to, but not in, the front line.
- You can sack HQs with low command ratings and replace them with better ones by right clicking on the HQ.
- Consider whether you need to buy any units to either replace losses, or for use in the near future. Plan ahead, as there will be a delay between buying a unit and its arrival.
- Upgrade any units that can be upgraded, but keep an eye on your available expenditure as some upgrades are more important than others. For instance, upgrading your navy probably isn’t very relevant if the enemy is attacking your capital.
- Consider whether you have any remaining income to undertake any research or diplomacy.
- Consider providing Elite Reinforcements to any experienced units.
- Partisans can spring up if their trigger points aren’t covered. Keep an eye out for them!
- Forests block line of sight, so bear this in mind when planning your moves.
- Check out the main Manual and Strategy Guide in the Manuals folder or access them in game using the buttons at the top right of the screen.
- Have fun! That’s what it’s all about, so don’t get too hung up on doing everything right the first time. It will come, and sometimes a decisive defeat is the best teacher.
- If you do get stuck on anything, don’t be afraid to ask on our forums. We monitor them regularly and are very happy to help.

### 5.25. Ending a Turn

Select **End Turn** from the Game Menu or use **Ctrl-E**. Military Production Points (MPPs) will be collected, based on the number of resources currently owned or occupied by your side, and income will also be received from convoys and scripted events.

### 5.26. Saving a Game

- A game can be saved at any time by selecting **Save** from the Game Menu or using **Ctrl-S**. Select a file name.
- Games played against the computer are saved in the Save folder, while Hotseat games are saved in the Hotseat folder.
- All games are also automatically saved at the start of each turn in a file called autosave.sav in their relevant default folder.

### 5.27. Exiting the Game

In order to end the game select **Quit** from the Game Menu or use **Ctrl-Q**.

### 5.28. Winning the Game

The Victory Conditions for each campaign can be seen during the game by clicking on **Options** and then the **Victory** button.

Once the game is over, multiplayer passwords are set to null so that items not previously visible under Fog of War will now become visible to both sides.

### 5.29. Support

You can report issues on the forums or email **support@furysoftware.com**.
6. MOVEMENT AND COMBAT

6.1. BASICS

6.1.1. TURN ACTIVITIES

There are five key areas to think of during each turn, and considering each of them in the following sequence will ensure that nothing important is missed out:

- **Read any Reports** – to help you assess the situation
- **Orders** – Move, Attack, Reinforce and Upgrade Units
- **Politics and Diplomacy** – Declare War, Invest Diplomacy Chits
- **Research** – Invest Research Chits and check on progress
- **Military Production** – Purchase Units and Deploy New Arrivals

6.1.2. TURN LENGTHS

The default setting is to have turns with variable lengths according to the season, with longer winter turns and shorter summer turns.

Turns are alternate rather than simultaneous, so the first Confederate turn will cover 12th to 22nd April 1861, and the first Union turn will run from 23rd April to 3rd May 1861.

**Seasons run as follows:**

<table>
<thead>
<tr>
<th>SEASON</th>
<th>DATES COVERED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spring</td>
<td>21st March to 20th June</td>
</tr>
<tr>
<td>Summer</td>
<td>21st June to 20th September</td>
</tr>
<tr>
<td>Fall</td>
<td>21st September to 20th December</td>
</tr>
<tr>
<td>Winter</td>
<td>21st December to 20th March</td>
</tr>
</tbody>
</table>

In addition to the four normal seasons, four separate sub-seasons are provided for Late Spring (May 1 to June 20), Early Fall (September 21 to October 14), Late Fall (December 1 to December 20), and Late Winter (March 1 to March 20). These don’t need to be filled in by campaign designers, but if they are then their Trigger % will apply for the periods in question. If they aren’t filled in then the Trigger % for the main seasons will apply during these periods.
Note: The length of turns, as well as whether or not they are simultaneous or alternate, is fully customizable in our Editor.

6.1.3. Visibility

The following applies if you are playing with the Fog of War option on.

All units can spot enemy land or naval units according to their set spotting ranges, though neutral Majors’ spotting ranges are limited to 1 hex. The location, though not any other details, of enemy Defenses may be seen regardless of spotting ranges, as their locations were known before war broke out.

Infantry can typically only spot units in the hex adjacent to them, while cavalry can spot land units up to 3 hexes away. Note that when determining the land spotting radius of units, only land hexes are considered: cavalry cannot spot across river ports or large bodies of water.

6.2. Moving Units

6.2.1. Indicator Sprites

- Any unit that has not yet used up any of its potential movement is considered active and will display a flashing sprite on its lower section.
- Units that have moved but that still have Attacks and are in range of attacking an enemy unit will also display a flashing sprite on their lower section.
- Units that have moved with Action Points remaining but with no Attacks remaining, will display a faded flashing sprite.
- Units that have no Action Points or Attacks remaining, are darkened to indicate that no further movement is possible.
- Units that have Attacks remaining but have exhausted all their Action Points and have no valid targets within range will have their Attacks set to zero, and they will be darkened to indicate that no further movement/Attacks are possible.

6.2.1. Sleep Mode

If you do not intend to move a unit, and don’t wish to see its indicator sprite flashing on the War Maps, nor for it to be included when you skip through
units using the Previous/Next unit buttons, you can select the Sleep option by right-clicking on the unit.

However, please note that this unit will remain in Sleep Mode in subsequent turns unless you again right click and deselect Sleep.

6.2.2. Dynamic Movement

Dynamic Movement allows most land and naval units to move or attack, be deselected, then reselected again until they have used up all their Action Points (APs) or Attacks.

The exceptions to using Dynamic Movement are some unit types including all Artillery. After Artillery attack they can move a maximum of 1 hex.

6.2.3. Specifying Controlled Movement Paths

A specific movement path can be chosen by pressing Ctrl on your keyboard.

Individual Waypoints can then be selected by left clicking on the hexes you wish to move through.

You can either select each individual hex to be moved through, or you can select several Waypoints and let the game engine determine the paths in between. Left click on the final destination to carry out the move.

Tip! If playing using Fog of War, you can use controlled movement paths to avoid surprise contacts with hidden enemy units whose location is only suspected.

6.2.4. Unit Spotting Ranges During Movement

If a unit has moved its full distance in one move, i.e. without being deselected at any point, then its full spotting range will remain after its movement. However, by moving its full movement all at once the risk of Surprise Encounters with hidden enemy units is high.

The only way to avoid these Surprise Encounters is to deselect an advancing unit, have it spot, and then move it again. But when a unit moves or attacks, after its second committed move (i.e. when it has been deselected a second time) its spotting range is reduced to 1 hex. Thus it retains its full spotting range after its first move, but loses it once it moves a second time.
The unit’s movement range will update as it is moved, and you can click on new attainable destination hexes without deselecting it.

**Tip!** Cavalry have a greater spotting range than Infantry, so moving a Cavalry unit first may disclose some enemy units. As infantry can only spot into adjacent hexes, having some cavalry in your armies is essential to prevent ambush!

### 6.2.5. Surprise Contact

Fog of war provides a special combat feature that occurs when a unit moves adjacent to a hidden enemy unit. A message denoting *Enemy Contact!* will appear when this happens. These encounters will only result in combat if it favors the hidden unit; otherwise, the moving unit may still attack normally.

**Exception:** Submarines that have dived when attacked will not attack a surprised unit that runs into them in the same turn.

On land, if the contact results in combat, then the hidden unit (which counts as the attacker) has its readiness increased by 15% for the combat calculation. Additionally, the hidden unit’s combat losses will be 15% less and the moving unit’s combat losses 15% more than they would otherwise have been.

**Tip!** Surprise Encounters can lead to your units suffering severe casualties which a more cautious advance or prior reconnaissance might have avoided.

When a surprise contact occurs at sea, the enemy contact adjustment for the attacker only applies when calculating attacker losses and does not apply when calculating defender losses. For example, if an Ironclad is moving and there is enemy contact with a Monitor, the Monitor becomes the attacker. The Monitor will still take 15% less damage when calculating its losses but it will not inflict 15% more damage on the Ironclad. An encounter at sea still favors the hidden unit, but the impact is reduced.

Land units that are surprised by a hidden enemy unit do not lose any Action Points, but surprised naval units will generally have their remaining Action Points divided by 5, except for in the following exceptions:

- Submarines in Silent Mode will have their remaining Action Points divided by 2.
- Naval units that have engaged in combat as a result of the surprise will have their remaining Action Points divided by 2.
- Naval units in cruise Mode will lose all remaining Action Points.

**Note:** any naval unit using Cruise will not be stopped by a Submarine in Silent mode.

### 6.2.6. Zones of Control

In addition to the Terrain penalties listed above, most land units exert a zone of control hindering enemy movement in adjacent hexes. To determine the extent of the zone of control exerted, all units are assigned a category:

- **Front Line Units** are Divisions, Corps, Mountain Divisions, Marines, Blockhouses, Defenses, and all naval units except for Submarines, Naval Mines, and all types of Transport.
- **Support Units** are all remaining land units apart from HQs and Balloons.
- **No Zone of Control Units** are HQs, Balloons, Submarines, Naval Mines and all types of Transport.
- **Damaged Units:** units below strength 5 do not exert any Zone of Control.
- **Naval Units in Port** do not exert a Zone of Control.

One Front line unit will exert a zone of control, and this means that all enemy units moving into, or within, one hex of it will have to pay an extra Action Point to do so, while it will require two Support units to have the same effect.

**Note:** Naval units can pass through enemy naval units but they have a 50% chance of suffering a 1 strength point loss for doing so.

**Exceptions**

- **Weak Units:** Any unit with a strength of less than 5 does not exert any Zone of Control.
- **Newly Landed Units:** Units landing from Transports and Amphibious Transports are not impeded by Zone of Control rules, though they are limited to moving up to 2 hexes.
- **Dived Submarines:** If a Submarine dives then it won’t exert any Zone of Control for as long as it remains hidden. This can lead to naval units
having the appearance of gaining some Action Points when an enemy Submarine dives near them.

6.3. LAND MOVEMENT

- Land unit movement is divided into four main areas:
  - Regular Movement
  - Rail Movement
  - Forced March
  - Swapping Units

6.3.1. REGULAR MOVEMENT

Whenever an active land unit has been selected with a left mouse click, the hexes it can move to will have a green outline.

If you now move your cursor over the hexes you can move to, the movement cost in Action Points will be shown. This cost includes any factors such as terrain penalties or moving into or within the enemy’s Zone of Control.

Left click on your chosen destination hex and your unit will move there.

6.3.2. RAIL MOVEMENT

A Rail Movement for a land unit represents its rapid transfer by rail between valid urban resources or Fortresses that are all connected by a railway.

To perform a Rail Movement, the unit must begin its turn on a railroad, and from there it must be possible to follow a railway line that travels through an unbroken path of friendly land hexes connecting it to the final destination. Other requirements are:

- The controlling Major must have sufficient MPPs to pay for the Rail Movement. This is 20% of the unit’s current production cost, though the cost is reduced by 2 percentage points with every advance in Logistics research.
- The destination rail-head hexes must be on or next to a settlement (including towns, cities etc.)
- The unit’s supply value must be at least 5.
- The origin, destination and all through points must have a strength of at least 5.
In order to Rail Move a land unit, right click on the unit and select Rail Move from the drop down menu. Left clicking on any one of the highlighted destination hexes will complete the movement. **Note** that Rail Movement triggers a 15-25% loss of unit morale.

### 6.3.3. Forced March

This enables you to move your units at a much faster pace, but in doing so they will suffer a 50-65% loss of morale. This will severely reduce their combat effectiveness.

Left click on a Land unit twice and providing it is a unit capable of Forced March, it has a supply value of 5 or more and it is not adjacent to an enemy unit, it will be able to move twice as far as usual.

The outline of the hexes it can move to solely by using Forced March will have an orange outline.

In carrying out a Forced March the unit will not be able to attack any enemy units or capture any enemy resources, and Artillery will be reduced to 1 shell when doing so. The dramatic loss of Unit Morale represents the tiredness, disruption, and logistical problems caused by the unit moving at such a rapid rate.

### 6.3.4. Swapping Units

Select one unit, press Shift and select an adjacent unit you wish to swap it with. There is a Morale penalty of 15-20% for swapping, and both units will have a maximum of 1 Action Point after doing so. Unless the swapped units have already attacked they will still be free to attack, and providing they aren’t adjacent to any enemy units, to be reinforced or upgraded.

### 6.3.5. The Effect of Terrain on Land Movement

Launching attacks reduces Action Points by 1 per attack, and moving into a clear hex or along a Paved Road (or Dirt Road in good weather) uses up 1 Action Point per hex.

However, some hexes cost 2 or more Action Points to move into, as there is an additional penalty point associated with moving into or through them as follows:
1 Penalty Point
- Major River
- Land/Sea Hexes e.g. navigable rivers such as the Mississippi
- Forest
- Marsh
- Hill
- Bush
- Bocage
- Oasis
- Desert
- Enemy held Major River
- Mud
- Rain/Fog
- Snow
- Sandstorms
- Storms at Sea

2 Penalty Points
- Jungle
- Mountain
- Lake

3 Penalty Points
- High Mountains

The above are cumulative so some hexes may require a unit to have a significant number of Action Points available to be able to move into them.

Tip! Given that supply is a very important factor on the number of Action Points a unit has, keep your units in good supply, and if possible consider upgrading them with Mobility to increase their Action Points.

6.3.6. HEX OWNERSHIP
Advancing units will not change the ownership of empty hexes that are contested by an enemy unit or resource. Instead, ownership of these contested hexes will only change if the hex is no longer contested, i.e. if the enemy unit
contesting ownership from an adjacent hex is destroyed or retreats, or if the resource is captured.

This means that you can see changes to hex ownership instantly, increasing clarity and helping with your planning.

6.4. NAVAL MOVEMENT

Naval unit movement is divided into four main areas:

- Regular Movement
- Naval Cruise
- Transport Movement
- Submarine Movement

6.4.1. REGULAR MOVEMENT

All naval units can be moved by first selecting the unit and then left clicking on any one of the highlighted destination hexes.

A specific movement path can be chosen by pressing and holding Ctrl on your keyboard. Individual Waypoints can then be selected by left clicking on the hexes you wish to move through. Left click on the final destination to carry out the move.

6.4.1.1. NAVAL UNITS AND NEUTRAL MAJORS

Naval units belonging to neutral Majors cannot be used to blockade the path of belligerent nations’ naval units. The belligerent’s units can sail through them, though they cannot literally occupy the same hexes as the neutral’s vessels.

6.4.2. NAVAL CRUISE

The option to Cruise is available for almost all naval units that have a supply value of 5 or more, and this enables them to move double their normal movement distance, but for the loss of 1 supply point.

Left click on a naval unit twice, and the outline of the hexes it can move to will change from blue to orange. Click on your destination and the unit will move there, providing it doesn’t encounter any previously unseen enemy units en route.
A cruising naval unit will not be able to attack, not even if it does encounter previously hidden enemy units in a Surprise Encounter, nor will it be able to slip past any previously unseen enemy units.

Regular Amphibious Transports and Submarines are the only naval units that cannot Cruise.

Troop Transports and Long Range Amphibious Transports can Cruise because they are generally using faster, lighter ships, whereas regular Amphibious Transports are designed more for short range operations and are less seaworthy.

6.4.3. SURFACE RAIDERS
To raid a Convoy route, Surface vessels must be in Raider mode, and this Mode can be turned on or off at any time during your turn.

6.4.4. TRANSPORT MOVEMENT
Regular Transports are used solely to move land units across the sea, and they have no attack capabilities. Transports can only load or unload units at a friendly-controlled Port, and can then be moved just like other naval units.

The cost for embarking units in Transports is set at 5% of unit cost, but Logistics research will decrease this cost by 10% per level.

Even if the controlling Major has sufficient MPPs, each country can only put a limited number of units in Transports at any one time. This limit will increase through researching Logistics, as Build Limits will increase by 1 per level for Majors and their respective Minors.

To transport a land unit using regular troop Transports, the unit must be active and located adjacent to a friendly Port (including River Ports) that has a strength of at least 5.

By right clicking on the unit and selecting Transport from the drop down menu, the land unit will be replaced by a Transport icon either directly on top of the Port hex or, if there is already a unit in the Port, adjacent to it. The Transport will have a supply value of 10. If more units are present to be placed in Transports, they can be embarked as long as there are available sea hexes adjacent to the Port for them to go to.
In terms of combat, Transports are quite weak since they cannot attack and their defense is poor. They do have a 10% chance of evading damage if attacked, but even so, providing them with naval escorts is strongly recommended.

A regular Transport can be moved immediately after loading. The embarked unit can only be unloaded in a friendly Port, and possibly in the same turn if it has sufficient Action Points to reach the new Port destination.

To unload in a friendly Port, move the unit into the desired Port hex and then finish its movement. The unit will remain active and may be unloaded either by left clicking on the Transport again, or by right clicking on it and selecting Unload from the drop down menu. Left clicking on any one of the highlighted hexes adjacent to the Port will complete the unloading.

Nevertheless, regular Transports can only enter and unload in a Port in the same turn if the Port has a strength of at least 5. If the Port’s strength is below 5 then the Transport can enter in one turn and unload in the next. This represents the disruption to unloading facilities that would exist in a damaged Port.

**Note:** Transport loading or unloading cannot take place at a frozen Port hex.

Once unloaded, the Transport icon will disappear and the original transported unit will then land with a maximum supply value of 5 regardless of the current Transport supply value. In most cases this will be a reduction in unit supply and it represents the reorganization required following troop transport. Morale is recalculated when the unit is unloaded, which may also result in a reduction in unit readiness, but the unit may now move and fight normally.

### 6.4.4.1. LIMITS ON TRANSPORTS

Each country can only put a limited number of units in Transports at any one time. This limit will increase through researching *Logistics*, as Build Limits will increase by 2 per level for Majors and their respective Minors. *Logistics* also decreases the cost of putting units in Transports by 10%.

### 6.4.5. AMPHIBIOUS TRANSPORTS

Amphibious Transports are used to conduct invasions against enemy shores, so their use may be important for both sides at times. Note that neutral Majors cannot embark units into Amphibious Transports.
The cost for Amphibious Transport is set at 10% of unit cost, and this higher cost is due to the specialized organization and equipment required for an amphibious landing.

Researching *Amphibious Warfare* will increase the Action Points and Build Limits of Amphibious Transports.

Like regular Transports, land units have to be embarked on Amphibious Transports at a Port that is at strength 5 or more. However, they can unload not only in friendly Ports, but also directly onto friendly or enemy held Coastal hexes (or the banks of navigable rivers).

Marines are a unique unit type in that they don’t need to be adjacent to a Port in order to embark in an Amphibious Transport.

Right click on the unit and select Amphibious Transport from the drop down menu, and the unit will be replaced by an Amphibious Transport icon either directly on top of the Port hex or adjacent to it.

Unlike regular Transports, the Amphibious Transport cannot move on the turn the unit embarks unless level 1 in *Amphibious Warfare* has been reached, in which case it will be able to move 1 hex after loading. This can be useful as it increases the ability to load multiple units at a single port.

On your next turn you will be able to move the Amphibious Transport in accordance with its number of Action Points.

Like regular Transports, the embarked unit will be given full supply of 10 and there will be an immediate recalculation of morale to reflect this supply value. If more units are present to be placed in Amphibious Transports, they can be embarked as long as there are available sea hexes adjacent to the Port for them to go to.

The Amphibious Transport’s supply value will drop by 1 each turn it is at sea, and its Action Points and the embarked unit’s readiness will also fall the longer it remains at sea.

Regular Amphibious Transports cannot Cruise or use Dynamic Movement, so their moves need to be planned well, especially with a view to avoiding them being at sea for very long.

The Weather will impact on some amphibious operations, as:
- No Amphibious loading is allowed from a snowed Port hex.
- No Amphibious unloading is allowed onto a snowed Coastal hex.
- No Amphibious loading or unloading is allowed from or onto a frozen Coastal or Port hex.

To help soften up the target before a landing is made, Amphibious Transports can themselves attack an enemy unit occupying a Coastal hex, before the unit they are carrying is landed. This feature enables amphibious units to attack small defended islands. However, it can only unload into an empty hex, so the defender will have to be eliminated before landing. Once the unit has been unloaded from the Amphibious Transport it can attack again.

**Note:** This is the era before dedicated landing craft were designed to aid amphibious landings. While it is still possible to launch attacks while your units are still in their Amphibious Transports, such attacks are likely to result in heavy casualties.

To unload onto either friendly or enemy territory, move the Amphibious Transport adjacent to the desired Coastal hex and then finish its movement. The unit will remain active and may be unloaded, either by left clicking on the Amphibious Transport again or by right clicking on it and selecting Unload from the drop down menu.

Left clicking on any one of the adjacent highlighted Coastal hexes will complete the unloading. The Amphibious Transport icon will disappear and the original transported unit will then land with its current supply onto the selected Coastal hex. Once unloaded, the unit may move and fight normally.

When unloading an Amphibious Transport onto enemy territory, the unit only has 2 Action Points so it cannot move too far inland. Also, when unloading onto enemy territory there is a chance that landing casualties will be suffered. This random chance is related to the amphibious unit’s current supply as shown in the following formula:

\[
\text{Landing Casualty Chance} = 100 - (\text{Amphibious Unit Supply} - 1) \times 10
\]

As supply decreases over time, the longer a unit is at sea the greater its chance of suffering landing casualties. If this trigger is met, the landing casualty penalty will be a loss of up to 25% of unit strength in good weather, and up to 40% in bad weather.
Also, if landing on non-clear terrain then there is a 50% chance of suffering additional landing casualties on top of the previous landing casualty rule. Morale and readiness will then be recalculated after any landing losses are factored in.

Enemy naval units and fortress Defenses will fire on Amphibious Transports that halt in an adjacent hex, even if only temporarily prior to landing, so if your own naval units and bombers can deal with these prior to the landing then that will help to keep your casualties down.

6.4.6. AMPHIBIOUS TRANSPORTS (LONG RANGE)

These act just like Amphibious Transports except that they don’t lose supply every turn, have a much greater normal movement range, and they can Cruise.

Their ability to Cruise is really useful for launching invasions far from their starting point. However, as they are 25% more expensive than regular Amphibious Transports, their use should be carefully considered before embarking the troops.

Long Range Amphibious Transports also benefit from increased Action Points and Build Limits when Amphibious Warfare is researched.

6.4.6.1. LAUNCHING SUCCESSFUL INVASIONS

The key to successful amphibious landings is to have the units embarked for the shortest possible time, with naval escorts, and for them to seize a port as soon as possible after landing.

To maintain supply after the landing, it is important to land a HQ as part of the invasion force, keeping it safe from counterattack so that it can provide command and logistical support in subsequent turns as reinforcements are fed into the battle and the enemy driven back.

HQ units, after amphibiously unloading, start at 10 supply and maintain supply for up to 5 turns with a drop of 2 supply points per turn. This is similar to Marines, and allows the HQ to act as a supply source for an initial landing until further supply sources are achieved.

6.4.7. SUBMARINE MOVEMENT

Submarines have a Mode option that can be set by right clicking the unit and selecting the appropriate Mode from the drop down menu.
- **Hunt**—This is a Submarine’s default status, allowing them to move their full range each turn, and it will display a small blue button when in this mode.
- **Silent**—Set to run silent and pass through enemy naval units undetected, though with only 2/3 their normal number of Action Points.
- Submarines in Silent Mode will display a small red button when in this mode.
- Changing from Hunt to Silent Mode or vice versa can only be done before the Submarine moves or attacks.

Submarines that are attacked while running in Silent mode, will have their potential losses reduced by 50%. They will also have the effectiveness of their defensive return fire reduced by 50%.

**Note:** Submarines in Port that are in Silent Mode will not benefit from being in Silent Mode if attacked. Nor will they be hidden from enemy spotting like they would if at sea. However, if a Submarine is attacked while in Port, the damage it receives is automatically halved.

The Submarine’s Silent Mode represents movement beneath the surface where Submarines can pass through any enemy units unless they end their move next to one.

When attacked, Submarines have a % chance of diving (note that this is zero unless the Submarine has been upgraded with Buoyancy Tanks). If they dive, they have a 25% chance of losing 1 strength point.

If they do dive then they will generally move 1-2 hexes away, and if they were in Hunt Mode then they will automatically switch to Silent mode. This means that the attacker will probably have to relocate the Submarine before it can be attacked again.

Note that the best use of Submarines in combat is to lurk and ambush enemy vessels. If however a Submarine moves before attacking then the vessel it attacks will have its losses reduced by 50%, and the attacking Submarine will have its losses doubled.

### 6.4.8. Oceans, Coasts and Rivers

Unlike previous *Strategic Command* games, *American Civil War* divides sea hexes into three categories: Coast, Ocean and River. For reasons of historical
seaworthiness, some naval units are restricted from entering one or more of these types of sea tiles, so these divisions will have a significant impact on the movement of your naval units.

As a general rule of thumb, hexes that are within four hexes of the coastline will be considered Coast tiles. All naval units, except for River Ironclads, River Timberclads, and River Gunboats (“River ships”), can enter Coast tiles.

Hexes that are more than four hexes from the coastline will instead be considered Ocean tiles, representing deeper and more challenging waters. River ships, Gunboats, Monitors and Submarines cannot enter Ocean tiles.

Inland waters, such as the Mississippi River and Hudson-Delaware Canal, are considered River tiles. Most commonly, these will appear on the map as Land+Sea hexes (that is, hexes that both land units and sea units can occupy), although some larger bodies of water such as the Great Lakes also function as Rivers for game purposes. These navigable Rivers can only be traversed by the three River ships, Gunboats, and all types of Transports. Land units treat River hexes as they would any other Land+Sea tile, and the River distinction only applies to naval units.

The distinction between Coast, Ocean and River tiles only determines which units can enter a particular hex, and otherwise has no impact on movement, combat or any other factors such as storm damage. All sea hexes require 1 AP to move through.

Unlike our previous games, American Civil War allows all naval units, including Transports, to move through and occupy enemy-held Land+Sea hexes, with the exception of hexes that contain an enemy-controlled port (including River Ports). This means that it is possible to load units onto Amphibious Transports and sail them deep into enemy territory before unloading. Beware that if you do so, your land units (though not your ships) will still be bound by the usual supply rules. Towns taken in such a manner can trace their supply along Land+Sea hexes, but only if every hex along the route is controlled by that side. Note that enemy-controlled towns along the river’s banks (and passing enemy units) will exert their zones of control at the end of the turn just like any other resource in the game, which may result in this line of supply being broken.
Naval units moving through inland waters will still be bound by their own supply rules, and while they can occupy and control Land+Sea hexes, they cannot be “cut off” from supply.

**Note:** Naval units can move through River hexes that are occupied by an enemy land unit, but will suffer the loss of one strength point in doing so. Rules for moving through enemy naval units are the same in Rivers as they are on the open seas.

### 6.5. COMBAT

There are two basic types of combat: land and naval. Unlike some games where multiple units may combine their attacks into a single combat, units in *Strategic Command* move and attack individually, and may do so in any order.

Therefore, you are advised to learn to sequence and orchestrate your combat maneuvers depending on the situation. While most units can participate in both attack and defense sequences, some restrictions may apply and will be further explained in the sections below.

To launch an attack, left click to select one of your units that has an enemy unit within its Attack Range, and move your mouse cursor over the enemy unit.

#### 6.5.1. Combat Predictions

Before attacking, the estimated combat results from an attack can be seen above the target cursor as well as in the center of the Information Panel at the bottom of the screen.

#### 6.5.2. Combat Results

Once combat is resolved, the casualties suffered will appear temporarily above each unit/resource that suffers a loss.

#### 6.5.3. Fighting Spirit Bonus

Whenever an enemy unit is destroyed when its supply status is less than 5, the Major whose unit destroyed it will receive a Fighting Spirit bonus equal to the MPP cost of the unit it has just destroyed.

If a unit belonging to a Minor power destroys an enemy unit, then its controlling Major will receive the Fighting Spirit bonus.
6.5.4. LAND COMBAT
Most land units can participate in two different modes of combat:

- Prepared Attack
- Regular Combat

Artillery units work differently in that they may fire Offensively and/or Defensively, and they cannot fire after moving.

6.5.4.1. LAUNCHING ATTACKS
Left click to select one of your units that has an enemy unit within its Attack Range, and move your mouse cursor over the enemy unit you would like to target.

For most land units their Attack Range is 1 hex, though for Artillery units it will tend to be 2 hexes.

Once a valid target has been found, both the attacker and defender information is shown at the bottom of the screen. Also, the expected combat losses are shown at the top center of the information bar, as well as above the unit's involved, as shown below.

Note: HQ units cannot attack at all since they are administrative in nature.
**6.5.4.2. PREPARED ATTACK**

A Prepared Attack occurs when a land unit (excepting any Artillery units) attacks without moving first. The attacking unit receives a 40% readiness bonus in the combat calculations (50% if commanded by an HQ with rating greater than or equal to 8).

Although none of the official *American Civil War* campaigns allow units to do so, if a unit can launch 2 or more Attacks, it will only benefit from the Prepared Attack bonus with its first attack.

**6.5.4.3. REGULAR COMBAT**

This occurs when a land unit moves before attacking, and because the attack isn’t prepared it doesn’t benefit from the Readiness boost that a Prepared Attack gives.

**6.5.4.4. ATTACKS AND ACTION POINTS**

Each attack costs one Action Point, so a unit that attacks before moving its full potential distance will have its potential movement distance reduced.

**6.5.4.5. RIVER CROSSINGS**

When attacking across enemy held watercourses the attacker suffers a Readiness Penalty in the combat calculation as follows:

<table>
<thead>
<tr>
<th>ATTACKING ACROSS</th>
<th>READINESS PENALTY</th>
</tr>
</thead>
<tbody>
<tr>
<td>River</td>
<td>20</td>
</tr>
<tr>
<td>Major River or Land/Sea Hex (this includes Navigable Rivers)</td>
<td>35</td>
</tr>
<tr>
<td>Stream/Wadi</td>
<td>10</td>
</tr>
</tbody>
</table>

**6.5.4.6. OFFENSIVE AND DEFENSIVE ARTILLERY**

Artillery units of all types receive a supply of shells each turn, and these can be fired one by one during your turn, or left so that should your opponent attack anyone within range of your artillery, they will fire defensively to protect the targeted unit.

Artillery can fire blindly, potentially damaging hidden units, though the firer will not discover from this whether or not any enemy units are present.
Siege Artillery will only provide Defensive Fire against enemy artillery units. Railroad Batteries can only fire offensively, they do not provide Defensive Fire. Artillery and Railroad Batteries can either fire or move in their turn. If they fire, then they can move 1 hex after firing.

Fortress Defenses cannot move, but they can fire either offensively or defensively. Their Defensive Fire will target any enemy Amphibious Transports that come within range, so they can be very useful against an enemy invasion.

6.5.4.7. Retreats

Weakened units may retreat when attacked. This may happen if their estimated remaining strength after the combat is 5 or less, and the unit will be fully de-entrenched. However, if they retreat then the attacker will only receive 50% of their potential losses, and in retreating they may leave a resource unguarded, and a follow up attack will have a very good chance of destroying the retreating unit.

The chance of a unit retreating depends not only on its strength, but also on its unit type and on the hex it is occupying when it is attacked. The potential retreat range is also dependent on the unit type.

For example, here are some examples of the % chances of some unit types to retreat, depending on the hex they are in when attacked, along with their maximum retreat range:

<table>
<thead>
<tr>
<th>HEX TYPE</th>
<th>ALL UNITS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-Resource</td>
<td>75%</td>
</tr>
<tr>
<td>Town, Settlement, Mine, Oil</td>
<td>50%</td>
</tr>
<tr>
<td>City, Major City, Fortification, Fortified Town</td>
<td>30%</td>
</tr>
<tr>
<td>Fortress, Major Fortress</td>
<td>0%</td>
</tr>
<tr>
<td>Maximum Retreat Range</td>
<td>3 hexes</td>
</tr>
</tbody>
</table>

6.5.4.8. Shattered Units

If a unit is at strength 1 or 2 when it is attacked, and it is unable to retreat, then it will be destroyed instead.
6.5.4.9. Reduced Operational Efficiency

Damaged Urban resources cannot carry out the following functions:

- If at less than strength 5, they cannot be used by land units for Rail Movement.

A Port that has been reduced below strength 5:

- Cannot be used to load units into Transports.
- Cannot be used to unload units from Transports in the same turn that they enter the Port.

6.5.4.10. Reduced Economic Value

Naval and artillery bombardment will immediately reduce an opponent’s MPPs, as each point of damage inflicted on the resource will deduct MPPs proportionate to the economic worth of that resource.

End of turn MPP income will also be reduced, as a damaged resource will not provide its full potential output until they have been fully repaired.

As resources only repair themselves by 1 strength point per turn, if severe damage is inflicted then it can take a long time for normal production to resume, and repeated attacks every 3-4 turns can prevent this recovery.

Reduced value as a Supply Source

Damaged Urban resources will provide less supply to units in their vicinity, so this means that unless they have alternative supply sources, enemy units in this area will have their combat efficiency reduced and be easier to destroy.

6.5.5. Naval Combat

Naval combat is divided into four main areas:

- Regular Combat
- Naval Mines
- Shore Bombardment
- Convoy Raiding
6.5.5.1. Naval Combat and Supply

Each combat that a naval unit is involved in will use up 1 supply point, whether the unit is attacking or defending. The only time that a unit doesn’t lose a supply point when attacked is when a Submarine avoids an attack by diving.

6.5.5.2. Sinking Enemy Vessels

Whenever a vessel is sunk, the Major whose unit sinks it will receive a Fighting Spirit bonus equal to the MPP cost of the vessel sunk, and its owner will suffer a similar penalty. If it were a Battleship, Cruiser, Ironclad, Monitor, Ship of the Line or Frigate then the penalty is double the cost.

If a unit belonging to a Minor power destroys the enemy vessel, then its controlling Major will receive the Fighting Spirit bonus.

6.5.5.3. Regular Combat

Regular naval combat occurs whenever a naval unit attacks another naval unit within its Attack Range, either before, during or after moving. The Attack Range for all naval units is 1 hex.

Generally the higher the class of surface vessel, the more dangerous to the enemy their attacks will be, so Battleships will tend to defeat Cruisers and Ironclads, which will in turn tend to defeat Frigates and Gunboats. Ironclad-class ships are also much more powerful than Wooden ships, as their iron armor is almost impervious to Wooden ships’ older cannons.

Note that the best use of Submarines in combat is to lurk and ambush enemy vessels. This is because if a Submarine moves before attacking then the vessel it attacks will have its losses reduced by 50%, and the attacking Submarine will have its losses doubled.

Attacking Naval Units In Port

All attacks by land units on a Port will target any naval units in the Port. Attacks by surface vessels, except Gunboats, river ships and Torpedo Boats, will target the Port first, and they will then have a small % chance (as shown in the Combat Predictions Table before attacking) of damaging any naval units that may be in the Port.
All naval units in Port are very vulnerable to attack by land units. So if enemy ground forces are near any of your Ports, and the situation looks precarious, it might be best to move any naval units out of the Port.

6.5.6. NAVAL MINES
Naval Mines can provide a good way of damaging enemy naval units with little risk to yourself.

Laying Minefields
Naval Mines can be laid 2 per turn by Gunboats, River Gunboats and Torpedo Boats belonging to a Major that is fully mobilized and at war.

Each Major has a pre-defined Build Limit of Naval Mines. The number of minefields on the map can never exceed that Major’s Build Limit, though as minefields are removed from the map when they are struck by vessels, so their owning Majors will be able to relay them.

**Note:** The Build Limit for Naval Mines for all Majors in 1861 Blue and Gray, and other default campaigns, has been set to zero. This means they will not be seen in those campaigns, although you may choose to add them to your own custom campaigns.

The Gunboat or Torpedo Boat must have a supply value of 5 or more, have not engaged in combat this turn, and it must not have already used up all its Action Points. Nor can it be adjacent to an enemy unit.

The unit laying a minefield will have its remaining Action Points divided by 5. This means it could be vulnerable to enemy attack in their forthcoming turn.

**Tip!** With a Gunboat or Torpedo Boat selected, mines can be laid with a right click on the unit, a click on the Operation Action Button showing the Naval Mine icon, or by left clicking on the Gunboat/Torpedo Boat 3 times if it hasn't moved, or 2 times if it has moved but not yet been deselected.

Moving into Minefields
All surface vessels have a 50% chance of striking an enemy mine when attempting to move through a minefield, or when moving adjacent to a previously unseen minefield, including when using Naval Cruise.
Submarines in Silent Mode can move through a friendly minefield with impunity, whereas Submarines in Hunt Mode and all other surface vessels have a 25% chance of striking a mine when doing so.

Submarines in Silent Mode have a 10% chance of striking a mine when attempting to move through an enemy minefield, or when moving adjacent to a previously unseen minefield.

Submarines in Hunt Mode have a 25% chance of striking an enemy naval mine when passing through an enemy minefield.

If a unit does strike an enemy minefield, it will lose 2-5 strength points and it will suffer an 8-15% unit morale penalty. Additionally it will have its remaining Action Points halved, while a unit in Cruise Mode will have its movement ended.

The minefield will be considered to have been cleared in the process, and it will be removed from the map.

**Note:** Minefields placed in strategic locations can trigger events the same way a warship placed in that same location would.

### 6.5.6.1. Shore Bombardment

This occurs whenever naval units attack resources and enemy units located on a Coastal hex. These attacks can help soften up any defenses prior to an amphibious landing.

When a unit is ordered to perform shore bombardment on a resource, damage can be inflicted on that resource even if there is a unit located there. Shore bombardments will first attack the resource and then there is a 10% chance (+10% for each level of *Naval Weapons* research) that a defending unit located on the resource will also suffer a strength point loss. Note that Submarines cannot perform shore bombardment.

### 6.5.6.2. Convoy Raiders

In addition to their regular naval combat capabilities, surface vessels (but not Submarines) can be selected to hunt enemy Convoys in order to disrupt enemy shipping, thus reducing your opponent’s income.

Active Convoy routes are shown as red or blue lines in game, or as white lines if they are inactive. These can both also be seen on the Convoy Map.
To raid a Convoy route:

- The raiding unit must be within 1 hex of a Convoy route
- The raiding unit cannot be adjacent to any enemy naval units
- The raiding unit must be in Raider Mode

Convoy raiding will reduce the income received by the Convoy’s recipient, and Union players are advised that a concerted campaign against the Confederacy can have a very significant impact on their income.

Convoy raiding will also inflict a small Fighting Spirit penalty on the Convoy recipient. Gunboats inflict a reduction of 8 Fighting Spirit points against the Convoy recipient, while other vessels will have a smaller effect.

Naval units gain 0.05 experience per successful raid.

**Tip!** At zero supply units cannot raid convoy lines, and Submarines cannot dive, so returning to port periodically to refuel is strongly advised. The time in port can also be used to reinforce and upgrade.

### 6.5.6.3 Convoy Raiding Mechanism

Resulting enemy MPP losses, up to the maximum value of the Convoy, are determined by the following formulas:

\[
\text{Convoy MPP Loss} = \frac{\text{Random Value}}{10} \times \text{Raider Raid Multiplier} \times \text{Seasonal Decrease }\%
\]

Where: Random Value \([\text{Raider Strength}, \text{Raider Strength} + (\text{Raider Strength} / 2)]\)

### 6.5.7 Purchasing Units

Units may be purchased at any time during your turn by selecting Purchase from the button at the top of the screen, or using the **Ctrl-P** Hotkey.

Once the Purchase Unit dialog appears, available units by country and by type will be selectable on the left, while a breakdown of their combat values will be displayed in a single column on the right.

By clicking on the Major country flag at the top, the name of that country and all its active Minors will appear in the Select Country box. All purchases are made by the Major powers, and they are responsible for paying for any new
units belonging to their Minors. If buying a unit for a Minor, click first on the Major's flag and then on the relevant country's name. The Minor must be both allied to you and an active participant in the war, i.e. it hasn't surrendered.

The names of the unit types available for purchase are shown in white, while those that you could have bought had you sufficient MPPs are shown in gray. The number of units of each type available for purchase are shown in parentheses. If you are playing with the Production Delay option then these will be followed by the number of months or turns before the purchased unit will be ready to deploy. (In all default campaigns, the delay will be given in Months).

In the Set Name box, you can select the named unit you wish to purchase, or you can change the name providing the new name you choose does not already exist for that unit type.

The dialog screen will show an icon for the selected unit type, the base unit cost including any costs for any upgrades you apply, and its adjusted unit cost in parentheses. These adjusted costs will take into account any reductions due to Production Technology research, and Soft Build Limit penalties if you are playing with that option switched on.

Unit types whose Build Limit has already been reached will be shown in red, as will those that will only be available for purchase at a later date. You can tell the latter from the former by clicking on the unit type's name, as if they can't yet be bought then they will show the date when they will become available.

6.5.7.1. Upgrading Units when Purchasing

In the Upgrade box at the bottom of the dialog you can add upgrades when you purchase the units in accordance with your current research levels. The corresponding unit cost and combat values are dynamically adjusted as you add or remove selected upgrades. If the adjusted unit cost is more than a country's currently available MPPs, the cost will be highlighted in light gray, and the Purchase button will be unselectable.

Tip! If MPPs are tight and you need to produce units quickly, then upgrade them later when you have more MPPs available.

Tip! If you are researching Production Technology and are not in a rush for new units, wait until you have achieved success in this category as that will reduce their cost by 5% per level attained.
Once a unit is selected and you have added any upgrades, click on the Purchase button to complete the purchase. Purchased units will arrive as new units for placement as described below under New Unit Arrivals. Once all purchases are complete, click on the Close button to return to the Game Menu.

### 6.5.7.2. Reforming Destroyed Units

When a land unit is destroyed with a supply level of at least 5, it can be repurchased at 60% base cost with half the usual Production Delay. In the Purchase List, these unit’s names will be annotated with an ‘*’.

**Tip!** Prioritize these for repurchase rather than other units of the same type.

This represents the ability to repair equipment, call on cadres, partially trained recruits and the wounded returning to the ranks. This isn’t available to naval units as even though they represent more than one vessel, land units are much better able to recover from losses and be reconstituted into fighting formations, albeit ones that will have lost any experience they may have had before they were destroyed.

In the default campaigns for *American Civil War*, unit reform rules only apply to land units that have been given unit names (for instance Divisions, which bear the name of their commander), but not to those that do not (such as Regiments, which are considered too small to reform, or Armored Trains, which were typically ad hoc constructions without a standardized design). Note that this is only a convention, and will not necessarily be the case in custom campaigns.

### 6.5.7.3. The Production Table

Units scheduled to arrive for each Major and their respective Minors can be accessed by either right clicking on the Major’s flag at the top left of the screen, or by clicking on the Production button within the Purchase screen.

The Production Table shows all units that are due to arrive in future game turns, i.e. that are in the Production Queue. These can be units included within the campaign as well as units that you have purchased. Though if you are playing with the Production Delay option switched off, then only the former would show, as any units you buy can be deployed immediately after purchase.
Arrivals are arranged in two-month periods; e.g., Jan/Feb, Mar/Apr, etc. with their specific arrival dates and locations, if applicable, listed beneath the unit graphics. Click on OK at any time to exit back to the previous screen.

**Note:** Units destined to arrive by script or as a result of Decision Events are not shown in the Production Queue.

### 6.5.8. New Unit Arrivals

New units becoming available for deployment this turn, or that weren’t deployed in previous turns, are displayed when you start the turn in a New Units dialog box as shown below:

Select a new unit and click OK to place it on the map. Valid locations where the unit can be deployed are highlighted on the map. Left click on one to place the unit there.

**Note:** Unlike our previous games, in *American Civil War*, land units may only be deployed at Cities, Major Cities and both types of Capitals.

You can continue placing units until there are no more available this turn, or you can click Cancel to delay any remaining unit placements until either later this turn, or in a future turn.

If you do delay any or all unit placements, you can select New Units from the Game Menu or use **Ctrl-N** at any point during the turn to bring up the New Units dialog again. The only reminder that new units remain available for placement is that the New Units button on the Game Menu remains highlighted. If there are no new units available, the menu button is grayed out.

New units may not move or engage in combat during the turn that they are placed on the map.

**Tip!** Regardless of how long the deployment of new units is delayed, they will deploy with 50% morale. So there is very rarely anything to be gained by delaying unit deployments beyond the current turn, unless you are very uncertain of where you wish to place them.
6.5.8.1. New Units’ Supply
Most new units have a supply value of 10 when they deploy, except when they belong to a neutral Minor when it enters the war, or when a Major enters the war and some of its units deploy by script. These units will have supply of 3 for that turn.

This means that an aggressor has the potential to wreak havoc in the turn that they attack a neutral country, but they may face stiffer opposition in subsequent turns as any surviving enemy units will have better supply.

6.5.9. Reinforcing Units
To reinforce a unit, right click on it and select either Reinforce or Elite Reinforcements from the drop down menu. If the unit cannot receive any of these then these options will be grayed out.

**Note:** Reinforcing a unit completes its action for the turn.

A unit can be reinforced providing:

- It has not yet carried out any actions this turn, or has only swapped position with a friendly unit.
- Its current Supply Value allows for an increase in strength.
- Its controlling Major has sufficient MPPs available.

A unit’s maximum reinforcement value is relative to its Supply Value, see the Supply and Reinforcements Table for full details.

Regular reinforcement will allow a unit to be reinforced up to a maximum strength value of 10, with a small reduction in experience for every strength point reinforced. This represents the intake of new recruits lacking in combat experience.

Note that naval units (with the sole exception of Torpedo Boats) can only receive a maximum of 5 strength points per turn.

6.5.9.1. Surrounded Units
These can only be reinforced to a **maximum** strength of 5, irrespective of their supply level and available MPPs.
6.5.9.2. Elite Reinforcements

Elite Reinforcements can only be applied if a unit is already at full strength. The reason for this is that adding Elite Reinforcements increases a unit’s strength beyond the normal maximum without any loss in experience. These are more expensive than regular reinforcements and can only be added if there are no adjacent enemy units.

Units can only receive 1 extra strength point of Elite Reinforcements per turn, and they can only receive these up to the number of full experience bars that they are carrying. For example, a unit with 2 experience bars can only be reinforced to 2 strength points beyond its normal maximum.

Note: HQs cannot receive Elite Reinforcements.

6.5.9.3. The Cost of Reinforcing Units

The following formulas reflect the relative reinforcement costs of a unit due to combat losses:

- Regular Reinforcement Cost = # of Strength Points * (Cost of Unit / 10) / 2
- Elite Reinforcement Cost = Regular Reinforcement Cost * 2

6.5.10. Upgrading Units

To upgrade a unit, right click on it and select Upgrade from the drop down menu.

Once the Upgrade dialog appears, a list of available research levels will be displayed on the left hand side and a breakdown of the unit’s adjusted combat values as you apply upgrades will display in brackets [...] on the right.

You may customize units by setting the exact upgrades by type and level, and the cost is dynamically adjusted as you do so, so you can consider different options before deciding.

Note that units belonging to most Minors will cost more to upgrade.

It will at times be the case that a unit can only be upgraded in one of its research categories, either because others haven’t yet been researched or because sufficient MPPs aren’t available.
A unit can be upgraded providing:

- It has not yet carried out any actions this turn, or has only swapped position with a friendly unit.
- Its current Supply Value is at least 5.
- Its controlling Major has sufficient MPPs available.
- There are no adjacent enemy units.

If the unit cannot be upgraded, the drop down menu option will be grayed out.

**Note:** Upgrading a unit completes its action for the turn.

**Tip!** It isn’t necessary to upgrade units to their maximum potential. It is fully up to you how many upgrades you implement.

### 6.5.10.1. Upgrading Ports

Ports (including River Ports) may be upgraded with *Lighthouses*, providing that category has been researched (in all default campaigns, all Majors will have
the maximum level of this technology). To upgrade a resource and increase its naval spotting range, right click on it and select Upgrade.

If a unit is also located on the port, the drop down menu will expand to allow either the unit or the port to be selected.

Once the Upgrade dialog appears, a list of available research levels will be displayed on the left hand side and a breakdown of the resource’s adjusted values will be displayed in brackets [...] on the right.

**Note:** No other resources, such as cities, may be upgraded with *Lighthouses*.

### 6.5.11. Renaming Units

In order to rename a unit, right click on it and select **Rename** from the drop down menu.

**Note:** A check is made when renaming a unit to determine if the new name already exists for the country and unit type. A warning message will prompt you to select another name if it does.

### 6.5.12. Disbanding Units

Land units (including Balloons) belonging to Major powers can be disbanded, and any unit that is disbanded results in an immediate recovery of MPPs as shown in the formula below:

\[
\text{Recovered MPPs} = \frac{\text{Unit Cost}}{10} \times \text{lowest value of unit's supply or strength} \times 20\%
\]

In order to disband a unit, right click on it and select **Disband** from the drop down menu.

To avoid abuse of this feature, a unit can only be disbanded if:

- It has not yet carried out any actions this turn.
- It has a current supply value > 0.
- No enemy units are adjacent.

Naval units, Forts and Minor’s units cannot be disbanded, again to avoid abuse. Also excepted from being able to disband are units that have unloaded from Transports this turn.
7. ADVANCED GAMEPLAY CONCEPTS

7.1. GENERAL UNIT CHARACTERISTICS

The following table outlines the basic characteristics for all units:

<table>
<thead>
<tr>
<th>CHARACTERISTIC</th>
<th>MAX VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experience</td>
<td>Up to 5*</td>
</tr>
<tr>
<td>Supply</td>
<td>10</td>
</tr>
<tr>
<td>Action Points</td>
<td>Unit’s AP Value</td>
</tr>
<tr>
<td>Strength</td>
<td>Varying from 1-15</td>
</tr>
<tr>
<td>Attacks</td>
<td>0-2</td>
</tr>
<tr>
<td>Morale</td>
<td>Determined by Formula</td>
</tr>
<tr>
<td>Readiness</td>
<td>Determined by Formula</td>
</tr>
<tr>
<td>Entrenchment</td>
<td>Dependent on Terrain Type</td>
</tr>
</tbody>
</table>

*This is a potential maximum, but in the official campaigns this is set to 3.

7.2. COMBAT TARGET VALUES

Each unit type also has Combat Target Values for:

<table>
<thead>
<tr>
<th>ATTACK VALUES</th>
<th>DEFENSE VALUES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Soft</td>
<td>Soft</td>
</tr>
<tr>
<td>Infantry</td>
<td>Infantry</td>
</tr>
<tr>
<td>Cavalry</td>
<td>Cavalry</td>
</tr>
<tr>
<td>Artillery</td>
<td>Artillery</td>
</tr>
<tr>
<td>Fort (this is an unused slot)</td>
<td>Fort (this is an unused slot)</td>
</tr>
<tr>
<td>Armored Train</td>
<td>Armored Train</td>
</tr>
<tr>
<td>- (this is an unused slot)</td>
<td>- (this is an unused slot)</td>
</tr>
<tr>
<td>- (this is an unused slot)</td>
<td>- (this is an unused slot)</td>
</tr>
<tr>
<td>- (this is an unused slot)</td>
<td>- (this is an unused slot)</td>
</tr>
<tr>
<td>Balloon</td>
<td>Balloon</td>
</tr>
<tr>
<td>Ironclad</td>
<td>Ironclad</td>
</tr>
<tr>
<td>Wooden (Ship)</td>
<td>Wooden (Ship)</td>
</tr>
<tr>
<td>- (this is an unused slot)</td>
<td>- (this is an unused slot)</td>
</tr>
<tr>
<td>Sub</td>
<td>Sub</td>
</tr>
</tbody>
</table>
Not all of these characteristics will be applicable to every unit type, so where they aren’t applicable a default value of zero will apply. For instance, only Artillery units have Shells so all other unit types will have Min and Max Shell values of zero.

Many of these values can be improved through researching and upgrading your units, please refer to chapter 9 on Research for further details.

### 7.3. Headquarters Attachments

Headquarters attachments are vital in improving the Morale and Readiness and therefore combat efficiency of your units.

Default unit attachment to an HQ is limited to the 5 closest units of the commander’s nationality that are within 3 hexes of the HQ at the start of each turn. These limits can be increased by researching the *Field Telegraph* technology.

If the HQ is a Major that can command units belonging to its Minors too, then these will be included in the process. Thus Union and Confederate HQs can command the troops of any Indian tribes that enter the war on their side, and French HQs can command the forces of the Mexican Empire.

The game engine will automatically attempt to attach units firstly to the highest rated HQ within its Attachment Range. It will also attempt to prioritize attaching units that are adjacent to enemy units.

Basically, the HQ automatically reaches out until it collects the maximum number of attachable units within its Attachment Range. If there is more than

<table>
<thead>
<tr>
<th>Transport</th>
<th>Transport</th>
</tr>
</thead>
<tbody>
<tr>
<td>- (this is an unused slot)</td>
<td>- (this is an unused slot)</td>
</tr>
<tr>
<td>Resource</td>
<td>Resource</td>
</tr>
</tbody>
</table>

### GENERAL

| Spotting (Land) | Min Shells |
| Spotting (Naval) | Max Shells |
| Action Points | De-Entrenchment |
| Operational Range | De-Moralization |
| Intercept Range | Interceptions |
| Escort Range | Escorts |
| Attack Range | Attacks |
one HQ in the area or units are manually attached to other HQs, then the engine will attempt to allocate attachment as best satisfies the above requirement.

Clicking once on an HQ will highlight in green all of the units it commands. A second click shows its attachment range. Also, when an attached unit is selected, its parent HQ is highlighted in green.

7.3.1. HQ Modes

You can manually select and deselect HQ attachments if you wish to fine tune them to get the best combat results. However, any changes in a unit’s attachment or detachment status will only alter that unit’s Readiness value this turn, its Morale value won’t change until the next turn.

To do this, right click on an HQ, select Set Mode, and then choose between Auto, Auto-Assist and Manual.

Auto is the default and is automatically handled by the game engine, as described above.

Auto-Assist allows attachments to be set manually, but the game engine will provide assistance in subsequent turns by automatically selecting replacement attachments if any of the units that had been manually attached no longer fulfill the attachment requirements. So for instance, if the unit is now too far away from the HQ, or has been destroyed, then the engine will attempt to find another that can benefit from the HQ’s command.

Manual allows attachments to be set manually under the same rules as for automatic attachments, except that you will have to make all changes yourself. In subsequent turns you will need to keep an eye on the attached units, because if one exceeds the attachment range or is destroyed then you will have to create a new attachment yourself in a subsequent turn.

Once either Auto-Assist or Manual modes are selected, with the HQ selected you will notice highlights in blue for units within its attachment range that could be attached to it. To change a unit’s attachment or detachment status, simply right click on a green unit and select Detach from the drop down menu or right click on a blue unit and select Attach.

Note that only units that haven’t yet carried out any actions may be attached or detached, so it is best to change unit attachments at the start of your turn.
As an example, the screenshot below shows the basic process for the Hill AP HQ detaching the highlighted Anderson Division. First, right-click on AP Hill and set the Mode to either **Auto-Assist** or **Manual** by left-clicking on one of these options. Now right-click on the Division and you will be given the option to Detach it:

Attaching units works in exactly the same way, except that if an HQ is already commanding its maximum complement of units then you will have to detach a unit before you can attach another.

### 7.4. BUILDING FORTIFICATIONS

Engineers have the ability to build Fortifications that units can then occupy in order to benefit from defense bonuses when attacked.

Engineer units must have a supply value of at least 5 to begin constructing Fortifications, and they may move into position and begin fortifying in the same turn. Engineers cannot begin constructing a Fortification when they are adjacent to any enemy units, though they can continue with the work should the enemy advance to an adjacent hex.

To begin constructing a Fortification, right click on the unit, select **Set Mode** and **Fortify** from the drop down menu.

A dialog box will now appear which you can use to design your Fortification as you can set the number of sides (# of Sides) and its orientation (Rotate).

The construction time is noted at the bottom of the dialog box. Note that the construction time depends upon the number of sides selected, as additional sides will extend the construction time.

Once you have set the Fortification’s design, the Engineer unit will receive a small black circle on its base indicating that it is fortifying the hex.

The Engineer unit must remain in place during the entire construction period, and when the work is complete a Fortification will appear in the hex. The Engineer unit can then either occupy the Fortification and defend it, or better still, it can move away to construct another while a front line unit moves in to occupy the Fortification in its place.
If the Engineer unit is destroyed or moves away before construction is complete, all work is lost and must be started all over again.

**Note:** Engineers cannot fortify hexes containing Resources.

### 7.5. Surrendering Nations

#### 7.5.1. Surrendering Due to Losing the Capital

The primary way that a country will surrender is if its Capital has been captured and it has few land units left within the country to defend it. Some countries may continue fighting even if they have lost their Capital, and on rare occasions it might even be possible to counterattack and liberate the Capital.

Every turn after a country loses its Capital (or last Capital if it had more than one) there will be a check to see if it carries on fighting. The chance that it will carry on fighting depends on the number of units it has left within its own borders, as follows:

- **Major Country Surrender** = \(3\% \times \text{number of remaining units within the home country} \times \text{FS}\)
- **Minor Country Surrender** = \(6\% \times \text{number of remaining units within the home country}\)

The chance for Minors is slightly higher because Minors generally have significantly fewer units.

**Tip!** Liberating the Capital will end this process, so if you lose your Capital do your best to take it back!

#### 7.5.2. Alternative Capitals

Some countries do not immediately surrender when their Capital is captured, either because they have one or more Alternative Capitals where their government will move to, or because their government may transfer to another country altogether. For example, if Washington DC falls then the Union’s Capital will move to Philadelphia, then New York if Philadelphia falls too, and finally Chicago if New York is also taken.
A country whose Capital transfers will lose its current Production Queue items unless the new Capital is connected to either the location of the previous Capital, or to any of the Industrial Center locations for that country.

7.5.3. Fighting on from Exile

Some countries’ units have a chance that they will not give up the fight when their country surrenders.

In the default 1861 Blue and Gray campaign, the following nations’ units will turn into “free” units following their surrender: Creek, Cherokee, Seminole, Chickasaw, Choctaw, Osage.

**Note:** To fight on from exile, the unit must have evacuated before the country surrenders. If it is within its own territory when the country it belongs to surrenders then the unit will surrender too.

It is also not recommended to evacuate a country without fighting for it, as you will lose the income from it sooner, therefore judging the right time to evacuate does require good judgment.

7.5.4. Liberating Capitals

Capitals move back to their original location as they are liberated. So if Philadelphia is the Union Capital and the Union is able to recapture Washington then it would move back to Washington.

The liberation doesn’t have to be carried out in any order, so if the Union recaptures Washington but not Philadelphia then the Capital would move back to Washington even though it had changed from Washington to Philadelphia earlier on.

7.5.5. Surrendering Due to Low Fighting Spirit

The alternative way in which a Major will surrender is if its Fighting Spirit value falls to zero, irrespective of whether or not it still holds its Capital.

In the American Civil War campaigns, the Union and Confederate players will lose the game when their Fighting Spirit falls below 10%, that is shortly before they would surrender, to represent the fact that some Confederate armies stayed in the field for several weeks after Lee’s surrender at Appomattox.
Although unlikely, it is possible for the European powers to withdraw from the war when their Fighting Spirit falls to zero.

7.6. Capturing Enemy Supply Centers
An occupier gains the pre-existing Primary and Secondary Supply Centers when an enemy country surrenders.

Supply and Industrial Centers that become part of another country as part of an event (for instance, when Virginia becomes a part of the Confederacy) will retain their status as Supply and/or Industrial Centers. Capitals that are annexed into another nation will become Primary Supply Centers for that new nation.

7.7. Plunder
When a country surrenders due to having all its Capitals captured, the conqueror will plunder the country and receive a one-off MPP bonus. The actual Plunder value is based on the following:

- The total number and value of its Resources
- The number of units the country had before surrendering

The plunder formulas do not include any units that will become free units, such as if the Cherokees fight on from exile following the capture of Tahlequah. The formulas used are:

Unit Plunder = Current Unit Cost / 10 * strength * 5% (for all units)
Resource Plunder = Full value of all originally owned Resources * 75%

These values are added together and then multiplied by a random factor of between 150-200% for Major countries and between 250-300% for Minor countries.

A final factor is the Difficulty Setting if playing against the AI.

Tip! Disbanding units when you realize a Major is about to surrender will not reduce the amount of Plunder your opponent will receive. Fight on, do not give up as only the enemy benefits from defeatism!
7.8. Victory Conditions

Victory Conditions are determined by specific scripts set for each campaign. A message indicating the Game Over Victory Status will be displayed when the game ends in either a victory for one side or in a stalemate.

With the game over, items not previously visible under Fog of War will now become visible. These include all of your opponent’s units and strengths, research successes, current diplomatic investments and items in their Production Queue.

**Major Victory** is normally achieved whenever you have successfully defeated the leading Major country on the other side (the Union or Confederacy).

**Minor Victory** Conditions normally apply if the campaign’s end date has been reached with one side having an advantage, but without being in a strong enough position to claim a Major Victory.

**Stalemate** Victory Conditions occur if neither side achieves any of their Victory Conditions by the campaign’s end date.

The scripts controlling the Victory Conditions are read in sequence, so even if more than one set of conditions apply, the one that is higher in the listed order will be the one that applies.

**Tip!** Be sure to read a campaign’s Victory Conditions as you play, as these should inform your strategy.

7.9. The Game Engine’s Turn Sequence

These are the processes the engine goes through at the start and end of each turn.

**Calculation Phase I (at the start of the turn)**
- Determine resource Operational Efficiency
- Calculate Unit Supply
- Calculate Unit Morale
- Determine Unit Entrenchment
- Calculate unit Action Points
- Determine Fog of War

**Calculation Phase II (after you have hit end turn)**
- Test for weather changes
- Test for liberated countries
- Test for country surrender
Test for scripted events
Test for naval damage at sea
Test for Partisan activity
Test for Diplomacy (current side only)
Test for Research (current side only)
Calculate Military Production Points (MPPs)

7.10. Collecting Military Production Points

Military Production Points (MPPs) are collected by Major countries at the end of each turn and are based on the number, strength and type of Resources currently owned or occupied by either side, coupled with the level of Industrial Technology research that each Major has achieved.

For neutral, inactive Majors, their income is linked to their Mobilization Values, as full production will not be reached until the country reaches 100% Mobilization.

Note: In the default American Civil War campaigns, including 1861 Blue and Gray, this game rule has been adjusted so that neutral Majors will not receive any MPPs until they enter the war.

Although Minor countries do not receive MPPs, they do contribute MPPs to their controlling Majors, who are in turn responsible for paying for everything relating to their Minors, e.g. buying new units and reinforcing and upgrading existing ones.

7.11. Supply

Units receive supply from friendly Resources and HQs, and unit supply is a major factor in determining combat effectiveness.

General Notes on Supply

Major Capitals provide the most supply, with a maximum supply value of 12.

- These are followed by Major’s Capitals, Industrial Centers, Primary Supply Centers and Ports, which can potentially provide supply up to 10.
- All of the above, except for Ports and Major Ports, are considered Key Resources.
Connection (via a line of friendly land or land+sea hexes) from Key Resources to other friendly resources will enable those resources to reach their maximum strength and supply levels.

It is therefore wise to consider cutting the connections linking enemy resources to their Key Resources, and this should be a factor in determining your axis of advance into enemy territory. This way you can not only reduce enemy income without capturing any Resources, but it can also facilitate the destruction of enemy units at lower supply. This will help because units at lower supply are less effective, are much easier to destroy, and if destroyed with a supply value of less than 5 then they cannot be cheaply reformed.

Secondary Supply Centers and Minor’s Capitals provide supply up to a maximum of 5, potentially increasing up to their maximum value according to their Resource type if they are connected by rail to any of the above.

Captured enemy Resources will generally provide less supply than friendly ones.

The supply benefit of Resources decreases with distance by 1 per hex in clear terrain.

The rate of decrease will be greater in non-clear terrain, as such terrain is an impediment to good supply. For example, placing units in forests, mountains or marshes, unless they are very close to a good supply source, will generally be a bad move.

Both types of Roads negate the effect of terrain on supply, so keeping units on or near roads is recommended. However, when the weather is Mud only Paved Roads will do so.

**Note:** Paved Roads were uncommon outside of cities during the 19th century, and will not be seen in any of the default campaigns.

Oil and Mine Resource types do not provide supply to any units.

Units in low supply cannot be reinforced as well as those in higher supply, while those lacking any source of supply cannot be reinforced at all.

Naval units can only be fully supplied in Port, though they will gain some supply from being in the proximity of friendly Ports, the benefit decreasing with distance.
7.12. Resource Definitions

7.12.1. Major Powers’ Capitals

- These act as a primary supply source providing supply up to their maximum strength value according to their Resource type (usually 12).
- New units can be deployed in a Capital and any friendly city or capital belonging to the same country with a strength of at least 5 that is connected via friendly controlled hexes to it.
- If the Capital falls the country generally surrenders, unless it transfers to an Alternative Capital.

7.12.2. Industrial Centers

- These act as a primary supply source providing supply up to their maximum strength value according to their Resource type (usually 10) even if they are cut off from the Capital.
- New units can be built at an Industrial Center and any city or capital with a strength of at least 5 that is connected via friendly controlled land hexes to the Industrial Center.

7.12.3. Primary Supply Centers

These act as a primary supply source providing supply up to 10 even if cutoff from the Capital.

7.12.4. Secondary Supply Centers

- These act as a secondary supply source that provides supply up to 5 if cutoff from any of the above.
- You cannot build new units from a Secondary Supply Center unless it is connected to a Capital or Industrial Center via friendly controlled land hexes, and it is either a city or capital.

7.12.5. Minor’s Capitals

- These act as a secondary supply source that provides supply up to 5 if cutoff from a friendly Major’s Capital, Industrial Center or Primary Supply Center.
- New units belonging to that Minor can be built at a Minor Capital and in any city within that country with a strength of at least 5 that is connected via friendly controlled land hexes to the Minor Capital.
- If the Minor Capital falls the country generally surrenders.

### 7.12.6. Key Resources
- The above are all defined as Key Resources.
- Resources not connected to a Key Resource will have a maximum supply value of 3, or 5 if they are a Port.
- Port supply = Port strength minus the distance in hexes from the Port, both out to sea and also on land, with terrain and roads also needing to be factored in with the latter.

### 7.13. Maximum Resource Strengths
The following outlines the conditions that determine the maximum Operational Strength Value of a resource.

#### 7.13.1. Connected Resources
If the resource is in direct connection to a friendly Major’s Capital, Industrial Center or Primary Supply Center, then unless they are damaged, these resources will have strength and supply values of:
- 12 for Major Cities, Major Capitals and Major Fortresses
- 10 for Cities, Ports, Capitals and Fortresses
- 10 for Occupied enemy Major Cities and Major Capitals
- 8 for Towns, and any Occupied enemy Resources
- 8 for Settlements

#### 7.13.2. Unconnected Resources
If the resource is connected to a Secondary Supply Center but not to a friendly Major’s Capital, Industrial Center or Primary Supply Center, then it will have a maximum strength of 5.
7.13.3. Captured but Unconnected Enemy Resources

The Occupational Efficiency penalty (the fact that enemy resources don’t generally work as efficiently under your control) doesn’t apply in the following circumstances:

- Occupied Capitals, Primary or Secondary Supply Centers that aren’t connected to a friendly Major’s Capital, Industrial Center or Primary Supply Center will have a maximum strength of 5.
- Occupied Industrial Centers that aren’t connected to a friendly Major’s Capital, Industrial Center or Primary Supply Center will have a maximum strength of 3.


- All resources connected to either a Primary or Secondary supply source will have their maximum strength & supply values according to their type, e.g. Towns will be at strength 8, Cities at 10.
- All resources that are not connected to a Supply Center are considered cutoff and will have a maximum strength value of 3. Ports are an exception to this rule, as their maximum will default to 5.

7.15. Besieging Resources

Any resource except for a Major’s Capital or Fortress that has 2 or more enemy units adjacent to it will have its strength reduced by 1 point per turn until it reaches 0.

The absence of enemy units will see the resource regain strength by 1 point per friendly turn, i.e. deterioration happens in both friendly and enemy turns, but regaining strength only occurs in friendly turns.

This rule also applies to Ports with two or more enemy naval units (except Gunboats, Submarine, river ships, naval mines and all types of Transports) present.

7.16. Port Supply to Land Forces

Any Port that has an enemy unit adjacent to it will not provide supply to friendly land units within its supply range. Port strength itself will be unaffected, and the only effect of the presence of the enemy unit will be to impede supply to
land units. Destroying the enemy unit or driving it away will enable that Port to provide supply again.

7.17. ARTILLERY WITH ZERO SUPPLY
Artillery and Railroad Batteries do not accumulate shells beyond their minimum if their supply level is zero.

7.18. RAIDING WHEN AT ZERO SUPPLY
Units cannot raid convoy lines when they are at zero supply, though they can still disrupt shipping at locations marked on the map.

Submarines cannot dive when they are at zero supply, rendering them more vulnerable, so it is strongly advised to return to port for refueling before their supply level drops too low.

7.19. DAMAGE TO RESOURCES
Naval blockade, bombardment, and partisan activity can all reduce the strength of resources. This will in turn reduce both their supply value and also the number of MPPs collected at the end of each turn.

On subsequent turns, the Operational Strength Value for damaged resources is automatically increased by one point per friendly turn, up to their maximum strength value. This simulates rebuilding and repair of damaged infrastructure, without requiring any micromanagement.

7.20. INDUSTRIAL MODIFIER
A factor in determining the actual income received by each Major from its own Resources is its Industrial Modifier. This represents the production capability of its Resources relative to their strength.

Each friendly Major’s Industrial Modifier value appears when you hover your mouse over the Major’s flags in the top left of the screen:

A value of 100% represents a 1-to-1 relationship between collected MPPs and production capability.
A value of 75% represents three-quarters production, 125% represents one and one-quarter production, and so on.

This Industrial Modifier value will increase with each level of Industrial Technology research that is achieved. Please refer to chapter 9 on Research for additional details.

Since Minor countries cannot conduct their own research, and do not benefit from their Major’s Industrial Technology research successes, they will always have a default Industrial Modifier of 100%.

In general, all MPPs collected at the end of each turn are available for use during the next turn. The production values for each type of controlled resource are added together and then multiplied by their country’s Industrial Modifier.

For neutral Major countries, as their Mobilization value is less than 100%, their income is adjusted to account for this. (Note that 1861 Blue and Gray has a special rule in place limiting the income of neutral Majors to zero). The following formula shows how MPP collection is calculated:

\[
\text{MPP Collection} = \text{Total Resource Value} \times \text{Industrial Modifier} \times \text{Mobilization Value}
\]

**Note:** If a campaign has longer winter turns and shorter summer turns, then this has the effect of meaning that less income is received in winter. If this isn’t desired then campaigns can be amended to use the Normalized Production option which ensures that production per time period is more balanced in campaigns with variable seasonal turn lengths. Its effect will be to increase production in winter turns and decrease it in summer turns.

### 7.21. UNIT PRODUCTION

In general, a country’s production of units can only occur in or adjacent to cities, major cities and capitals that are connected to their Capital or an Industrial Center. In addition, most campaigns are set so that new units can only be deployed in their Home Countries.

The following table outlines the standard production costs in MPPs for each unit type with no research upgrades added:
<table>
<thead>
<tr>
<th>Unit Type</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>HQ</td>
<td>300 + (HQ Rating * 5%)</td>
</tr>
<tr>
<td>Regiment</td>
<td>100</td>
</tr>
<tr>
<td>Brigade</td>
<td>200</td>
</tr>
<tr>
<td>Division</td>
<td>300</td>
</tr>
<tr>
<td>Corps</td>
<td>450</td>
</tr>
<tr>
<td>Mountain Division</td>
<td>300</td>
</tr>
<tr>
<td>Rangers</td>
<td>225</td>
</tr>
<tr>
<td>Marines</td>
<td>350</td>
</tr>
<tr>
<td>Engineers</td>
<td>350</td>
</tr>
<tr>
<td>Indians</td>
<td>275</td>
</tr>
<tr>
<td>Cavalry Brigade</td>
<td>250</td>
</tr>
<tr>
<td>Cavalry Division</td>
<td>375</td>
</tr>
<tr>
<td>Cavalry Corps</td>
<td>500</td>
</tr>
<tr>
<td>Partisans</td>
<td>150</td>
</tr>
<tr>
<td>Blockhouse</td>
<td>175</td>
</tr>
<tr>
<td>Field Artillery</td>
<td>350</td>
</tr>
<tr>
<td>Siege Artillery</td>
<td>400</td>
</tr>
<tr>
<td>Railroad Battery</td>
<td>425</td>
</tr>
<tr>
<td>Defenses</td>
<td>200</td>
</tr>
<tr>
<td>Armored Train</td>
<td>150</td>
</tr>
<tr>
<td>Balloons</td>
<td>150</td>
</tr>
<tr>
<td>Battleship</td>
<td>450</td>
</tr>
<tr>
<td>Cruiser</td>
<td>400</td>
</tr>
<tr>
<td>Ironclad</td>
<td>325</td>
</tr>
<tr>
<td>Monitor</td>
<td>275</td>
</tr>
<tr>
<td>Ship of the Line</td>
<td>300</td>
</tr>
<tr>
<td>Frigate</td>
<td>200</td>
</tr>
<tr>
<td>Gunboat</td>
<td>100</td>
</tr>
<tr>
<td>River Ironclad</td>
<td>150</td>
</tr>
<tr>
<td>River Timberclad</td>
<td>100</td>
</tr>
<tr>
<td>River Gunboat</td>
<td>75</td>
</tr>
<tr>
<td>Submarine</td>
<td>100</td>
</tr>
<tr>
<td>Torpedo Boat</td>
<td>250</td>
</tr>
</tbody>
</table>

**Note:** The Partisan cost is only relevant to reinforcement cost calculations, as this unit type can never be purchased. Also, some unit costs may vary slightly from the above.
7.22. Reinforcement Costs
Reinforcement costs for damaged units are based on the current cost of the unit. The following formulas reflect the relative reinforcement costs of a unit due to combat losses:

- Regular Reinforcement Cost = # of strength points * (Cost of Unit / 10) / 2
- Elite Reinforcement Cost = Regular Reinforcement Cost * 2

7.23. The Cost of Upgrading Units
Research is vital to improving the combat effectiveness of your units. There are two categories of Research, Manual and Automatic. Automatic research successes don’t increase unit production and reinforcement costs, but Manual upgrades applied to units will do so.

The following formula reflects the cost of units according to their applied research upgrades:

Cost of Unit = Standard Production Cost + (% increase * # of applicable research levels)

By % increase we are referring to the increase in cost due to each upgrade applied to the unit. So for example, if a Corps is upgraded with Infantry Equipment level 1 then its price will increase by 10% as that is the cost per upgrade for that research type.

Cost increases for units upgraded with multiple technologies will have cumulative effects. For example, upgrading a unit with level 2 research in both Infantry Equipment and Skirmishers would increase overall costs by 30%, as the former increases costs by 10% per level, and the second by 5%. See chapter 9 on Research for more details.

7.24. Decision Events
During the game you will at times be asked to make strategic decisions. This feature is called a Decision Event and you will be prompted to choose either Yes or No.

The text accompanying the Decision Event will describe and explain the choice facing you, but choose wisely because once you have chosen you will not be able to change your mind.
Examples of Decision Events include:

- For the Union: choosing whether to issue the Emancipation Proclamation.
- For the Confederacy: choosing whether to sell the pre-war cotton stockpile.
- For Mexico: choosing whether to sell Baja California to the Union.
- For the UK: choosing whether to launch an invasion of the off-map Washington Territory.

Clicking on the ‘Notes’ tab on the bottom right of the Decision screen will bring up notes relating to the decision that may help you make your choice.

While a Decision is awaiting your choice, you can click on ‘View Map’ so that you can consider the situation with reference to the actual game map, checking various things like your Production Queue and Diplomacy.

When you’re ready, you can return to the Decision screen by clicking on the button in the bottom left corner. Note that you won’t be able to continue playing until you have responded to the Decision Event by choosing either Yes or No.

7.25. FACTORS INFLUENCING COMBAT EFFECTIVENESS

Let’s now look at the different factors that determine a unit’s combat effectiveness.

7.25.1. EXPERIENCE

A unit’s experience is based upon its success in combat, with a small extra bonus for attacking and destroying enemy units.

Unit experience has a maximum value of 3 in our official campaigns (except for forts, small ships, Armored Trains and Artillery, which are limited to 1), though the maximum can be edited up to 5.

When replacing losses, some experience will be lost, and the formula used for this is as follows:

Experience Point Losses = (Reinforcement amount * Experience) / 10

For HQs, combat experience is dependent upon how well subordinate units under their command perform in the field according to the following two equations:
If Defender's Losses > Attacker Losses
   +0.05 (Attacker's HQ, if Attacker is a Soft, Infantry or Cavalry unit); +/-0.0 (if Attacker is an Artillery, Fort or Armored Train unit)
   +/- 0.0 (Defender's HQ)

If Defender's Losses >= Attacker Losses
   +0.05 (Defender's HQ)
   -0.05 (Attacker's HQ)

7.25.2. FACTORS INFLUENCING ACTION POINTS
In general, normal supply is traced from friendly sources over friendly controlled hexes, with the supply value decreasing as the distance from the supply source increases.

Terrain movement costs apply to supply paths, reducing by 2 for entering Mountain and Lake hexes, 3 for High Mountains, and by 1 for all other terrain. Supply to land units cannot be traced over bodies of water, across depressions, or through neutral territory. The supply value of a hex is the maximum supply it is receiving from any source, and this may not be the closest, e.g. a Town 3 hexes away will, all other things being equal, provide less supply than a Major City 4 hexes away.

7.25.3. ROADS AND SUPPLY
Paved Roads negate the effect of terrain and weather on supply, and as troops also move faster on roads it is usually best to keep most of your units on roads, and only leave them when you will gain a tactical advantage by doing so.

Dirt Roads work like Paved Roads except that they do not prevent a reduction in Action Points (APs) when the weather effect is that of Mud. Note that due to the generally poor standard of roads in the 19th century, all roads in the default campaigns are Dirt Roads.

One special rule is that if a unit has only 1 AP then any additional weather penalties do not apply.
7.25.4. HQ Supply

HQs have a calculated supply value just like all other units, but in addition they have a Supply Distribution Value that can be applied to supply other friendly units around them.

This Supply Distribution Value is calculated based on the current supply value of the HQ. The following table outlines HQ supply distribution calculations, based on full strength HQs:

<table>
<thead>
<tr>
<th>HQ Supply (Incoming)</th>
<th>HQ Supply Distribution (Outgoing to Other Units)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>&lt; 3</td>
<td>5</td>
</tr>
<tr>
<td>&lt; 5</td>
<td>6</td>
</tr>
<tr>
<td>5</td>
<td>8</td>
</tr>
<tr>
<td>&gt; 5</td>
<td>10</td>
</tr>
</tbody>
</table>

7.25.5. The Supply Value of Low Strength HQs

Low strength HQs aren’t very effective sources of supply to units around them because they are working at reduced efficiency. Consequently their Supply Distribution Value is reduced using a formula that multiplies the HQ Supply Distribution Value by HQ strength, divided by 10.

The Final Supply Distribution Value cannot however fall below the HQ’s Minimum Supply Value, and this can be increased by researching Logistics, see below.

7.25.6. Reinforcing HQs

Low Strength HQs can only be reinforced in stages, so if damaged it is wise to start reinforcing them as soon as possible. Or move them to safety if they are in extreme danger.

7.25.7. Raising HQs’ Minimum Supply Value

Researching Logistics raises the Minimum Supply Value for HQs. At level 1, the Minimum Supply Value is 1, and this will rise by 1 for every subsequent level attained.
So if level 5 Logistics has been attained, then a HQ with a strength value of 1-4 will have a minimum supply value of 5 even if it has no access to a supply source.

It is true that this means that you will only really see any benefit if a high level of Logistics is researched, but this may be of use in a critical situation.

### 7.25.8. Boosting HQ Supply

- Friendly HQs with a supply value of at least 3, will automatically boost the supply of another friendly HQ that is within supply distribution range. The friendly HQ receiving the supply boost, will have its supply value boosted to 5, and this will raise its supply distribution value to a maximum of 8.
- Any friendly HQ with a supply level less than 5 can receive this boost.
- The friendly HQ providing the supply boost, will only boost the supply of one other low supply HQ and never more than one.
- The hex of the friendly HQ providing the supply boost will be outlined in yellow when clicking on the boosted HQ.
- The engine will seek to make lower rated HQs provide supply for higher rated ones, rather than vice versa.
- As HQ units are moved around the map, the engine will also automatically recalculate HQ supply boosting connections after each turn.
- By positioning HQ units appropriately in low supply areas, the HQ supply boosting mechanism can be helpful in extending higher distribution supply to your units than would otherwise be possible.

### 7.25.9. HQ Supply During Amphibious Invasions

- HQ units, after amphibiously unloading, start at 5 supply + their current Amphibious Warfare level, maintaining supply for up to 5 turns with a drop of 2 supply points per turn.
- This allows the HQ to act as a good supply source for an initial landing until further supply sources are achieved.

**Note:** HQs that have amphibiously unloaded cannot boost another HQ, nor receive a boost from another HQ, until they have secured a supply providing resource greater than their current supply level.
7.26. Naval Supply

Naval supply is handled differently than normal supply for land units. In general, naval units within range of a Port receive maximum supply, minus their distance from Port, regardless of Port strength.

Once naval units are out of Port range they will not have their supply values reduced unless they:

- Cruise
- Raid a Convoy route
- Engage in combat, whether in attack or defense

The exception to this rule are regular Amphibious Transports, as they will have their supply value reduced by one for each turn at sea, regardless of their vicinity to a Port. This does not apply to Amphibious Transport (Long Range) as they act like any other naval unit in this respect.

7.27. Supply and Action Points Table

This table shows the Action Point penalties that all unit types receive, whether land or naval, if their supply values are low:

<table>
<thead>
<tr>
<th>Unit’s Supply Value</th>
<th>Action Point Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>6 - 10</td>
<td>Unit’s Maximum</td>
</tr>
<tr>
<td>1 - 5</td>
<td>Unit’s Maximum minus 1</td>
</tr>
<tr>
<td>0</td>
<td>1 (Land units)   50% of Unit’s Maximum (Naval units)</td>
</tr>
</tbody>
</table>

7.28. Supply & Reinforcements Table

Unit strength can only be reduced by combat losses, scripted events such as the effect of Apache attacks on Union and Confederate units, and naval units may occasionally suffer from storms at sea.

Land unit’s strength can be replenished through reinforcement, providing the unit has sufficient supply, and its controlling Major has MPPs available to cover the cost.

Naval units must be in a friendly Port to be reinforced, and their attainable strength is based on the Port’s strength value rather than the naval unit’s supply

---

[Train Image]
value. However, it works in the same way as for land units, so for example, a naval unit in a Port that is at strength 5 can only be reinforced up to strength 8.

**Note:** Naval units (with the sole exception of Torpedo Boats) can only receive a maximum of 5 strength points per turn.

If a unit's strength is already greater than its attainable strength then it cannot be reinforced.

The following table shows reinforcement potential in accordance with the above:

<table>
<thead>
<tr>
<th>UNIT’S SUPPLY VALUE/PORT STRENGTH</th>
<th>ATTAINABLE STRENGTH</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Cannot be reinforced</td>
</tr>
<tr>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
</tr>
<tr>
<td>3</td>
<td>6</td>
</tr>
<tr>
<td>4</td>
<td>7</td>
</tr>
<tr>
<td>5</td>
<td>8</td>
</tr>
<tr>
<td>6-10</td>
<td>10+</td>
</tr>
</tbody>
</table>

Please refer to the Reinforcing Units section in Chapter 6 for information regarding the cost of reinforcing a unit, and how to reinforce units during a game.

### 7.28.1. REINFORCING DAMAGED HQS

HQs can only be reinforced to their maximum strength of 10, as they cannot receive Elite Reinforcements to take them beyond that. The rate at which they can be reinforced is also dependent on their strength, as shown in the table below:

<table>
<thead>
<tr>
<th>HQ STRENGTH</th>
<th>CAN BE REINFORCED TO:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
</tr>
<tr>
<td>3</td>
<td>6</td>
</tr>
<tr>
<td>4</td>
<td>7</td>
</tr>
<tr>
<td>5</td>
<td>8</td>
</tr>
<tr>
<td>6-9</td>
<td>10</td>
</tr>
</tbody>
</table>
It can therefore take several turns to bring a low strength HQ back up to full strength.

### 7.28.2. Low Supply & Attrition Losses

Zero supply units, HQs excluded, automatically lose 1 strength point per turn if they are at least one hex beyond traceable supply. Land units at zero supply also have a 50% chance, and at 1 supply a 20% chance, of 1 strength point loss per adjacent enemy unit, providing they are adjacent to at least 2 enemy front line units with strength and supply levels of at least 5. If their last strength point is lost then the unit surrenders.

**Additionally:**
- Units at zero supply suffer a unit Morale penalty of 50%, those at 1 supply 25%.
- The effectiveness of an attack against a unit at zero supply is increased by 50%.

### 7.29. Morale and Readiness

At the start of a new game, all units will start with morale equal to their calculated supply value. For example, a unit that has a supply of 9 will start with 90% morale.

At the start of each subsequent turn, unit morale is determined by two things: its supply value, and its current strength compared to its potential maximum strength.

Newly deployed units start with 50% morale, and this will update at the end of their first turn in accordance with their situation.

Morale is formulated to drop over time when a unit is cut off or low on supply, and this will ultimately affect the unit’s readiness. For example, if a Confederate Corps marches into Maryland and is subsequently completely cut off from any source of supply, then its morale and readiness will drop. Conversely, as a unit’s supply situation improves, its morale will rise.

These changes are gradual over time as determined by the following formula:

\[
\text{New Morale} = \text{Old Morale} \times 0.75 + (\text{Strength} \times 10 - \text{Old Morale} \times 0.75) \times \left(\frac{\text{Supply}}{10} \times \frac{\text{Old Morale}}{100}\right)
\]
Note: The actual Morale formula includes minor corrections for Strengths greater than 10 and if the Old Morale value was greater than 100, then it is capped at 100.

Morale Boosts from Automatic Upgrades (eg. Infantry Tactics) are added in addition to the formula, but in a way that won’t allow them to accumulate from turn to turn. Their role is simply to provide a small boost to the actual Morale of the unit based on its condition and situation.

The formulas will also take into account if the unit has a Maximum Strength below 10, so that they aren’t penalized for this.

Units will start their turn with at least 10% Morale, regardless of prior turn reductions below 10%, and all newly deployed units start with a Morale value of 50%.

7.29.1. Morale Losses Due To Movement

The following actions will trigger Morale Losses within the range specified:

<table>
<thead>
<tr>
<th>Action</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forced March</td>
<td>50-65%</td>
</tr>
<tr>
<td>Rail Movement</td>
<td>15-25%</td>
</tr>
<tr>
<td>Unit Swap</td>
<td>15-20%</td>
</tr>
</tbody>
</table>

7.29.2. Unit Attacks Inflicting Morale Losses

Even if they don’t inflict any casualties, many unit types will reduce the targeted unit’s morale when they attack.

These defender Morale losses are relative to the strength of the attacking unit. For example, a Cavalry Division at strength 9 would inflict 90% of a 10% morale loss = a 9% morale loss.

All units that inflict Morale Losses when attacking are listed below:
<table>
<thead>
<tr>
<th>ATTACKING UNIT TYPE</th>
<th>MORALE LOSS INFLECTED ON THE DEFENDER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Infantry with Skirmishers Tech</td>
<td>Up to 20%</td>
</tr>
<tr>
<td>Rangers</td>
<td>10%</td>
</tr>
<tr>
<td>Indians</td>
<td>15%</td>
</tr>
<tr>
<td>Cavalry Brigade</td>
<td>5%</td>
</tr>
<tr>
<td>Cavalry Division</td>
<td>10%</td>
</tr>
<tr>
<td>Cavalry Corps</td>
<td>10%</td>
</tr>
<tr>
<td>Partisans</td>
<td>10%</td>
</tr>
<tr>
<td>Blockhouse</td>
<td>5%</td>
</tr>
<tr>
<td>Field Artillery</td>
<td>15%</td>
</tr>
<tr>
<td>Siege Artillery</td>
<td>20%</td>
</tr>
<tr>
<td>Railroad Battery</td>
<td>25%</td>
</tr>
<tr>
<td>Defenses</td>
<td>10%</td>
</tr>
<tr>
<td>Armored Train</td>
<td>5%</td>
</tr>
<tr>
<td>Battleship</td>
<td>30%</td>
</tr>
<tr>
<td>Cruiser</td>
<td>20%</td>
</tr>
<tr>
<td>Ironclad</td>
<td>20%</td>
</tr>
<tr>
<td>Monitor</td>
<td>20%</td>
</tr>
<tr>
<td>Ship of the Line</td>
<td>15%</td>
</tr>
<tr>
<td>Frigate</td>
<td>10%</td>
</tr>
<tr>
<td>Gunboat</td>
<td>5%</td>
</tr>
<tr>
<td>River Ironclad</td>
<td>10%</td>
</tr>
<tr>
<td>River Timberclad</td>
<td>5%</td>
</tr>
<tr>
<td>River Gunboat</td>
<td>5%</td>
</tr>
<tr>
<td>Submarine</td>
<td>10%</td>
</tr>
<tr>
<td>Torpedo Boat</td>
<td>10%</td>
</tr>
<tr>
<td>Amphibious Transport</td>
<td>10%</td>
</tr>
<tr>
<td>Amphibious Transport (Long Range)</td>
<td>10%</td>
</tr>
</tbody>
</table>

7.29.3. UNIT READINESS AND ITS EFFECT ON COMBAT

Unit strength, supply and morale values all combine to determine a unit’s overall readiness for combat, and this Readiness value is key to its combat effectiveness.

Readiness for **land units** is calculated using one of the following two formulas:
If the unit comes under a HQ
- Readiness = (((Unit Strength + HQ Rating) / 2 + Unit Morale / 10 + HQ Experience) / 2) * 10

If the unit isn’t commanded by a HQ
- Readiness = ((Unit Strength / 2 + Unit Morale / 10) / 2) * 10

As naval units never come under the command of HQs they always use a special formula of their own:
- Readiness = (Unit Strength + (Unit Morale / 10)) / 2 * 10

The Importance of HQs
Because the HQ rating has such an important impact on readiness for land units, purchasing the more expensive but highest rated HQs is highly recommended, providing you have the funds available to do so.

Also, an HQ’s experience from combat leadership is passed down to all units under its command as a combat morale bonus. This makes experienced and highly rated HQs very useful in improving the effectiveness of units under their command.

The Importance of Fighting Spirit
Majors with reduced Fighting Spirit will suffer a small penalty to their Unit Morale, while those with Fighting Spirit of higher than 125% will benefit from a small boost.

- If Fighting Spirit < 25% then Unit Morale is multiplied by 0.85.
- If Fighting Spirit < 50% then Unit Morale is multiplied by 0.90.
- If Fighting Spirit < 75% then Unit Morale is multiplied by 0.95.
- If Fighting Spirit > 125% then Unit Morale is multiplied by 1.10.

7.29.4. The Effect of Entrenchment on Combat
Entrenchment provides attacked units with a chance to suppress combat losses.

It is therefore best to avoid attacking units with high Entrenchment Values if other targets are nearby whose destruction will equally assist your plan.
There may be times when bypassing entrenched units is best, cutting them off from sources of supply and forcing them to either retire or be attacked when in lower supply.

Each level of Entrenchment is multiplied by a factor of 10 to determine the percentage chance that a unit will suppress strength losses from combat. For example, a unit with an entrenchment level of 4 will have a 40% chance of suppressing a strength loss.

If a strength loss is suppressed, then the targeted unit will suffer a morale loss of 10% per suppressed loss instead. So a unit that should have lost 2 strength points, would lose 20% of its morale instead.

While Entrenchment is very useful in reducing losses, an accumulation of morale losses may penalize the unit that receives them for some turns to come. This is because morale is a stored value that is updated each turn with its previous turn’s value (including the morale losses suffered) being a major factor in the next turn’s value. So a unit may survive some early hits but a rapid decrease in morale without relief may cause the unit to break down that much quicker in later rounds of combat.

7.29.5. GAINING ENTRENCHMENT

Entrenchment Values automatically increase by 1 point every friendly turn that a land unit stays in the same hex, up to the maximum value depending on terrain type.

If a unit moves into, or starts a turn within a friendly Fortress or Fortification, it will immediately entrench up to 1/2 of the maximum entrenchment value for those prepared positions.

Land units of all Majors, and of fully mobilized Minors can benefit from Entrenchment. Naval units cannot entrench under any circumstances.

Units belonging to neutral Minors cannot build up their Entrenchment Values, though campaign designers can provide their units with entrenchment so that they enter the war with those values.

All Entrenchment Values are lost when a unit moves out of its current hex, so if playing defensively it is best to position your units a few turns prior to an expected enemy attack so that they can build up their Entrenchment Values.
A defending unit can only have its Entrenchment Value decreased by direct attack, and the following table outlines these reductions according to attack type:

<table>
<thead>
<tr>
<th>ATTACKING UNIT</th>
<th>DEFENDER’S ENTRENCHMENT LOSS PER ATTACK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Divisions, Corps, Mountain Divisions, Marines, Engineers, Field Artillery, Railroad Batteries</td>
<td>1</td>
</tr>
<tr>
<td>Siege Artillery</td>
<td>1 (+1 if defending unit is in a Resource)</td>
</tr>
<tr>
<td>Amphibious Transports (including LR)</td>
<td>0</td>
</tr>
<tr>
<td>All Other Units</td>
<td>0</td>
</tr>
</tbody>
</table>

### 7.29.6. COMBAT LOSSES

The primary effect of combat is to reduce unit strength, and the following formulas illustrate the processes involved in determining the casualties that will be suffered.

First a Combat Multiplier based on a unit’s Readiness establishes the % of a unit’s attack or defense capabilities. The Combat Multiplier is calculated as shown below:

\[
\text{Combat Multiplier} = \frac{\text{Readiness}}{100}
\]

The combat formulas that determine a unit’s strength losses are as follows:

- **Attacker Losses** = Defender’s Combat Multiplier * (Defense Type Value + Defender Experience / 3) - Attacker Multiplier * Attacker Experience / 3
- **Defender Losses** = Attacker Multiplier * (Attack Type Value + Attacker Experience / 3) - (Defender Multiplier * (Defender Experience / 3 + Defender Entrenchment + Defense Bonuses))

**Note:** The Attack and Defense values used depend on the unit types involved in combat. When units of different target types fight each other, then their values respective to the enemy unit are used.

For example, if a Cavalry unit attacks an Infantry unit, then the attacker’s Infantry Attack values apply in determining the defender losses, and the defending Infantry unit’s Cavalry Defense values apply in the calculation of the attacker’s losses.

Defense Bonuses are provided by the terrain and resources a defending unit is occupying, with forests, mountains, cities and fortresses providing the most.
Combat includes an awareness of relative unit upgrades so that it is only the difference between combat factors that count. For example, two Level-2 Infantry Corps attacking each other will inflict damage on each other similar to two Level-0 Infantry Corps.

Actual combat losses are a complex calculation based on the following:

- Unit Type
- Experience
- Supply
- Strength
- Unit Morale
- HQ Command Rating
- HQ Experience
- Entrenchment Value
- Terrain Defense Bonus

When calculating some combat losses there are additional considerations and the above formulas have been adjusted internally to take the following factors into account:

- HQs, Balloons and Transports cannot attack.
- Land units have their attack values halved when they are attacking from terrain with a negative defense bonus value.
- Only Cities, Ports and Fortresses can defend against naval bombardments, other resources will not inflict damage on their naval attackers.
- Entrenched units may suppress combat losses and have their morale reduced instead.
- Attack values against Transports are increased by 50%.
- Weather effects may reduce attack values, except that they will not reduce the 50% bonus for attacking Transports.
- Elite unit strength is not included when calculating readiness for Transports.
7.29.7. Variability in the Combat Results

In addition to each of the factors described above, there is a possible +/-1 point variation in each combat that provides some randomness to the combat calculations.

This variation is small enough to produce reasonable and expected variety from game to game, but not significant enough to produce extreme results.

**Exceptions:** There are two occasions when this variable won’t apply:

- If any units engaged in combat are at zero supply.
- If the calculated defender losses would have been greater than their remaining strength.

You aren’t expected to memorize all of the formulas surrounding combat, but it helps to have a broad understanding of how all of the various factors are used in the calculations. This intuitive “feel for the game” will enable you to make sound decisions as you play.

The casualty predictions that are displayed above the units as well as in the Information Panel prior to resolving combats are a fairly accurate estimate when the Fog of War game option is turned off, apart from the +/-1 point variation.

However, if Fog of War is being used then some hidden enemy factors such as HQ command rating and combat morale bonus are ignored in the calculated estimates, and so the experienced player should expect slightly different results.

7.30. Supply Values

7.30.1. Land Units

<table>
<thead>
<tr>
<th>Unit Location</th>
<th>Unit’s Supply Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>≤ 10 Action Points to HQ</td>
<td>HQ Supply minus Shortest Distance</td>
</tr>
<tr>
<td>≤ 10 Action Points to Friendly/Occupied Resource</td>
<td>Resource Strength minus Shortest Distance</td>
</tr>
<tr>
<td>(12 if Major City or Port)</td>
<td></td>
</tr>
<tr>
<td>&gt; 10 Action Points to HQ</td>
<td>0</td>
</tr>
<tr>
<td>&gt; 10 Action Points to Friendly/Occupied Resource</td>
<td>0</td>
</tr>
<tr>
<td>(12 if Major City or Port)</td>
<td></td>
</tr>
</tbody>
</table>
CUT OFF FROM A FRIENDLY MAJOR

<table>
<thead>
<tr>
<th>Unit Location</th>
<th>Unit’s Supply Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut off from HQ but connected to a Friendly/Occupied Resource</td>
<td>Resource Strength minus Shortest Distance</td>
</tr>
<tr>
<td>Cut off from any valid City/Port but not from a friendly HQ</td>
<td>HQ Supply minus Shortest Distance</td>
</tr>
<tr>
<td>Cut off from any HQ and any valid Resource</td>
<td>0 (3 if Partisans or Rangers)</td>
</tr>
</tbody>
</table>

Note: If either an HQ or a friendly/occupied resource can supply a unit then the greatest of the above values will be taken for a unit’s supply.

7.30.2. NAVAL UNITS

IN RANGE OF A FRIENDLY/OCCUPIED PORT

<table>
<thead>
<tr>
<th>Unit Location</th>
<th>Unit’s Supply Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>≤ [Port Strength] Action Points to valid Port</td>
<td>10 minus Shortest Distance (12 if Major Port)</td>
</tr>
<tr>
<td>&gt; [Port Strength] Action Points to valid Port</td>
<td>0</td>
</tr>
</tbody>
</table>

8. UNIT TYPES

8.1. LAND UNITS

Making the most effective use of your land forces can make all the difference between victory and defeat, as they are vital for holding and capturing territory and resources.

Knowing their attributes is important, so this chapter is a guide to the various land units in the game.

8.1.1. TARGET TYPES

All Land Units are divided into six Target Types:

- **Soft** – HQ, Rangers, Engineers, Partisans
- **Infantry** – Regiments, Brigades, Divisions, Corps, Mountain Divisions, Marines
- **Cavalry** – Indians, Cavalry Brigades, Cavalry Divisions, Cavalry Corps
- **Artillery** – Field and Siege Artillery, Railroad Batteries
- **Fort** – Blockhouses, Defenses
- **Armored Train** – Armored Trains

### 8.1.2. Default Maximum Strength

In the section that follows, Default Maximum Strength refers to maximum potential strength unless the unit has sufficient experience to receive Elite Reinforcements. All units described below have a default maximum of 10 unless stated otherwise.

### 8.1.3. Headquarters

An HQ is a strategic unit that provides leadership and logistical support to subordinate units. In real life it could employ thousands in largely administrative roles providing essential support to the soldiers in the front line.

Although HQs are administrative in nature and cannot attack, they provide supply to units in their vicinity, even to those not directly under their command.

Normally, up to 5 land units within a range of 3 hexes may be attached to an HQ, although this may be increased with *Field Telegraph* research.

Historical commanders are available to most nations, and they all have a preset base Command Rating. The higher this Command Rating, all other things being equal, the better the units under their command will fight. In game terms, this is because higher ratings equate to higher readiness values for the units under their command.

**Example Base HQ Command Ratings:**

- Sherman 7
- Lee 7
- Grant 6
- Johnston J 5
- McClellan 3
HQs not only increase the readiness of units under their command, they also provide a combat morale bonus.

This bonus can increase over time if their subordinate units perform well in action, as any unit that performs well when attached to an HQ will increase that HQ's command experience. This will in turn increase the combat morale bonus that the HQ provides to all units under its command. So success breeds success!

However, it works in reverse too, so if units attached to an HQ are defeated then that HQ's command experience is reduced, and this will in turn reduce the combat morale bonuses for all units under its command.

### 8.1.4. Regiment

The Regiment is the smallest unit represented in the game, typically made up of less than 1000 men. These units can prevent an enemy unit from simply occupying a position without contest, but they are unlikely to withstand a strong attack. Regiments have a default maximum strength of 5. In the default 1861 Blue and Gray campaign, these units are only seen representing some small garrisons on the Great Plains at the beginning of the war, and cannot be purchased.

### 8.1.5. Brigade

Comprising around 2,500-3,000 soldiers, the Brigade is the smallest unit suitable for frontline service. At the beginning of the game, both sides will receive a large number of brigades that will form the bulk of your army for the first year of the war, until more powerful Divisions and eventually Corps take the field. The Brigade's modest strength and low cost make it ideal for garrisoning important locations away from the frontline.

### 8.1.6. Division/Mountain Division

Made up of 6,000-10,000 men, the Division is a moderately powerful unit suitable for all roles on the battlefield. Divisions are available to purchase from the start of the game, and receive twice the benefit from technological advancement as Brigades, making them the most important part of your army in the first two years of the war.
Tip! Mountain Divisions benefit from +1 Attack and Defense bonuses when fighting from or attacking into Mountain and Hill hexes.

8.1.7. CORPS
Consisting of anywhere between two and seven divisions, and typically more than 15,000 men, the Corps is the most powerful unit on the Civil War battlefield. Corps are not available for purchase until the first level of Corps Organization technology is researched, with each level allowing the purchase of four Corps. The benefits of technological advancement are increased for Corps relative to Divisions, and by the third year of the war the Corps will be the most important unit in your army.

8.1.8. RANGERS
Rangers were small semi-regular cavalry formations often used as scouts and to attack enemy targets behind the front lines, such as supply trains. The most famous example of these is Mosby’s Rangers, a Confederate unit active in northern Virginia, although similar units were also seen on the Union side as well.

Rangers, like Partisans, have a minimum supply value of 3, and have a 25% chance to evade damage from combat, making them ideal for raiding behind enemy lines. Unlike other infantry units, Rangers also can spot land units two hexes away.

8.1.9. MARINES
Marines played a vital part in the enforcement of the Union blockade, being used to capture a number of offshore islands along the coasts of the Carolinas and Georgia, as well as the occupation of New Orleans and southern Mississippi River in the summer of 1862. In the game, Marines are considered to be a division-strength unit with combat bonuses when fighting Forts and Warships.

Marines have the unique ability of being able to embark on Amphibious Transports from any Coastal hex. This makes them very useful for raiding purposes, as they may be able to evacuate via sea if the landing fails to capture a Port.
The supply value of Marine units that have amphibiously unloaded will only drop by 2 points per turn in the absence of a separate source of supply, meaning that they will have some supply for a maximum of 5 turns.

8.1.10. Engineers

These are effectively Construction Engineers as Combat Engineers are presumed to be an integral part of the other combat units in the game.

Engineers can be used to build Fortifications (such as the great defensive works of Petersburg) to help strengthen defenses against enemy land attacks and amphibious operations, and they can be very useful in providing strongpoints which the enemy may struggle to capture if properly defended.

Building Fortifications is covered in more detail in the Advanced Gameplay chapter.

8.1.11. Indians

Native Americans (or ‘Indians’, in the terminology of the era) served in large numbers on both sides of the Civil War, most commonly as mounted forces west of the Mississippi, although some also served in the Eastern Theater. The Indian unit, which can be purchased by Indian tribes (though not by the Union or Confederacy), is similar in strength and abilities to the Cavalry Brigade, but has a higher Demoralization value, making it ideal for the mobile warfare seen on the open plains of the West.

Note: In recent decades, there has been considerable controversy surrounding the terminology used to describe the native peoples of the United States. While we have endeavored to use the names of individual tribes wherever possible, it is occasionally necessary to refer to multiple tribes collectively. As no single term has received near-universal approval from native peoples, we have chosen to use the word ‘Indian’ in such settings, as the most historically appropriate alternative. While we recognize that this term arose from a historical error, and at times may have acquired negative connotations during the centuries of conflict between the native peoples and settlers, it was the term most commonly used in the 19th century, and, as ‘American Indian’, remains the term of choice in the United States Census to this day. We have
no desire to offend anyone, and our decisions on this matter have been guided solely by what will make *American Civil War* an enjoyable and historically accurate game for everyone.

### 8.1.12. CAVALRY UNITS

During the Civil War, Cavalry played a vital role in both the Union and Confederate armies, serving as long-range scouts, raiding enemy territory and occasionally conducting Napoleonic-style charges on the battlefield. Three types of Cavalry units are represented in the game: Cavalry Brigades, Cavalry Divisions and Cavalry Corps, each one more powerful than the last. Note that Cavalry Corps are not used in the default campaigns, but may be used if you wish to design your own campaign.

**Tip!** Cavalry units can spot up to 3 hexes whereas other units can generally only spot 1, making them an essential component of armies wishing to conduct offensive action without being ambushed by the enemy.

### 8.1.13. PARTISANS

Partisans can help pin down enemy units, reduce the supply-level of resources, and disrupt military production in their areas of operation. In certain contested areas, this activity might develop into full-scale uprisings, as was considered by the Confederate leadership towards the end of the war.

Most partisan activity can be prevented by keeping units in or adjacent to their spawning hexes, and these can be seen by pressing ‘P’ on your keyboard.

Smaller partisan actions will simply damage resources, with no actual units being deployed on the map.

Partisan uprisings of significant strength will deploy units on the map, and these can capture resources and interdict supply lines causing immense trouble to their occupiers.

When pressing ‘P’, Partisan locations that can spawn a unit show a Partisan, whereas those that will only damage resources show a Partisan with a line drawn through it.

Partisans have a default maximum strength of 8, a minimum supply value of 3, and they are restricted to rail movement within their home country.
8.1.14. FIELD ARTILLERY

Field Artillery units represent concentrations of small cannons, such as the 12-pounder bronze ‘Napoleon’, deployed at key points to either bolster the defense or support an attack. Field Artillery units can be useful in lowering enemy entrenchment values and demoralizing the target.

Artillery units also have an automatic ability whereby, providing they have shells remaining, they will provide Defensive Fire to shell any enemy units attacking friendly units within range.

Artillery can also fire blindly, targeting enemy held hexes and potentially damaging hidden units in them. These attacks will not disclose the presence of hidden units.

Note that Field Artillery units are not used in the default 1861 Blue and Gray campaign.

8.1.15. SIEGE ARTILLERY

Siege Artillery units represent concentrations of larger and more powerful mortars, such as the Parrott rifles used at Charleston and Petersburg. Compared to Field Artillery, Siege Artillery is less effective at reducing enemy unit strength directly but has greater ability to reduce their entrenchment and demoralize their target. Siege Artillery is also particularly effective at targeting units in cities and fortifications, as it inflicts an additional +1 de-entrenchment when targeting units in Resources.

Like Field Artillery, Siege Artillery also has the Defensive Fire ability, although this will only target enemy artillery units. Siege Artillery can also “fire blindly”.

8.1.16. RAILROAD BATTERY

The forerunner of the great Rail Guns of the 20th century, the Railroad Battery consists of a very large mortar mounted on a railcar. The most famous of these is the 13-inch Coehorn mortar used in the Siege of Petersburg, where it earned the nickname Dictator for its accurate long-range fire.

Railroad Batteries, like Siege Artillery, are primarily useful in de-entrenching and demoralizing heavily fortified units. They can only fire
before moving and naturally their movement is restricted to friendly railway lines. They will have 1 shell per turn that can be fired, and note that they do not provide Defensive Fire to friendly units under attack, so it is best to fire that shell during your turn.

### 8.1.17. Forts

Forts are static defensive units that can shell enemy forces, accumulating shells in the same way that Artillery does. Forts will fire on Amphibious Transports that halt in an adjacent hex, even if only temporarily prior to landing, and this feature means that they will have to be a prime target for destruction before an amphibious invasion can expect to succeed.

Forts cannot Rail Move or Swap as they have a default setting of zero Action Points.

Two types of Fort units are included in the game: Blockhouses and the more powerful Defenses. Note that only Defenses are used in the default campaigns.

As the location of all pre-war forts were known by both sides in the Civil War, these units are exempt from normal Fog of War rules and their location can be seen by both sides at all times, although their exact combat strength (as well as stats such as Readiness) will remain hidden unless you have a unit adjacent to their position.

Forts are limited to a maximum strength of 5.

### 8.1.18. Armored Train

A relatively new weapon in the Civil War, Armored Trains equipped with riflemen and artillery are fast-moving units ideal for anti-partisan duties or performing limited reconnaissance. As the name implies, their movement is restricted to friendly railway lines. Armored Trains are limited to a maximum strength of 5.

### 8.1.19. Balloons

Lighter-than-air flight technology was in its infancy during the 1860s, with the Union Army experimenting with hydrogen-filled Balloons early in the war.

When moving, Balloon units behave like all other ground units, moving more quickly on roads and being slowed by difficult terrain or enemy zones of
control. Balloons have a large spotting radius, but unlike other units, they can only benefit from this during clear weather. They cannot attack enemy units and will likely be destroyed if attacked themselves. Balloons are limited to a maximum strength of 5.

Balloons become available for purchase once the first level of Experimental Balloons technology has been researched, and subsequent levels will increase their spotting radius and movement range.

8.2. NAVAL UNITS

Naval units represent several combat and support vessels clustered around a named capital ship. They can be used to help control or threaten vital sea-lanes and Convoy routes, and they can also carry out shore bombardments.

8.2.1. RESISTING AMPHIBIOUS INVASIONS

All naval units except Submarines can also be used to direct automatic Defensive Fire against Amphibious Transports that end their move adjacent to one of these ships. By placing these naval units in key areas they can help to frustrate your opponent’s amphibious landings.

8.2.2. RAIDING PORTS

Naval units can reduce the effectiveness of enemy Ports and other coastal resources by raiding in selected locations on the map. They will not gain experience from doing so, but nor will they lose supply in doing so. These areas are shown like this on the map:

Another use of naval units is to raid enemy Convoy routes, a task Gunboats in particular excel at. To raid a convoy route, right click on the unit and select Select Convoy Mode → Raider, so that they display a Blue button next to the strength counter, and then move them to be either on or directly adjacent to an enemy convoy route.
8.2.3. **Battleships**

The pre-Dreadnought Battleships of the 1890s are the most powerful warships represented in the game. Their large size prevents them from entering Rivers, but they will outgun any opponent they meet on the high seas. Battleships cannot be purchased in the default Civil War-era campaigns, such as *1861 Blue and Gray*.

8.2.4. **Cruisers**

Steel-hulled Protected and Armored Cruisers were fast and powerful warships whose design emerged in the early 1880s. Like Battleships, they cannot enter Rivers. These units will not appear in the default Civil War campaigns, but are available for use if you wish to design your own campaigns.

8.2.5. **Ironclads**

Steam-powered armored Ironclads first appeared with the launching of the French *Gloire* in 1859, and soon emerged as the most powerful warships of the Civil War era, with their heavier guns making them ideal for destroying coastal Monitors. Ironclads cannot enter Rivers but can freely sail both coastal waters and open Ocean. In the default campaigns, they become available for purchase at the end of 1861.

**Note:** A distinction should be noted between the Ironclad *unit* type and the Ironclad *class* of units, which also includes Battleships, Cruisers, Monitors and River Ironclads. Where the meaning is not obvious, the game’s documentation will use the capitalized Ironclad to refer to the unit, and the lower-case ironclad to refer to the class of units.

8.2.6. **Monitors**

Made famous by the 1862 battle between *Monitor* and *Virginia* (or Merrimack), the Monitor (alternatively known as a casemate ironclad) is the first ironclad warship available for purchase. Their large guns and iron armor make them virtually immune to attack by older wooden warships, although they are limited to Coastal waters only and are relatively slow. Even with these limitations, they represent a cost-effective way to defend and control the coastline.
Due to the severe shortage of iron production in the Confederacy, Confederate Monitors cannot be purchased until October 1861.

8.2.7. SHIPS OF THE LINE
Wooden-hulled Ships of the Line, carrying anywhere from 50 to over 100 guns, were the most powerful warships afloat until the invention of the ironclad. Though most famous for being powered by sail, a number of ships of the line were converted to steam power in the 1840s and 50s. These obsolescent ships remain available for purchase by the Union and Confederate navies, and are the strongest warships permitted to sail on the open Ocean until the appearance of the Ironclad.

8.2.8. FRIGATES
Like the larger ships of the line, wooden sail- and steam-powered Frigates became obsolescent as the Civil War progressed. These fast-moving vessels can travel in both coastal and deep Ocean waters, although not Rivers, and the large numbers of them available to the Union early in the game make them suitable for enforcing the Blockade of the South until more powerful warships can be constructed.

8.2.9. GUNBOATS
Small screw-driven gunboats and paddle steamers were built in large numbers by both the Union and Confederate navies. They are restricted to coastal waters, but may also enter rivers. Gunboats are particularly effective in providing shore bombardment, and are second-to-none for convoy raiding, although their small size means they will be outmatched by any larger warships. Gunboats are limited to a maximum strength of 5.

Note: Gunboats, unlike other warships, do not attack resources such as Towns or Ports, and will instead only target the unit in a hex when attacking.

8.2.10. RIVER SHIPS
During the Civil War, both sides built a variety of small craft designed for service on rivers, particularly the Mississippi, Tennessee and Cumberland.
These ships are included in the game as River Ironclads, River Timberclads and River Gunboats.

River ships, as the name implies, are limited to traveling along Rivers, and cannot move into either coastal or ocean waters. All River Ships are limited to a maximum strength of 5.

Note: All river ships will ignore resources such as Towns or Ports, and will instead only target the unit in a hex when attacking.

8.2.11. Submarines

Submarines in the 1860s were still experimental weapons, built in small numbers and causing very limited damage in the Civil War. Most submarines of this era were powered by hand, rendering them slow and unable to move outside of coastal waters. Note that the best use of Submarines in combat is to lurk and ambush enemy vessels. If however a Submarine moves before attacking then the vessel it attacks will have its losses reduced by 50%, and the attacking Submarine will have its losses doubled.

Owing to their experimental nature, Submarines will require substantial research investments if they are to be used as effective weapons of war. Level 1 of Experimental Submarines is required before a Submarine can be purchased, while subsequent levels will improve their combat stats. The Buoyancy Tanks upgrade also grants the ability of a Submarine to dive and avoid combat when attacked.

Unlike other ships, Submarines are unable to use the Naval Cruise function. Submarines are limited to a maximum strength of 5.

In the default campaigns, Submarines cannot raid enemy convoy routes, although this may be changed in custom campaigns.

8.2.12. Torpedo Boats

Torpedo Boats are small, fast warships that became prominent in the 1890s. Though outmatched by the firepower offered by a Battleship or Cruiser, they can be useful for escorting Transports, or for attacking weak naval targets such as enemy Transports, as well as enemy warships in port. Torpedo Boats can enter coastal and ocean hexes, but not rivers. Torpedo Boats are not present in the default 1861 Blue and Gray campaign but are available for use in custom campaigns.
8.2.13. TRANSPORTS

Transports are used to move land units across the sea. Transports can only load or unload units at a friendly-controlled Port, and can then be moved just like other naval units. Transports can move land units over all types of sea hexes, including Rivers.

In terms of combat, Transports are quite weak since they cannot attack and their defense is poor. They do have a 10% chance of evading damage if attacked, but even so, providing them with a naval escort is recommended.

Note: Each country can only put a limited number of units in Transports at any one time. This limit will increase through researching Logistics, as Build Limits will increase by 2 per level for Majors (Minors in the default campaigns cannot use transports). Logistics also decreases the cost of putting units in Transports by 10%.

8.2.14. AMPHIBIOUS TRANSPORTS

Amphibious Transports are used to conduct invasions against enemy controlled shores.

Unlike regular Transports, Amphibious Transports can be used to unload units directly onto Coastal hexes, either friendly or enemy controlled. Amphibious Transports may also unload units at a friendly controlled Port.

To help soften up the target before a landing is made, Amphibious Transports can themselves attack an enemy unit, before the unit they are carrying lands. Be aware that the Amphibious Transport and consequently the unit it is carrying can suffer casualties when doing so. Even so, this can be useful if attacking defended islands or coastlines, and the unit itself can also attack once it has been unloaded from the Amphibious Transport.

8.2.15. AMPHIBIOUS TRANSPORTS (LONG RANGE)

These act exactly the same as Amphibious Transports, except that they don’t lose supply every turn. Their benefits from Amphibious Warfare research are the same as for Amphibious Transports, except that they do not gain any increases in their Action Points.
They can Cruise and are really useful for launching invasions far from their starting point, but as they are 25% more expensive than regular Amphibious Transports their use should be carefully considered before embarking the troops.

8.2.16. USING TRANSPORTS AND AMPHIBIOUS TRANSPORTS
Right clicking on a unit which is immediately adjacent to a friendly Port will provide the option to place it in a Transport or Amphibious Transport, providing it hasn’t yet moved or attacked, and you have sufficient MPPs available.

Marines are a unique unit type in that they don’t need to be adjacent to a Port in order to embark in an Amphibious Transport.

Note: Researching Amphibious Warfare will increase both the Action Points and the number of units allowed to be amphibiously transported simultaneously, for both types of Amphibious Transport.

9. RESEARCH

9.1. INTRODUCTION
Getting the best out of your armed forces and economy requires investing a significant proportion of your income into Research.

All Majors can conduct research to improve their income and the fighting qualities of their armed forces. Minors can benefit from the research undertaken by their controlling Majors, but they cannot themselves invest in research.

Each technology area has a maximum potential achievement level of 5, though the actual limits per category do vary.

In other campaigns the limits may be different, in accordance with the settings chosen by their designer.

The limits can be seen in the Research screen, as the maximum level that can be researched is shown in brackets at the end of each category’s entry:
Although this functionality is not used in American Civil War, modders can set the actual maximum level for upgrades to also vary according to unit type. For instance, one may wish to limit Brigades to level 1 Infantry Equipment, while other units can reach level 2.

The number of research chits that can be allocated at any one time into a specific research category will vary, as the investment limits can vary from 1-5 chits per category. In all default campaigns, this limit has been set at 2 chits for all techs.

Each Major has its own investment limit, in MPPs. This prevents anyone from investing far more in research than was historically possible, and it also means that those countries capable of rapid progress are more likely to do so.
For example, the Union can invest more in research than the Confederacy, and the Confederacy can in turn invest more than Mexico. In the flagship 1861 Blue and Gray campaign, the European powers cannot invest in research, their long-standing professional armies and military tradition meaning that they begin the game with all technologies already researched.

9.1.1. In Brief: The Research Mechanism

- For every chit invested, progress will be made at the end of that side’s turn towards reaching the next level of research.
- Per turn increments to achieve the next level in a technology field average 4% per turn, in reality between 2-6% per chit.
- Research automatically succeeds in gaining the next level on reaching 100% progress, though there is a small chance of a breakthrough speeding up your progress by an extra 15-25%.
- The chance of a breakthrough is 5% per turn per chit invested.
- The Research Sharing feature and researching Spying & Intelligence can both speed up your research progress.
- Research chits can be recouped at 50% of their original cost.
- Costs rise with unit upgrades, generally by 10% per level of upgrade, though some like Skirmishers only cost 5% and others like Infantry Scouts cost 20%.

9.2. In Depth: The Research Mechanism

Now let’s look at this mechanism in more detail.

9.2.1. Progression every Turn

At the end of each turn, each invested chit will advance your progress by a % towards the next level of research.

To achieve level 1 in a research category, the base % progress per chit per turn is 4% per turn.

The actual per turn increment will vary from 50% less to 50% more than the % above, with fractions being rounded down.

So, as an example, if you have 1 chit at 4% then you will have a 2-6% increment towards 100% per turn.
The more chits invested in a particular technology area, the faster you will progress towards the next level. So, if you have 2 chits if researching level 1 then you will have a 4-12% increment towards 100% per turn.

Each chit makes progress every turn from 0-100%, and once you reach 100% you will automatically achieve the next level in that category.

9.2.2. Research Breakthroughs
There is a chance every turn of achieving a Research Breakthrough that will speed your progress by an extra 15-25% that turn.

The chance of a breakthrough is based on the number of chits invested multiplied by the % chance of progressing per turn.

For example: 1 chit @ 5% gives you a 5% chance every turn that you might achieve a Research Breakthrough.

While there is some uncertainty about when your research will be successful, it will definitely occur once research has progressed to 100%. The mechanism is designed to give a blend of uncertainty and certainty, with no immediate success on investing the chit, but with ultimate success guaranteed after a period of time.

When a Breakthrough occurs, you will see a message at the end of your turn like these:
- War Department Reports Advances In <research_name> Development
- Espionage Advances <research_name> Development

9.2.3. Catch Up Bonus
The research formula also has an adjustment that takes into account real life situations that occur in every war, such as studying captured enemy equipment and the results of spying and espionage.

Therefore, if a fully mobilized enemy Major has achieved a higher level than you in something you are researching, then a bonus will be applied to your progress every turn of 1% per difference in level. This bonus might be further modified by Research Sharing and Spying & Intelligence as described below.
9.2.4. SPYING & INTELLIGENCE

Each new level of Spying & Intelligence increases your own research by 1% per turn. However, this can be impacted if your opponent is also researching and achieving Spying & Intelligence levels of its own.

The impact can either be to decrease or to negate your research bonus entirely. Though note that only the intelligence levels of fully mobilized enemy Majors are taken into account.

For example, if the enemy’s intelligence level is higher than yours, then it will negate your own Spying & Intelligence. But if your intelligence level is higher than your enemy’s, your Spying & Intelligence bonus will be the difference between the two levels.

For example, if the Union has intelligence Level-1 and the Confederacy has intelligence Level-2, then the Confederacy’s research bonus will only be the difference of 1. The Union will receive no bonus in their own research as the Confederacy has a higher level.

If both you and your enemy’s highest Spying & Intelligence levels are the same, then they simply cancel each other out until one or the other achieve a new higher level. Essentially Spying & Intelligence helps you if you are ahead of your opponent but not if you have the same or a lower level in it.

9.2.5. EXAMPLES

Our first example represents the research formula using just the Catch up Bonus.

- We have just one chit in Leadership at Level 1 (where the normalized research formula means you have an average 4% progression per turn) and the enemy currently has Level 3, so the result will be:
  - Base Chance + (highest enemy level - current level) x research chits invested
  - 5 + (3 - 1) x 1 chit = an average 7% progression per turn
- If we also assume that we have 2 more levels of Spying & Intelligence than our enemy does, the formula becomes the following:
  - Base Chance + (highest enemy level - current level) + Spying & Intelligence modifier) x research chits invested
  - 5 + (3 -1) + 2 x 1 chit = an average 9% progression per turn.
If 2 chits were invested then progression would average out at an impressive 18% a turn!

9.3. Viewing Progress

To view your current research progress, hover your mouse over the relevant research field and the exact advancement % towards the next level will be shown. Fields that cannot be researched, either because they have been disabled for that campaign or because the maximum level has already been reached, will be shown in red.

The green bars show your progress at a glance:
9.4. Progressing to the Next Level

Research will advance a level once your progression reaches 100%.

While progression varies per turn, the chance of a breakthrough does not, as it is set to be the % for the relevant level, per turn per chit invested.

If you are ahead in Spying & Intelligence research then the chance of a breakthrough will be 1% higher per level that you are ahead.

So if you have 1 chit invested to research a level 1 technology at 4% a turn, then progression will be 2-6% per turn if no other Major has yet researched that level. If we leave aside Spying & Intelligence research for the moment, then the chance of a breakthrough to speed up your research will be 5% a turn.

Once you attain the next research level, 1 invested chit is consumed by default and cannot be reinvested or redeemed.

9.5. Research Limits

While chits may vary in cost, the total maximum invested in Research cannot exceed the allowable MPP limit per Major.

If you change your mind about your investments, an invested chit may be redeemed at 50% of its original MPP cost. But in doing so you will lose any progress made.

If your research progresses to the highest possible level in a particular field, and you had more than 1 chit invested, your surplus chits will automatically be redeemed for MPPs at the end of your turn.

Some modded campaigns might not follow the rule that consumes chits when research advances are made. If that were the case then the chits would remain invested in the given technology after you have successfully progressed to the next level.

9.6. Research Categories

The following section explains the benefits of each level of upgrade, firstly for Manual Upgrades, then for Automatic Upgrades. Manual Upgrades are effectively improvements in equipment and training, while Automatic Upgrades encompass a broader spectrum including improvements in communication, doctrine, military intelligence and social and economic mobilization for war.
9.7. Applying Manual Upgrades

To benefit from your research success in the Manual Upgrades category, you will need to apply the upgrades to individual units. To do this, right click on a unit and select Upgrade.

You can upgrade some or all of the potential upgrades available, providing the unit:

- Hasn’t carried out any actions this turn
- Is at a supply level of at least 5
- Isn’t adjacent to the enemy
- You have sufficient MPPs to cover the cost

Research levels greater than zero will be indicated on upgraded units with a small number on the bottom right of their counter as shown left:


Note: With the following categories, specific upgrade limits can vary according to unit type.

9.8.1. Infantry Equipment

This research field covers a broad spectrum of improvements in infantry equipment, including the development of rifled muskets and their ammunition, standardization of equipment and even small field artillery pieces, that together enhance the fighting power of infantry units.

Each new level increases the Attack and Defense values for all Infantry units except Engineers against all other land units, a bonus that scales with unit size to represent the greater importance of standardized weaponry to large units: Regiments, Brigades and Rangers receive +0.5 per level, Divisions, Marines and Mountain Divisions +1, and Corps +2.

Tip! All Majors are advised to research this category as infantry are the main force in every army and improving their quality will be essential for success.

Production and Reinforcement cost increase per level: 10%.
9.8.2. Skirmishers

Skirmishers are small units of sharpshooters and other light infantry trained to form a thin line in front of the main body of an army, and harass the enemy with fire at the beginning of a battle. Many such formations became skilled at shooting enemy officers, making them a particularly feared, if rarely decisive, part of the Civil War infantry.

Each new level increases the Demoralization value of all infantry except Engineers. Regiments and Brigades receive a 5% bonus per level, while other units receive 10%.

Production and Reinforcement cost increase per level: 5%.

9.8.3. Scouts

Civil War armies relied on the cavalry in order to locate enemy armies and allow commanders to prevent their forces from being forced into an unfavorable engagement. While most mounted formations take the form of specialized cavalry units, the Scouts upgrade allows infantry units to be equipped with a small cavalry detachment for the purposes of reconnaissance.

Infantry units (except Regiments and Engineers) with the Scouts upgrade have their Land Spotting radius increased by 1 hex.

Production and Reinforcement cost increase per level: 20%.

9.8.4. Cavalry Equipment

New innovations, particularly the breech-loading carbine and Spencer’s repeating rifle, represented significant advances in weaponry carried by cavalry in the Civil War.

Each new level increases the Attack and Defense values for all Cavalry units against all other land units, a bonus that scales with unit size to represent the greater importance of standardized weaponry to large units: Cavalry Brigades and Indians receive +0.5 per level, Cavalry Divisions and Cavalry Corps receive +1.

Production and Reinforcement cost increase per level: 10%.
9.8.5. FIELD ARTILLERY
Recent advances in metallurgy allowed combatants in the Civil War to benefit from large-scale production of rifled cannon, giving field artillery units a significant advantage in range and accuracy over their smoothbore-equipped predecessors.

Each new level of Field Artillery research increases the Land Attack of Field Artillery units by 1 per level, their De-entrenchment value by 0.5 per level, and their Demoralization value by 5% per level.

Note: This technology is not used in the default 1861 Blue and Gray campaign, but remains available for use in custom campaigns.

Production and Reinforcement cost increase per level: 10%.

9.8.6. HEAVY MORTARS
In order to subdue large Confederate defensive works such as those at Vicksburg and Petersburg, the Union developed a series of very large mortars and other “siege” artillery pieces.

Each new level of Heavy Mortars increases the Fort Attack values of Siege Artillery and Railroad Batteries by 1 per level, their De-entrenchment value by 0.5 per level, and their Demoralization value by 5% per level.

Production and Reinforcement cost increase per level: 10%.

9.8.7. MOBILITY
“Horse artillery”, or light artillery pieces towed by groups of horses and handled by crew trained to rapidly position, fire and move their guns, was used to great effect in the French Revolutionary Wars, and was a decisive part of Zachary Taylor’s success in the Mexican War, with his forces gaining the nickname “flying artillery”.

Mobility is a technological upgrade that represents all of the technological and logistical innovations required to allow the quick deployment and movement of artillery.

Each new level increases the Action Points of Field and Siege Artillery by 1.

Production and Reinforcement cost increase per level: 10%.
9.8.8. Buoyancy Tanks
Buoyancy Tanks, or ballast tanks, are compartments within submarines that can be filled with water to control the depth of the submarine. The Confederate submarine *H. L. Hunley* had two buoyancy tanks that were controlled by valves and hand-pumps, making it one of the first submarines in the world capable of quickly diving and resurfacing.

This technology grants Submarines the ability to Dive when attacked, something they will have a 25% chance of doing.

**Tip!** Submarines cannot be built until Level 1 of *Experimental Submarines* is researched. Make sure to invest in the experiments first!

Production and Reinforcement cost increase per level: 15%.

9.8.9. Naval Weapons
The arrival of armored iron warships necessitated the development of more powerful naval artillery capable of damaging them, most notably the eleven-inch Dahlgren guns carried by the *Monitor* and a variety of other warships.

Each level of *Naval Weapons* increases the Attack values of all warships except Submarines, against Forts, Ironclads (of all types), Wooden Ships and Transports, with these increases per level being larger for larger ships. This technology also increases the Attack values of Gunboats against all types of land units, by 0.5 per level. It also increases the Demoralization stat of all warships except Submarines by 5% per level.

Production and Reinforcement cost increase per level: 5%.

9.8.10. Ironclads
Perhaps no category of weapon was more profoundly affected by the Civil War than the warship. The first ironclads - the British *Warrior* and the French *Gloire* - were launched only a year before the outbreak of the war, and it was only one year later that the confrontation between *Monitor* and *Virginia* proved the wooden navies of the world obsolete. *Monitor* itself would be outclassed before the end of the war, as more advanced ironclads took to the seas and filled the place once occupied by Ships of the Line in the world’s navies, as the first “battleships”.
This technology can be used to upgrade Ironclad-type ships’ Defense values against all naval units, by 2 per level for Battleships, Cruisers and Ironclads, and 1 per level for Monitors, Torpedo Boats and River Ironclads.

**Production and Reinforcement cost increase per level:** 5%.

### 9.8.11. Naval Engines
Paddle wheels and steam engines were among the first innovations enabling warships to move faster than the speeds that could be reached by sailing alone. Frigates and Ships of the Line were fitted with steam engines as early as the 1840s, and while few ocean-going ships were built entirely without a rigging system until the decades after the Civil War, it was clear that steam, not wind, would power the warships of the future.

Each level of Naval Engines increases the Action Points of warships, except submarines, by 2.

**Production and Reinforcement cost increase per level:** 10%.

Armored trains were a brand new and still largely experimental innovation at the beginning of the Civil War, usually consisting of an ad hoc assemblage of wooden or iron armor to protect a group of riflemen or a small artillery piece. Although they had not yet matured into the purpose-built behemoths that would gain fame in the Russian Civil War, they nonetheless proved effective at protecting vital railroads from enemy partisan bands.

Each new level of Armored Trains increases the Defense values of Armored Trains by 1 against all land units, and their Action Points by 2.

**Production and Reinforcement cost increase per level:** 10%.

### 9.8.13. Fort Modernization
Many of the coastal forts that defended both the Union and Confederacy had been built decades before the Civil War, and were thus poorly equipped to defend against the latest generations of artillery weapons. This technology represents the various improvements made to forts throughout the war, including the creation of earthworks to defend them and the deployment of more modern artillery pieces.
**Fort Modernization** increases the Defense values against all land and naval units for Blockhouses by 1 per level and for Defenses by 1.5 per level. Defenses also receive 1.5 Ironclad Attack per level.

**Tip!** The large number of Confederate forts make this a particularly wise investment for the Confederacy.

**Production and Reinforcement cost increase per level:** 10%.


Unlike other upgrades, *Lighthouses* are a technology that have been used by the world's leading powers for centuries, and no research is required in order to upgrade Ports with them. The *Lighthouse* technology does not represent the construction of the lighthouse towers themselves, but rather their integration into the broader defensive system, including via the telegraph.

Ports upgraded with *Lighthouses* have their Naval Spotting range increased by 2.

Increasing the levels of *Lighthouses* on ports does not otherwise increase any production or reinforcement costs.

**Note:** Due to the nature of the hex owner/controller relationship when Minor countries may claim territory for Majors, *Lighthouses* research is presumed to be a shared technology between a parent Major and its controlled Minors. For instance, France could upgrade Veracruz in the Mexican Empire. Also, captured resources may be upgraded, so the Union can upgrade Jacksonville to watch over the coast of Florida and ensure Confederate warships do not attempt to recapture it.

**Production and Reinforcement cost increase per level:** 10 MPPs.

### 9.9. Automatic Upgrades

Unlike with Manual Upgrades and as the name implies, Majors automatically benefit from success in the Automatic Upgrades research fields. No manual intervention is necessary to apply upgrades, and these categories do not increase any production or reinforcement costs.
9.9.1. Corps Organization

This represents the wide range of improvements in training, doctrines, communication and organization required to form a Corps, the largest infantry formation represented by a single unit.

Each level increases the Build Limits of Corps by 4, and their Action Points by 0.5. Note that Level 1 must be researched before you can build any Corps.

Tip! It cannot be overstated how important this technology is, as Corps will form the backbone of your armies in the second half of the war. Ignore this at your peril!

9.9.2. Field Telegraph

Portable telegraph machines, and thousands of miles of wire, allowed commanders to quickly communicate with their subordinates and civilian leaders, greatly increasing their ability to command and control their forces.

Each level of Field Telegraph research increases the Command Range of, and number of units that may be attached to, HQs by 1.

9.9.3. Leadership

Leadership represents the wide range of improvements in command brought on by staff training, battlefield experience, improved selection of subordinates, and all the other changes made necessary as the ranks of the pre-war army swelled from 16,000 to over half a million men.

Leadership increases the Command Rating of HQs by 1 per level, and their Action Points by 0.5 per level.

9.9.4. Infantry Tactics

Representing investment in training, tactics, doctrine and improvements to the enlistment system, this category improves the Unit Morale of all Infantry units except Regiments and Engineers by 10% per level. It also increases the Artillery Defense values of Divisions, Mountain Divisions, Corps and Marines by 0.5 per level, and the Naval Defense values of all infantry units by 0.5 per level.
9.9.5. CALVALRY TACTICS
Representing investment in training, tactics and doctrine, this category improves the Unit Morale of all Cavalry units, including Indians, by 10% per level. It also increases the Build Limit for Cavalry Divisions by 1 per level, and the Naval Defense values of all cavalry units except Indians by 0.5 per level.

9.9.6. NAVAL TACTICS
This represents both the training and battle experience of your sailors, and the growing understanding of new technologies including Ironclads and Submarines, which together increase the Unit Morale of all naval units by 10% per level. It also increases the amount of enemy MPPs lost when your ships raid the enemy convoys, making it a particularly useful technology for the Union as it attempts to shut down the Confederate blockade runners.

9.9.7. AMPHIBIOUS WARFARE
Perhaps inspired by Winfield Scott's successful Veracruz campaign in 1847, the Union launched amphibious invasions against virtually every Confederate port of any significance during the Civil War. Amphibious invasions are well known as among the riskiest of all military maneuvers, and the training and doctrines represented by Amphibious Warfare can greatly improve your troops' odds of success.

Each level attained increases the Build Limits of Amphibious Transports by 2, and Long Range Amphibious Transports and Marines by 1 each. It also increases the Action Points of Amphibious Transports by 1, and those of Long Range Amphibious Transports by 2.

Marines also benefit from Amphibious Warfare, with an increase of 0.5 Infantry and Fort Attack per level.

The Confederacy cannot build any Amphibious Transports by default, making this technology a necessary investment if they wish to strike at the Union from the sea!

**Note:** Amphibious Transports cannot move on the turn the unit embarks unless level 1 in Amphibious Warfare has been reached.
9.9.8. EXPERIMENTAL SUBMARINES

Throughout the Civil War, both sides experimented with the development of Submarines, weapons that promised the ability to strike at enemy ships without being seen. In the 1860s the Submarine is still unproven, but against an unsuspecting foe they may be a dangerous surprise indeed!

*Experimental Submarines* increases the Attack values of Submarines against all enemy naval units. More importantly, it increases the Build Limits of Submarines, by 1 per level, and Level 1 must be researched in order to build a Submarine.

9.9.9. EXPERIMENTAL BALLOONS

Thaddeus Lowe’s Balloon Corps represented one of the first attempts to take advantage of the opportunities offered by aerial reconnaissance in warfare, presenting the first true alternative to cavalry and mounted scouts for locating an enemy army.

*Experimental Balloons* increases the Land and Naval Spotting ranges, and Action Points of Balloons by 1 per level. More importantly, it increases the Build Limits of Balloons, by 1 per level, and Level 1 must be researched in order to build a Balloon.

9.9.10. SPYING & INTELLIGENCE

Attempts to gather information on, and potentially interrupt, enemy movements took a wide variety of forms in the Civil War, from the tapping and cutting of enemy telegraph lines, to networks of sympathizers on the other side of the border, to simply reading newspapers intended for the enemy public. Perhaps no battle was more important, nor more profoundly impacted, by the gathering of intelligence than Antietam, in which General McClellan was able to benefit from the capture of a copy of Lee’s Special Order 191, detailing his plans for the battle, four days before it was fought.

Gaining information on enemy deployments will assist in planning your own offensives or counter attacks, so all Majors will benefit from this area of research.

*Spying & Intelligence* can reveal enemy units on the map with a 1% chance per unit per level, with a limit of 5 units per turn being revealed.
So when a Major has level 2 it will have a 2% chance per turn of spotting each hidden enemy unit. This can be especially useful in naval warfare where knowing the location of the enemy’s fleet could make all the difference between victory and defeat.

Each new level of *Spying & Intelligence* research increases your own research bonus by 1% and decreases your opponent’s bonus by 1%.

*Spying & Intelligence* levels only compete with each other, so if the enemy has a higher intelligence level than you, the only net effect will be to negate the benefit you’ll get from your own intelligence level. It won’t prevent or slow the base research % chance per turn.

Only the *Spying & Intelligence* levels of fully mobilized Majors are also taken into account when determining results, and only the Major on each side with the highest level of Intelligence research affects Research progress.

*Spying & Intelligence* will also increase the chance of breakthroughs speeding up your research, so there is a lot to be gained from researching this category.

### 9.9.11. Logistics

This technology represents improvements in infrastructure for the rapid deployment and redeployment of forces, as well as for their supply and reinforcement.

Each new level of *Logistics* research reduces Rail Movement and regular Transport costs by 10%.

*Logistics* also increases by 1 per level HQ’s minimum supply values, and the Build Limits for Transports for Majors and their Minors. Finally, each level of *Logistics* increases the Action Points of Armored Trains by 1.

### 9.9.12. Production Technology

Advances in any of the Manual Upgrades research areas result in cumulative increases in production and reinforcement costs for upgraded units. Thus, to offset these additional costs, developing *Production Technology* represents increases in the efficiency with which a country’s industrial capacity is mobilized for the war effort.
Each new level of Production Technology research decreases unit costs and the cost of Manual Upgrades by 5%.

If you are playing with Soft Build Limits enabled, Soft Build Limit penalties are still applied where applicable, but only after the calculation of the final unit cost minus any reduction due to Production Technology.

9.9.13. INDUSTRIAL TECHNOLOGY

Mobilization for war and the transformation of economies to a war footing took time, and this research category represents Majors mobilizing their resources to support the war effort.

The initial Industrial Modifiers at the start of the war do vary, representing different factors such as their economic power, their self sufficiency, and their relative preparation for war.

The Industrial Technology increments default to 10% per level.

9.9.14. AUTOMATIC INDUSTRIAL MOBILIZATION

This is not a research category, but a game feature that you will see in play in some campaigns where countries can have Resources that aren’t producing for their respective war efforts at the start of the war, but that will enter into production as their respective countries increase their military production. These will show a strength value of zero.

For example, in the Union, a number of resources including the Pennsylvanian iron mines and Springfield armory will only begin production on the second turn of the game.
10. POLITICS AND DIPLOMACY

10.1. ALIGNMENT STATUS & MOBILIZATION VALUES

All countries have an Alignment Status of either Union, Union Minor, Confederate, Confederate Minor or Neutral.

All countries that are neither fully mobilized nor totally neutral at the start of a campaign will have a Mobilization Value showing as a %, as well as an indication of whether they favor the Union or Confederates.

In *1861 Blue and Gray*, and other default campaigns, neutral Majors do not receive any MPPs until they enter the war. In other campaigns, including unofficial modded campaigns, neutral Majors receive higher income with a higher Mobilization value, allowing them to step up their preparations for war by investing in key research areas or important units.

Note that Majors cannot switch sides, so for instance, the Union can only hope to reduce Spain’s pro-Confederate Mobilization value. They will never be able to sway Spain into siding with the Union.

10.1.1. NON-COOPERATIVE MAJORS

Although no Major countries have a non-cooperative setting in the official campaigns that come with *Strategic Command American Civil War*, they could be in unofficial modded campaigns.

The effect of doing this would be that a non-cooperative Major would only provide a maximum supply value of 3 to units belonging to their allies that might enter their territory. Units belonging to their allies would not be able to rail move into or out of their territories, nor would they be able to rail move into or out of their allies’ territories.

10.1.2. MINOR COMBATANTS

Scripted events will trigger changes in the Mobilization Values for both Minors and neutral Majors. For example, Navajo is a neutral but pro-Confederate Minor, and it will respond favorably to a Confederate advance in New Mexico, while the European great powers will respond to both Union and Confederate
actions, particularly along the Atlantic coastline. These successes may not be sufficient to make them enter the war, or at least not as early as one might wish, therefore some diplomacy may be required too.

10.2. THE DIPLOMATIC MECHANISM

The diplomatic mechanism gives each side the opportunity to influence neutral countries into joining their side.

Each fully mobilized Major can typically invest a limited number of chits in Diplomacy, although in the default American Civil War campaigns this is limited to just the Union and Confederacy. Diplomacy chits represent political efforts as well as the promise of trade, military equipment, and economic packages that were often used to influence neutrals. The number of chits is limited to reflect the historical difficulties in bringing neutrals into the war.

The cost of Diplomacy chits depends on the neutral being targeted, with diplomacy targeted at Majors being more expensive due to the greater value of bringing them into the war on your side. The maximum diplomatic investment (i.e. the number of chits) cannot exceed the allowable limit that each Major can purchase.

Each country has a Mobilization Value that reflects their current political leaning towards a particular side. It is generally best to focus your diplomatic efforts on countries that are already leaning towards your side, instead of investing in countries that had little or no sympathy with your side. For instance, the Union has more chance of enticing Kentucky than the Five Tribes of the Indian Territory to enter the war on their side.

Diplomacy can be used to try to delay or prevent an enemy Minor from entering the war, and there will be times when this is a good thing to do.

If your diplomatic strategy is focused on a particular country, with all your Majors investing to the maximum, then success will be more likely and the MPP investment will more likely be worth the economic cost.

Once a diplomacy chit has been purchased and assigned to a country, in each successive turn there will be a random chance of an increase in its Mobilization Value towards your side. If you have more chits assigned, there is a greater chance of success.
The chance per turn for diplomatic influence will be 3% multiplied by the number of diplomacy chits assigned to the target country.

If diplomacy succeeds, there will be a favorable increase of 7-10% in the targeted country’s political leaning towards your side, with a 10% chance of that swing being 20-30% if the targeted country is a Minor.

If a Minor country’s Mobilization Level drops below 0%, then its Political Alignment will switch to the other side. It will now have a Mobilization Level towards that side. Note that the Mobilization Level of a Major country may not drop below 0% and its Political Alignment cannot change.

Once you achieve a diplomatic success, your invested chits are consumed and the targeted country will move towards your side. At this point the successful Major will now be able to repurchase and invest that chit, either in the same country if it is still neutral, or in another one.

Unlike Research, you cannot reclaim an invested diplomacy chit to regain the MPPs spent. Once a diplomatic investment is made, the MPPs have been invested in that country and while the chit can be reclaimed and therefore freed up for use elsewhere, the MPPs cannot be.

Note: Due to the flexibility available in the game engine, it is possible that some modded campaigns may allow chits to remain invested in a target country after a success is achieved.

10.3. Contested Diplomacy

At the same time as you are investing in diplomacy, your opponent could also be purchasing diplomacy chits to influence the same country. In this event, the difference between the cumulative friendly diplomatic pressure and the cumulative enemy diplomatic pressure will determine the % chance for a diplomatic result.

This allows for counter-diplomacy as well as for more interesting and occasionally surprising diplomatic results under Fog of War whereby the target of the enemies’ diplomacy remains unknown. Therefore diplomacy and counter-diplomacy will have a realistic feel, sometimes frustrating and sometimes exhilarating.
Standard political events (i.e. random political triggers and war readiness factors) may also change Mobilization Values. These will represent historical situations, the result of Decision Events, or be the result of successful offensives that can inspire neutrals to reconsider their position. For instance, the fall of New Orleans will move the UK, France and Spain away from the Confederacy.

10.4. Impending War Entry

Once a country’s Mobilization Value reaches 90% there is a random automatic boost of 1-5% per turn, and this will continue until the Mobilization Value reaches 100%.

10.5. Belligerence

Each Major has a Belligerence setting that is separate to its mobilization setting, which means that it can be fully mobilized, i.e. at 100% mobilization, but not necessarily at war with any other country. A Major country that is fully mobilized can move its units, declare war, invest in diplomacy etc, even if it is not actually at war with anyone.

This is somewhat hypothetical in the official Strategic Command American Civil War campaigns, as scripts are in place to make all fully mobilized Majors be automatically at war with all opposing Majors, with one exception: should Mexico enter the war (an event that can only occur if France joins the war, for historical reasons), the Confederacy will be offered the decision of declaring war on Mexico, which they can decline. If these belligerence scripts were to be switched off (as can be done should you wish to) it would be possible, for instance, to have the Union not be at war with a fully mobilized UK.

The Belligerence settings enable you to decide which of the Majors under your control will declare war.

Fully mobilized Minor countries will follow the belligerence settings of their Majors. For example, Osage’s Union Parent is the Union, and this means that when Osage reaches 100% mobilization it will automatically be at war with all the countries the Union is at war with.

Similarly aligned and fully mobilized Majors can only enter each other’s territory if they share a common belligerent. Consequently Union units could
not enter Mexico unless the Union and Mexico are both at war with at least one of the Confederate Majors (in the case of that decision mentioned earlier, if all scripts were left on their default setting, both the Union and Mexico would be at war with France). Nor would Mexican units be able to enter the territory of Union Minors in this instance, because fully mobilized Minors follow the same belligerence settings as their Majors.

One point to note is that units cannot attack an enemy from a non-belligerent hex, i.e. Union forces could not attack Confederate units in western Texas from northeastern Mexico (ie, over the Rio Grande) if Mexico is not yet at war with the Confederacy.

10.6. The Wider Impact of Declarations of War

The Mobilization Value of neutral Majors and the timing of their eventual war entry can be greatly affected not only by diplomacy but also by either side’s declarations of war against other neutrals.

For instance, declaring war on one of the Five Tribes (that is, the Creek, Cherokee, Seminole, Choctaw and Chickasaw) will automatically swing the Mobilization Values of the other four against the side declaring war. In American Civil War these diplomatic shifts can be quite significant, so while it may be necessary to declare war in order to secure valuable strategic positions, remember that an overly aggressive strategy could result in the remaining neutrals banding together to oppose you!

Attacking a neutral Minor will not necessarily bring you into conflict with its assigned Major, unless that Major is already close to full Mobilization (although in American Civil War, all neutral Minors are associated with the Union or Confederacy, with the sole exception being the Mexican Empire, a French puppet state that cannot be attacked directly). Though nearby Minors may react to aggression against their neighbors by swinging towards the other side.

Some declarations of war will trigger Fighting Spirit penalties to the aggressor, e.g. if the Union was to attack the UK, France or Spain.
PART 2
DESIGNING YOUR OWN CAMPAIGNS

“DETERMINE THAT THE THING CAN AND SHALL BE DONE, AND THEN WE SHALL FIND THE WAY.”

Abraham Lincoln, in a speech to the House of Representatives, 1848.

1. INTRODUCTION

While we hope that the campaigns that come with Strategic Command American Civil War provide you with hours of entertainment, this game also comes with an Editor that you can use to massively increase your enjoyment of this game.

It is very easy to amend the default campaigns if you wish to change some of their details or to test out different scenarios, and it’s also very easy to design new campaigns from scratch.

This Editor is no different from the one used to design the default campaigns, so you have all the tools at your fingertips for designing good quality campaigns, of course within the confines of the overall game engine.

This guide will talk you through all the Editor’s features, and if you get stuck at all then please don’t hesitate to post your question on our discussion forum at Matrix Games.

1.1. First things First

The contents of this Manual includes details on how to use literally everything in the Editor, from designing a map through deploying units to sitting back and watching the AI play out both sides in a play-test of your campaign.

But before you get started with this Manual, the best thing to do is to open up the Editor, open a default campaign, and just try out all the functions you can see in the top rows.
Playing with these to see what they do is the quickest way to get a feel for the Editor, for what it can do and just how easy it is to do many things. Use this Manual as a guide to specific things, but you’ll probably find that within a very short period of time you’ll have learned far more than if you’d just sat back and read the Manual.

Above all, have fun while you try things out, and don’t worry about what things might do. The good thing is that if you are trying things out with a default campaign then you cannot save any of your changes over it. If you do want to save them, you will have to go to File and Save As, and rename the campaign as something else, e.g. Test Campaign.

Once you’ve familiarized yourself a bit through practicing with the Editor, use the following Manual and let it guide you through everything in more detail so that you too can start creating wonderful campaigns for either your own amusement, or for other players to enjoy too!

1.2. USING THE EDITOR

Welcome to our guide on how to use the Editor. Using this you can use it to amend the existing campaigns or create new ones from scratch!

This guide is written on the assumption that you have at least a basic understanding of how the game works, though if you come across anything you don’t understand please either consult the main Game Manual, or post on our forums at Matrix Games.

1.2.1. EDITOR HELP FILE

Pressing F1 opens this document, so you can easily access it from within the Editor.

1.2.2. THE INFORMATION PANEL

At the bottom of the screen is the Editor’s Information Panel which will display different information as you work on a campaign.

Keep an eye on this panel as it is a useful tool because the information it shows will vary in accordance with the selection type you are working on.
For example, if you are adding units to the map then information relevant to the units will show here, whereas if you are editing terrain then it will show the terrain types instead.

The middle of the Information Panel will always show the X-Y coordinates of the hex your mouse is currently hovering over, as well as whether it is a Land, Sea or Land-Sea hex.

## 2. MENU BUTTONS

Before we proceed further, here is a guide to the Menu Buttons that are available in the Editor once you have a campaign file open, or are creating a new one.

### 2.1. FILE

#### 2.1.1. File → Creating a New Campaign

Once the Campaign Editor has fully loaded, a new campaign may be created by selecting **File → New** from the Main Menu bar at the top left of the screen. This will create a blank campaign template. Use the scroll to set the map size. This can be from a minimum of 10 x 10 to a maximum of 512 x 256 hexes.

By default the new campaign will be created with all hexes filled with sea, and in 9. Menu Buttons - Second Row we will look at using the Map commands to change these hexes so that you can design your own campaign.

#### 2.1.2. File → Open Default Campaign

To open a default campaign, select **File → Open Default Campaign** from the Main Menu bar.

You may open the original campaigns that come with *Strategic Command American Civil War* this way, to either view them or to create your own mods from these. If you do make any changes to any of these default campaigns you will need to save your version with a new name, as the original campaigns are protected.
2.1.3. **File → Open User Campaign**

To open any campaigns that you have created or amended, or any user made campaigns that you have downloaded, select **File → Open User Campaign** from the Main Menu bar.

These campaigns are stored in a different place to the default campaigns, and any new campaigns you create will be saved here.

**Tip:** From the Open dialog, it is also possible to right click on a *.cgn file in the Campaigns directory to delete or rename it.

2.1.4. **File → Saving a Campaign**

There are two options to saving a campaign, either **File → Save** or **File → Save As**.

Using **Save** will save the campaign with the current file name, while **Save As** allows you to rename the current campaign prior to saving it as a *.cgn file in the Campaigns directory. Using **Save As** will also save copies of any custom files relating to the campaign into the newly named campaign’s folder within the game’s Campaigns folder.

If when using **Save As** you select a pre-existing campaign’s file name to save the files to, then a warning message will prompt you to confirm that you wish to overwrite the Event scripts for that campaign.

You cannot save over a default campaign, instead you will have to use **Save As** and give it a new name.

2.1.5. **File → Import Data**

Once a new campaign is created, or with an existing campaign open, the **File → Import Data** command allows you to import data extracted from a different campaign (see the next item for how to export data).

After clicking on **Import Data** there will be a Warning Message to check that you wish to proceed.

If you select **Yes** to continue, you will now need to choose the folder where the data to be imported is kept, then press OK.

You can now select to import any or all items from a previous campaign for use in the campaign that you have open at the moment. The browser will
default to the game's Data directory and you will have to choose the sub-directory containing the desired Data files.

To import any data from the Map Layers, the imported map size must match the current map size. If they don't match then a warning message will advise you of the discrepancy, and you will have to adjust the current map size before importing.

Caution: The import feature will overwrite the current campaign’s data with that contained in the imported *.dat files, so only import if you are 100% sure or have a backup just in case.

2.1.6. File → Export Data

Using the File → Export Data command allows you to save the current Map Layers, Country Data, and General Data as *.dat files onto your computer.

The Editor will prompt you to select a folder to export the data to, and if you haven’t already done so, it will be best to create a new folder specifically for this data in an easily accessible location.

Select the folder and press OK.

You will now be presented with a Dialog box listing all the different types of data to be exported. You can select as much or as little as you wish, and there is a Select All button in the bottom right for use if you wish to export all the campaign's data. Click OK once you've chosen, and *.dat files will now appear in that folder containing the information that you have exported.

This Export Data function can be very useful as exporting Data files will enable you to import some or all of them into another campaign. For instance, you might be interested in re-using the map of an official campaign for your own totally different campaign. Using this feature you can import as much or as little as you like!

Note: Individual data files are NOT saved when the Save or Save As commands are used; only the *.cgn campaign file and any amended scripts will be saved using these.
Note: The default Data directory for all export information will be a new sub-directory with the name of the current campaign (e.g., \Data\1861 Blue and Gray). From the Browse for Folder dialog that opens when you select Export Data, you will be able to choose another export folder or make a new folder if you would rather.

2.1.7. FILE → EXPORT MAP POSITIONS (F6)
This is useful for script work where you want to use the coordinates of multiple locations when writing Event scripts.

To execute this feature, click on Map and tick both Edit Hex Layer and Select Item(s). Now select your chosen map positions and then either press F6 or click on File and select Export Map Positions. This will generate a text file called map_positions.txt in the main Strategic Command directory pertaining to the game in question.

You can then cut and paste the generated #MAP_POSITION text into the appropriate script event, though you might have to rename the control '#' entry to the appropriate name for some scripts.

By default you can only select the hexes of one country at a time. However, if you want to select hexes belonging to more than one country at the same time, simply hold down both your left mouse button and the Shift button, as this will enable you to select hexes irrespective of their ownership.

Note: Once you have used this feature, the .txt file that it creates will be added to every time you use this function, so you may want to either delete the contents of the file or the file itself once you’ve used the exported data.

2.1.8. FILE → EXPORT DATES (F7)
This allows you to export the campaign’s dates into a text file, where you will be able to see on which date it will be a Union or Confederate turn. This can be of use when scripting to ensure that events happen when you would like them to.

2.1.9. FILE → EXIT
When you have finished your work for the time being, the File → Exit command will close the Editor.
Note: Before closing the file, a warning message will prompt you to save the current campaign if you have made any changes since it was opened or last saved.

2.2. EDIT

2.2.1. EDIT → UNDO
Undo the previous action(s). Up to 10 of the previous actions can be undone. Ctrl-Z will Undo the action via the keyboard.

2.2.2. EDIT → REDO
Redo the previous action. Ctrl-Y will Redo the action via the keyboard.

2.2.3. EDIT → LOCK AND UNLOCK SCROLL
This Locks the map view in the current position, though if unlocked you can scroll the map using either the mouse cursor or arrow keys. Tip! Locking the map view is very useful when drawing or editing a new map and you are constantly selecting sprites from the sprite library on the right. This prevents the map from shifting whenever you move the mouse cursor too far in any direction.

2.2.4. EDIT → CHANGE VIDEO MODE (F3)
Select one of the choices of screen resolution. The Editor will remember the last opened position on your screen, so if for example you had it open in the top left of your screen, then the next time you open it it will open up in the same place.

2.2.5. EDIT → REFRESH FONT S (F4)
If you load customized fonts into this game’s Fonts folder while a campaign is open, then pressing F4 to refresh Fonts will show the new fonts when accessing the Text Layer.
2.2.6. Edit → Refresh Bitmaps (F5)
This refreshes the Bitmaps for this campaign, so if they have been edited since you opened the campaign and have saved changes to them, the Editor will now show them with the latest changes.

Tip! This is a very useful tool if you are customizing any of the image files in the game. Once an image has been modified, using Refresh Bitmaps or pressing F5 on your keyboard will automatically reload all the images in the Editor so that you can immediately see your amended image files without having to close and reopen the Editor.

2.3. Map

2.3.1. General Map Drawing Tips

2.3.1.1. Offsets
Offsets enable you to fine tune the exact position of items on the map, allowing you to move them by up to 25 pixels along both the X and Y axis.

To use Offsets, select the Layer relevant to the Hex you wish to adjust, e.g. Terrain Layer, click on Select Item(s), and right click on the Hex in question. Select the Offsets option and click on the X and Y scroll buttons to move the item in question until you are happy with its new position. Click OK when done.

2.3.1.2. Selecting Hexes in the Hex Layer
If you left click and drag with the mouse, you will only select hexes belonging to the same country as that of the first selected hex. For this selection type, Land/Sea hexes and all Coastal hexes are treated as Land hexes.

If you left click and drag the mouse while holding down Ctrl, you will select Land hexes en masse, but they will only be hexes belonging to the same country as that of the first selected hex. For this selection type, Land/Sea hexes and all Coastal hexes are treated as Land hexes.

If you left click and drag the mouse while holding down Shift, you will select any hex, Land and/or Sea, irrespective of their nationality.

If you left click and drag the mouse while holding down Alt, you will only select Sea hexes. For this selection type, Land/Sea hexes, and all Coastal hexes, are treated as Sea hexes.
If you left click and drag the mouse while holding down both \textit{Shift} and \textit{Ctrl} keys, you will select hexes \textit{en masse} of any type, whether Land or Sea, irrespective of their nationality.

If you left click and drag the mouse while holding down both \textit{Alt} and \textit{Ctrl}, you will select Sea hexes \textit{en masse}. For this selection type, Land/Sea hexes and all Coastal hexes are treated as Sea hexes.

\textbf{2.3.1.3. Drawing>Selecting in all other Layers}

Left clicking and dragging with the mouse will select valid game objects belonging to the currently selected layer.

Left clicking and dragging with the mouse while holding \textit{Ctrl} will select \textit{en masse} valid game objects belonging to the currently selected layer.

\textbf{2.3.1.4. Right Clicking to Select Items}

While you are in \textit{Draw} mode, right clicking on a hex will select that hex’s sprite as the current drawing sprite. It will also bring that sprite to the top of the sprite list on the right hand side of the Editor.

\textbf{2.3.1.5. The + and - Keys}

While you are in \textit{Draw} mode, if you hover the mouse over a hex and press + or – on your keyboard then you can scroll respectively up or down the selected sprite type. For example if you have the Hex Layer selected it will scroll through that layer. As you scroll, providing your mouse is hovering over the hex, the sprites will immediately show on the map and you can then select the one that you prefer.

\textbf{2.3.2. Map \rightarrow Edit Hex Layer}

Here you can add and edit Sea, Land and Coastal hexes on the map. Coastal hexes count as either Land or Sea, depending on the proportion of each in the hex, and there are also some hexes with both attributes called Land/Sea hexes. These act as land bridges between land masses, e.g. the Suez Canal or the Bosphorus Strait in our previous games. In \textit{American Civil War}, Land/Sea hexes have also been used to represent navigable rivers such as the Mississippi and Ohio.
New Land hexes will automatically be aligned to the country that is marked as Major Country Number 1. See the section on *Edit Major Country IDs Data* on how to change this.

Land hexes drawn over the top of pre-existing Land hexes will automatically have the same country and ownership as the Land hexes that were already there.

**Tip:** One technique for drawing a new map is to take a picture of the map you want, decide on an appropriate scale and overlay a hex grid. From this you can gain a rough idea of the content needed for each hex, i.e. where to put coasts, resources etc.

### 2.3.3. Map → Edit Terrain Layer

Add and edit forests, mountains, marshes and depressions on the map.

#### 2.3.3.1. Drawing Desert Hexes

When drawing Desert hexes in the Terrain Layer, image numbers 531, 532, 539 and 540 are set as full Desert hex sprites. If you select to draw with one of them, hold down Ctrl and as you drag and draw with the mouse, the Editor will automatically select randomly between the four to draw on the map.

This makes things easier when drawing a large desert area as the engine will automatically introduce randomness into the terrain layer. By releasing the Ctrl key you can then fine tune the actual desert hexes to suit your design.

### 2.3.4. Map → Edit River Layer

Add and edit Rivers and Major Rivers on the map, including river mouths and tributaries.

Rivers can be very quickly added to the map once you have selected **Edit River Layer** by selecting a river sprite from the Selection Column on the right hand side by left clicking on it.

Now draw a river by left clicking on the map and moving the mouse with the left mouse button held down. This will draw the river’s path. It isn’t likely to produce a 100% perfect river at the first attempt, especially not if the river doubles back on itself, but drawing whole sections of river directly onto the
map, rather than on a hex by hex basis, can be done very quickly with edits being made afterwards.

If you want to change a River on the map to a Major River, or vice versa, this can easily be done by doing the following:

Right click on a normal River sprite on the map, then right click again and the Selection Column will select the matching Major River sprite.

You can now draw this Major River by left clicking on the map, either overtop of the normal River sprite or elsewhere.

You can then repeat the above steps for any other River sprites that you’d like to change to Major Rivers.

This process can also be used in reverse to change Major Rivers into Rivers. With stage 1, each right click is alternating between both types, so right clicking for a second time on the same spot will go back to the regular River sprite.

Note that if you wish to create navigable rivers on your map, these are created by using Land/Sea tiles from the Hex Layer, NOT the River Layer.

2.3.5. MAP → EDIT ROAD LAYER
Add and edit (Paved) Roads and Dirt Roads on the map, including their junctions.

Roads can be very quickly added to the map by selecting a road sprite from the Selection Column on the right hand side by left clicking on it. Now draw the road by left clicking on the map and moving the mouse with the left mouse button held down. You can edit the road, adding or amending junctions afterwards.

2.3.6. MAP → EDIT RAIL LAYER
Add and edit Rails on the map, including junctions.

Railways can be very quickly added to the map by selecting a rail sprite from the Selection Column on the right hand side by left clicking on it. Now draw the railway by left clicking on the map and moving the mouse with the left mouse button held down to draw its path. You can edit the rail network, adding or amending junctions afterwards.
2.3.7. MAP → EDIT RESOURCE LAYER

Different sprites are included for the Western, Eastern, Mediterranean, Middle Eastern and Desert regions.

Note: You cannot add additional Capitals to a country that already has a Capital.

Tip! To see what strength resources will have at the start of a game based on their connections to Key Resources, saving the campaign will recalculate their strengths afresh. Simply select the ‘Resource’ layer and when you pass over a resource, the info in the bottom information bar will show the resource strength in brackets next to the name.

2.3.8. MAP → EDIT SYMBOL LAYER
Add and edit symbols on the map.

These can be used for naval and land Loops, for showing raiding areas, or for denoting other information as you see fit.

2.3.9. MAP → EDIT TEXT LAYER
Add and edit text on the map.

This is used for the names of resources, geographical areas and other features.

2.3.10. MAP → EDIT UNIT LAYER
Add and edit land, air and naval units on the map.

Note: To add units that will start the game in an Amphibious Transport or regular Transport, first place the new unit on land. Then right click on it, select ‘Move’ and left click on a sea hex and it will give you the opportunity to place it as either type of Amphibious Transport or as a regular Transport.

2.3.11. MAP → EDIT WEATHER LAYER
Add and edit Weather Zones on the map.

Select the hexes that you wish to assign to a Weather Zone and right click. This will allow you to set the Weather Zone for these hexes.
With the addition of Weather Zones, if you set an area to be an Arid, Semi-Arid, or Frozen zone then the look of the terrain will dynamically adjust to the new Weather Zone.

See *Edit Weather Data* for additional details on setting Weather Zones for the campaign.

### 2.3.12. MAP → EDIT NAVAL LAYER

Add and edit Naval Zones on the map.

Select the hexes that you wish to assign to a Naval Zone and right click. This will allow you to set the Naval Zone for these hexes.

The four naval zones are: Ocean, Coast, River and Impassable.

Land hexes cannot be assigned to naval zones.

### 2.3.13. MAP → EDIT MAP SIZE

Adjust the map's size by amending its X and Y axis dimensions. Changing the X axis value will change the right boundary, while changing the Y axis value will change the map's bottom boundary.

**Note:** Any reduction in map size will result in permanent data loss along the reduced axis, so be sure that this is really what you want to do before proceeding.

### 2.3.14. MAP → SHIFT CONTENTS

Using this you can shift map contents to either the left or right, or up or down. Only one horizontal or vertical shift may be made per action.

Decide whether you wish to move the map vertically or horizontally and then manipulate the second or third rows of up/down buttons in accordance with whether you wish to move the left or right hand column if moving horizontally, or the top or bottom if moving vertically.

The first row represents the number of columns or rows that a map section is being shifted. The second and third rows represent the start and end column/row numbers of the map section to be shifted.

**Tip!** Practice in a copy of your campaign before amending the original.

**Note:** Shifting contents will result in permanent data loss from the hexes along the X or Y axis at the new location.
2.3.15. Editing Layers
The three sections that follow all relate to editing the various layers on the map.

There are eleven different layers, and selecting the correct layer before proceeding is important as otherwise you may find yourself editing the wrong layer.

The different layers are shown here, as they appear in the second row at the top of the Editor. They can be chosen simply by left clicking on the one you want.

In order, the layers are:

- Hex
- Terrain
- River
- Road
- Rail
- Resource
- Symbol
- Text
- Unit
- Weather

Note that there is no button for the Naval Zone layer. If you want to change the Naval Zone layer, you will need to click Map and then Edit Naval Layer.

Hovering your mouse over each one will show its name, e.g. Edit Hex Layer if hovering over the first.

2.3.16. Map → Draw
When in Draw mode, left clicking on the map places the currently selected sprite onto the map, over-writing whatever was previously in the hex.

The currently selected sprite is shown in the Upper Sprite Box at the top right in the Editor. You can change the selection by using the scroll bar on the right to go up or down the choices beneath the Upper Sprite Box. Left click
on another sprite to select it, and note how the current selection in the Upper Sprite Box will change to the newly selected one.

**Tip!** When in Draw mode, if there is a sprite on the map that you would like to use elsewhere, right click on the sprite on the map. That sprite will now display as the current selection in the Upper Sprite Box. Now you can left click on the map to place this sprite where you would like it.

**Note:** Using the mini-map to move around while in Draw Mode will only change your location within the map, it will not make any changes to the campaign.

### 2.3.17. MAP → SELECT ITEM(S)

Left clicking on the map or mini-map in this Mode WILL NOT make any hex changes.

- Select individual hexes by moving your mouse around with the left mouse button held down. By default left clicking on hexes will only select the hexes of one country at a time.
- Select large numbers of hexes at once by moving your mouse around with both your left mouse and the *Ctrl* buttons held down.
- If you want to select hexes belonging to more than one country at the same time, hold down both your left mouse button and the *Shift* button while selecting. This will enable you to select hexes irrespective of their ownership.

Left clicking on any selected hexes again will deselect them.

**Tip!** Right or left clicking on a sprite from the sprite library on the right will display the current selection in the upper right sprite box and automatically reset the Editor to Draw. This action will return you to the drawing mode, and any selected hexes will automatically be deselected in the process.

**Adding Countries to the Map**

While using the Select Item(s) mode, right clicking while in the Edit Hex Layer Mode will allow you to set Hex Owner/Controller status. This is the tool to use to define countries on the map, as by setting the Owner you are assigning hexes to belong to that country.
If the new country doesn’t yet have a Capital, you will need to add one before you can save the campaign. To do this you will need to select the Resource layer, be in Draw mode, and add a Capital or Major Capital to one of this country’s hexes.

**Note:** You can set the hex owner to anyone you wish from the country list. If choosing a neutral Minor country as the Owner, the Controller will default to neutral, whereas with a Major the Controller will be itself.

If any countries are set to be at war, i.e. belligerent, then when selecting hexes their Controller can be set to be either their own controlling Major, or a Major country on the other side. If used, setting the hexes to belong to an enemy Major would signify that some territory has been captured by the enemy before the campaign starts.

### 2.3.17.1. Editing Items on the Map

All of the following require using the *Select Item(s)* Mode rather than the *Draw* mode.

Right clicking while in the *Edit River Layer*, *Edit Terrain Layer* or *Edit Resource Layer* modes will allow you to move, delete, rename, or set properties for the selected feature. This allows terrain features and resources to be named or renamed, or upgrade levels to be applied if applicable.

For Fortifications, Fortresses and Major Fortresses, under the *Properties* dialog you can also set a *Destroy On Overrun or Surrender* option. This means that the resource will be removed from the map should it fall into enemy hands.

**Hiding Resources:** If desired, these can be hidden. To do this, select the *Hidden* box that appears in the bottom left of the selected resource’s *Properties* dialog.

Right clicking while in the *Edit Unit Layer* Mode will allow you to move, delete, rename, set properties or set Mode (if applicable) for the selected unit.

Moving a land unit from a Land to a Sea hex will present the option to have that unit loaded onto a Transport, Amphibious Transport or Amphibious Transport (Long Range). This also works in reverse, so you can move a unit from any type of Transport back to land.

Editing units’ initial strength, experience and entrenchment levels, and supply levels for naval units, can all be done under the *Properties* dialog. The *Set Mode* dialog enables you to set the starting Mode for those units with different
modes, e.g. Artillery can be assigned their starting supply of Shells, Subs to Silent mode, etc. This mode also lets you set units to Sleep by default.

As you set research levels for the campaign, additional options will become available for customizing each unit or resource, such as enabling the latter to be upgraded with *Lighthouses*.

The *Details* section under the *Properties* dialog displays combat values for units and defense values for resources. The default values and costs will appear normally, and any upgrades based on higher research levels will appear in brackets like this: [...].

Unit attributes may not be set higher than your current research levels allow. See the *Edit Research* section for additional details on setting research levels for the campaign.

### 2.3.18. Map → Remove Item(s)

With the Remove Item(s) tool selected you can erase hex contents by left clicking on a hex.

This action is relative to the layer selected. For instance, with the *Edit Terrain Layer* Mode selected this will only remove terrain pieces like forests and mountains. The same applies for all others apart from when the *Edit Hex Layer* Mode has been selected, as with this one if you remove a land hex then literally all the contents of this hex that were dependent on the land will also be removed, only the *Symbol*, *Text* and *Weather Layers* would remain.

**Caution:** A warning message WILL NOT prompt you to proceed prior to making a change.

**Tip!** Right or left clicking on a sprite from the sprite library on the right will display the current selection in the upper right sprite box and automatically reset the Editor to Draw. This is a very quick way to go back to drawing.

### 2.3.19. Map → Generate Full Map Screenshots (F8)

To take screenshots of the whole map, press F8.

A subfolder called *Screenshots* containing multiple images of your map will be created in the folder: User\Documents\My Games\Strategic Command American Civil War
2.3.20. **MAP → DRAW MAP CONTROL VALUES (F9)**

Press F9 to see the extent of hex ownership of all fully mobilized countries on the map. All hexes belonging to neutral countries will display the number zero, while fully mobilized countries will display the number of their controlling Major, e.g. Confederacy is 1, Union 5.

2.3.21. **MAP → DRAW LAND CONNECTION VALUES (F11)**

Each set of connected Land hexes are assigned a number, so by pressing F11 you can see if a land mass correctly displays the same number throughout its length. Neutral countries will be shown as 0.

2.3.22. **MAP → DRAW NAVAL CONNECTION VALUES (F12)**

To check that all the Ports you have added to the map can access the sea, press F12 and check that the number showing over the Port is the same as that over the Sea hexes they should be accessible to.

The engine automatically divides Sea hexes into numbered Sea Zones, with all connected Sea hexes being in a zone. All Land hexes and Land/Sea hexes that are in a neutral inactive country will be shown as 0.

This function will probably only be useful if you have positioned some Ports in inlets connected to the sea via Land/Sea hexes, but it is useful to use this function to quickly check that all your Ports will be accessible as intended.

2.4. **CAMPAIGN**

2.4.1. **CAMPAIGN → EDIT CAMPAIGN DATA**

To edit basic campaign data, select **Campaign → Edit Campaign Data** from the Main Menu bar.

In the **Campaign Data** field you can set the Start Date, End Date, Who Starts and Centered Map Position.

You can also provide a brief description of the campaign and claim authorship of the scenario by inputting your name.

Any dates from year 0 to 9999 may be entered. The initial map display can be centered by specifying an initial map position in X,Y coordinates.
Campaigns may also be flagged as mini-campaigns. This has no real effect other than to help order main campaigns first and mini-campaigns second in the Select Campaign dialog when starting a new game.

**Note:** The campaign End Date must be greater than the Start Date. A warning message will prompt you prior to saving a change.

If you click on the Advanced button in the bottom right, this will bring up the Advanced Game Play Options dialog where you can amend the following:

- Select the Victory Basis to be Capitals or Objectives. The Capitals option means countries surrender or are liberated when their Capital and all Alternate Capitals have been captured. The Objectives option means that the standard surrender and liberation rules are disabled. In either case, victory is determined by the campaign’s Victory Event Scripts.
- Display Borders, Convoy Map and War Maps. If unticked then these options won’t display in game.
- Turns Remaining. This is used to advise players when the game is nearing its end date, to show them how many turns there are still to go.
- Preferences: Research, Diplomacy and Purchases. If unticked then these features will be disabled in game.
- Operational Movement (Land): This option will be unavailable if unticked. If ticked, then it can be set to be either Unrestricted or by Rail Only. With Rail Only you can set the minimum connection strength value for Resources to be able to act as the starting and way points for Operational Movement by land units. The minimum supply value that a unit must have in order to be operationally moved can be set here as well.
- Operational Movement by Air: This option will be unavailable if unticked. If ticked, you can set the minimum strength value for Resources to be able to act as the starting and end points for Operational Movement by air units. The minimum supply value that a unit must have in order to be operationally moved can be set here as well.

**Note:** by default, *American Civil War* has renamed the ‘Operational Movement’ function from past games ‘Rail Movement’. If you are designing a campaign where non-rail-based Operational Movement is
a possibility, we would advise you to edit your scenario’s localization file (NOT the game’s original one!) and use the older name to avoid confusion.

- Resource Supply Calculation: should this be Unrestricted or by Rail Only. If the latter is selected then supply from Key Resources travels outwards by rail, meaning that resources not connected by rail to a Key Resource will have lower strength and therefore supply values.

- The remaining general options are either available in game if ticked, or unavailable if their button is unticked. These are to allow:
  - Reinforcements
  - Elite Reinforcements
  - Upgrades
  - Transports
  - Amphibious Transports
  - Disbanding
  - Rebasing
  - Consumable Research Chits
  - Consumable Diplomacy Chits
  - Variable Hex Placement
  - Unit Placement Variation Upon DOW (Minors)

2.4.1.1. NOTES

- The Objectives option for Victory Basis disables the Alternate Capitals feature whereby Capitals move when the first one is captured. All Cities in the Capitals list will become Objectives, with the first City listed (i.e., the Capital) being the primary objective. All objectives will be highlighted with a yellow ring around them. If using the Objectives option, it might be wise to set any that would have been Alternate Capitals as Industrial Centers to allow them to act as supply and production sources if the primary objective is captured. See the Add/Remove Capitals and Add/Remove Industrial Centers for more details.

- The Rebasing option allows rebasing of air units.
- The **Unit Placement Variation Upon DOW (Minors)** option randomly moves by a maximum of one hex the placement of units for Minor countries when they are declared war upon. This makes planning an ideal invasion just that little bit harder.
- The **Consumable Research and Diplomacy Chit** options mean that one chit is consumed when a result is achieved.

### 2.4.2. Campaign → Edit Country Data

#### 2.4.2.1. Mobilizing Countries

To activate a country in the Editor, select **Campaign → Edit Country Data** from the Main Menu bar. In the following we will go through each section of the Country Data area in turn.

#### 2.4.2.2. Select Country

Each individual country’s data must be edited separately, and you can select the country you wish to activate in the Select Country list on the left.

Each country that is represented on the map must have a Capital, but it is not necessary for all countries that will be involved in the war to be represented directly on the map, as Events can be used to create countries during a game. Please refer to the Editing Events section for details on how to do this.

#### 2.4.2.3. Flags

Here you can set each country’s:

- Alignment as Neutral; Union or Confederate
- Confederate Parent if the country is a Minor. If the selected country is a Major then the default status is None.
- Union Parent if the country is a Minor. If the selected country is a Major then the default status is None.
- Build Restrictions as None; Home Builds or Home/Occupied.
- Scorched Earth to be None; On Invasion; On Liberation or Full.
- Aircraft Operating Restriction as None, Home Country Only or Home/Controlled.
Minimum requirements are as follows:

- There must be at least one fully mobilized Major country. This can be either Union or Confederate.
- All Minor countries must have both a Union and Confederate Parent defined. These Parents do not have to be fully activated, but they cannot be Neutral.

2.4.2.4. BUILD RESTRICTIONS

Setting a country’s Build Restrictions to Home Builds Only limits the deployment of new units to within their home country.

The Home/Occupied setting allows new units to be deployed both within the home country and also within any cooperative countries directly under that Major’s control.

Setting Build Restrictions to None allows unit construction in any friendly cooperative territories if a direct land connection with the home Capital is available.

2.4.2.5. SCORCHED EARTH

Scorched Earth means that resources suffer damage when they are captured or liberated.

The Full setting sets Scorched Earth to occur whenever their resources change hands, whereas the On Invasion or On Liberation settings mean that it would only happen either when a country loses its resources, or when it regains them, but not both.

2.4.2.6. AIRCRAFT RESTRICTION

Aircraft Restriction denotes whether or not this country’s air units will be able to operate to other countries.

Home Country Only means that air units can only operate within their own country.

Home/Controlled means that a Major can operate its air units within its own home country and any territory they occupy, including their subordinate Minors, but not to or from territory controlled by their allies.
2.4.2.7. Mobilization % and Status

Set a country’s Mobilization % from 0 to 100. Note that:

- If a Neutral Alignment has been selected, then 0% Mobilization will automatically display.
- If a country has a pro-Union or pro-Confederate leaning of less than 100%, then the country is considered neutral (though not neutrally aligned) and not yet at war with anyone.
- If a Mobilized Status is selected, then 100% Mobilization will automatically display.

Although a country’s initial alignment in a campaign may be set as Union or Confederate with a positive Mobilization %, for Minors, diplomacy or game events could drop this value below 0%. Should this happen, the alignment switches with a positive value towards the other side, as countries never have a negative Mobilization Value.

**Surrendered or Annexed.** Here you can set any activated Minor countries to have either status, defining the Occupier country for each in the box below. Surrendered means that the country’s forces are removed from play and their territory is occupied by the Occupier.

**Annexed** is a way to remove a pre-existing country and its armed forces from the map, with its territory transferred to its Occupier. This is useful as a quick way of editing a campaign like 1861 Blue and Gray into one that starts several years later, as states that exist on the map can be ticked as annexed. If you change your mind, then this can always be undone by simply unticking the Annexed box.

**Note:** Changing a Major’s status may also reset the Surrender or Annexation status of its dependents, as well as their Parent and/or Mobilization Status. The Union and Confederate parents of an annexed Minor do not have to be fully activated, but they cannot be Neutral. Also, annexing a country may reset its Capitals or Industrial Centers lists. A warning message will prompt you to confirm prior to making a change.

Set country **Cooperative** status. If ticked this allows a country to be fully cooperative with its allies and vice versa. Non-cooperative countries:
- Cannot operate their units into territory controlled by their allies.
- Their Resources will provide a maximum of 3 supply to units belonging to other non-cooperative countries.
- They will not intercept or escort for each other.
- Non-cooperative Majors that liberate Minor countries will override the previous Parent country setting and become the new parent.

**Examples:** (The limited number of geographically significant Minors in *American Civil War* means this point is more easily illustrated with an example from our WWI game).

- If Serbia were to be set as a non-cooperative Entente Major then:
  - It cannot operate land or air units to British, French or Russian territory, and vice versa.
  - If the British conquer Greece and Serbia is fully mobilized, no Greek resources would benefit from being connected to full strength Serbian resources.
  - Montenegro has Serbia as its Parent, but if Montenegro is conquered by the Central Powers and then liberated by the British, it will become subordinate to the UK and not Serbia.
  - In contrast, Canada’s resources will benefit from their connection to the USA when the latter enters the war, as both Canada and the USA are cooperative.

2.4.2.8. Coop. Restriction

Restrictions can be added to the Cooperative status, so that it is possible to denote whether or not units of countries allied to this one will be able to operate in and out of this country.

If the restriction is *(None)* then there are no restrictions and cooperative countries’ resources will supply each other, and both can operate air and land units in and out of each others’ territory.

If the setting is *Supply Only* then units from other countries can receive supply from that country’s resources, but no units from other countries can be operated into, through or within this country.
2.4.2.9. Belligerence

Use this tick box to assign who is at war with whom when the campaign starts. This only applies to Majors, as their subordinate Minors will automatically adopt the same Belligerence settings as their Parent Major.

2.4.2.10. Unit Orientation

Set the default orientation of units when they aren’t in enemy contact range. This is based on the unit facings in the image files that are set by default to face the right, or east.

The Mirrored orientation flips the default unit image to the left, i.e. facing west. The default orientation for a country will also affect friendly units placed in that country, so this is a useful tool to ensure that units adopt a logical facing according to their location.

The Reflect at Position option can be used separately or in addition to the Mirrored option. It means that a country’s units will automatically face the opposite way if they are on the other side of this Position.

Example: The default unit orientation for France is to face west. If the Reflect at Position option is ticked, then any units east of that position will automatically face to the east. This means that the default for a country like France which faces the prospect of a two front war (ie. in Mexico and the Confederacy) is for the units to face outwards towards the enemy.

2.4.2.11. Proximity and Facing

Any enemy land or air units that are within 5 hexes of each other, and connected by land to each other, will automatically face off against each other as logically as possible. Otherwise, if there is no unit within 5 hexes then they will face in their default orientation. For naval units the face-off range is 8 hexes.

2.4.2.12. HQs

Ticking the Attachable Minors tickbox will enable the selected Major to command units belonging to their subordinate Minors. Thus for example, Confederate HQs can be set to command Seminole units, and Union HQs can command Osage units.
2.4.2.13. Modifiers

Here you can set the:

- Initial Military Production Points from 0 to 9999 MPPs (Majors only).
- Industrial Modifier % from 0 to 1000 (Majors only).
- Fighting Spirit – Start (FS) (Majors only). Use this if your campaign starts part way through a war, by setting a figure lower than the one you assign to Fighting Spirit - Upper in the box below. The difference can represent Fighting Spirit losses due to casualties and lost resources prior to the campaign starting.
- Fighting Spirit – Upper (FS) (Majors only).
- Max Occupational Efficiency % of captured resources from 0 to 100.
- Soft Build Penalty % from 0 to 100.
- Fortress Build Delay from 0 to 365 days.
- Min Paratroops Prepare Supply Level from 0 to 21. This is not applicable in the American Civil War engine so can be ignored.
- Max HQ Attachments from 0 to 25.
- Max HQ Attachment Range from 0 to 25.

2.4.3. Setting Key Resources

Key Resources are Capitals; Industrial Centers; Primary Supply Centers and Secondary Supply Centers.

2.4.4. Alphanumeric Sort

Urban Resource names can be sorted either according to their position on the map, or in alphanumeric order. The latter is the default, but if you would like to sort them according to their position on the map, then untick the Alphanumeric button.

2.4.5. Urban Resources

Each country’s Urban Resources are listed in two separate columns, one on the left and another to the right of the middle. Select locations from the list on the left to add them to the Capitals or Industrial Centers lists. Locations in the right hand list can be selected and added to the lists of Primary and Secondary Supply Centers.
2.4.6. ADD/REMOVE CAPITALS
Define a country’s Capital first and any alternate Capital(s) subsequently, in order, if applicable. If the current Capital is captured, the game will then move the country’s Capital to the next one listed that is still under friendly control. A country will only have one active Capital at a time during a game, and it will begin checking for surrender once its final Capital is captured.
If Capitals are liberated then the Capital can return to a previous location.

2.4.6.1. ADD/REMOVE INDUSTRIAL CENTERS
Define locations in addition to a country’s Capital that can serve as Industrial Centers. These Industrial Centers will not only act as a supply source similar to a Capital, but players will also be able to build and deploy units at urban resources that can trace a line of friendly hexes to these Industrial Centers.

2.4.6.2. ADD/REMOVE PRIMARY AND SECONDARY SUPPLY CENTERS
Define locations in addition to a country’s Capital and Industrial Centers that can serve as Primary and Secondary Supply Centers. These Supply Centers will provide supply but unless there is a line of friendly hexes directly connecting them to a Capital or Industrial Center, players will not be able to build units here.
Note that an occupier gains the pre-existing Primary and Secondary Supply Centers when the country surrenders.

2.4.6.3. CUSTOMIZED VALUES & RESTORE DEFAULTS
This game comes with default data settings for all countries and unit types. Any amendments you make will be classed as customized values, and these customized values will be displayed with an asterisk (*).
Selecting Restore Defaults at the bottom of the screen will enable you to restore some or all default values according to your selection.

Unit Build Lists: There will be a delay when restoring their defaults, as well as a warning message as the campaign needs to be saved before doing so.

Note: When you’ve finished editing, click on the OK button in the bottom right to go back to the Country Data screen, then click OK again to go back to the Editor itself.

Tip! It is wise to save your changes on a regular basis.
2.4.7. Campaign → Edit Country Data → Edit Unit Build Data

Here you can set Unit Build Limits for each unit type for each country. They can be set from -1 to 255. If set to -1 then no number will appear in the Build Limit, and the unit type will not appear in the Purchase screen during a game.

**Note:** Build limits do not restrict the number of units that can be placed on the map at the start of a campaign. Thus it is possible, if desired, to have units on the map that cannot be rebuilt once they have been destroyed, an example being the fortress Defenses controlled by both the Union and Confederacy at the start of the game.

2.4.7.1. Unit Name Lists

In this section on the right of the screen you can add/amend the unit names for all unit types for all countries.

Units with these names will then be available for deployment directly onto the map in the Editor, or for adding to the Purchase and Deployment Queues, or simply to be purchased in game. With HQ units you can set their Command Ratings from 1 to 10.

Select the country on the left whose Build List you wish to edit. Then select the relevant unit type, add a name in the field at the top right called **Name:** Click **Add/Edit** and the new name will appear in the **List:** box. Names may be amended or deleted from the list by clicking **Remove** near the bottom of the screen.

**Note:** During a game, renaming units is possible providing a unit of that country and type doesn’t already have that name.

**Tip:** By setting build limits at the 255 maximum you would effectively have a game with no limits.

2.4.8. Campaign → Edit Country Data → Edit Unit Cost Data

Set unit cost from 0 to 9999 MPPs by unit type for each individual country. All unit costs represent their costs without any research upgrades applied.
2.4.9. Campaign → Edit Country Data → Edit Production Delay Data

Here you can set the time it will take for new units to be ready for deployment from when they are purchased. This can be set to either Turns or Months using the buttons at the bottom left.

If set to Turns, the delay can be from 0 to 365 Turns for each unit type for each individual country. If set to Months, then from 0 to 60.

2.4.10. Campaign → Edit Country Data → Edit Combat Target Data

You can customize the Combat Target Values for any units in a campaign, changing any of their values for attack, defense, movement etc.

Attack and Defense values can be set to range from 0 to 10 by unit and resource type for each individual country, while most General Combat Target Values can range from 0 to 25. Exceptions to the latter are:

- The number of Interceptions, Escorts, Attacks can be set to a maximum of 2.
- Min Shells and Max Shells can vary from 1 to 10 for applicable artillery unit types.
- De-Entrenchment can vary from 0 – 8.
- De-Moralization can range from 0 – 100%.

With Anti-Aircraft units, their Intercept Range is the range at which they will attempt to shoot down attacking enemy aircraft. The Number of Interceptions determines the maximum number of enemy air attacks they can attempt to fire at in any one turn.

Loss Evasion in Land and Naval Combat can be set from 0 – 100%, with different values applied if desired for attacking and defending. Note that this is the % chance that this unit type will suffer no losses at all when attacking or defending.

In the Extra area you can set the Raid Multiplier in MPPs for unit types capable of raiding (naval units and bombers), and Enemy Fighting Spirit Losses (Per Raid). The latter is used to inflict a penalty per Raider on the Fighting Spirit of a Convoy recipient. For example, for every Union Gunboat that does at least 1 MPP damage to a Confederate convoy route, the Confederacy will also lose
8 FS points. The Raid Multiplier (MPPs) can be set to a maximum of 100, and the Enemy Fighting Spirit Losses (Per Raid) can be set to a maximum of 5,000.

Lastly, the Target Type is shown. As combat is resolved between the competing Attack and Defense Values by Target Type, it is recommended to familiarize yourself with them a little, so that the values you assign will be most applicable for your campaign.

**Note:** All values in this area represent their values without any research upgrades applied. Please see the Research section for additional details regarding how higher technology levels affect Combat Target Values.

### 2.4.10.1. APPLY DATA

At the bottom of the screen you’ll notice that between the Restore Defaults and OK button there is one called Apply Data. This tool enables you to effectively apply the settings for one country to another. This can really speed up your editing so be sure to try it out!

From the Combat Target Data screen select a country whose Combat Target Values you would like to apply to another. Click on Apply Data.

Note that the selected country is shown right at the top of the newly opened Dialog Box, e.g. *Apply Current Data (UK →)*.

Select countries on the left hand side that you would like to have the data applied to, and then select the unit type(s) on the right that will receive the same statistics as the selected country. If every country and/or unit type is to have the same Combat Target Values, then you can use the Select All buttons at the bottom.

The Apply Data function works in this way throughout the Editor, allowing data from one country to be applied to others.

### 2.4.11. CAMPAIGN → EDIT COUNTRY DATA → EDIT RESEARCH

You can set the research values for each individual Major country for each research type. Select a Major on the left whose research values and costs you wish to view and/or edit.

The Current Research level, Maximum Research level, current Chits Assigned, and Maximum Chits Assignable may be set from 0 to 5. The cost of
each research chit can be set from 0 to 1000 MPPs in increments of 5 MPPs for each category. The Maximum Research MPP investment is set at the bottom of the screen, and it can be set from 0 to 10,000 MPPs.

The cost of research chits already invested is automatically shown in the Current Research MPP field to the right of the Maximum Research MPP field, and this updates itself if more are invested.

If your campaign has the setting in place for research chits to remain invested in an area after technology advances are achieved*, you may wish to increase the research cost per chit invested.

*This is effected by unticking the Consumable Research Chits button by going to Campaign → Edit Campaign Data → Advanced. If ticked then one research chit is consumed whenever a research advance is achieved.

The Apply Data button works in exactly the same way as it does for Combat Target Values (see above) allowing you to transfer the settings from one country to others.

**Tip!** By setting Max Level values at 0 you can effectively block research in particular areas, while by setting the Maximum Research at 0 MPP for a Major you can effectively prevent it from performing any research. And if you would rather there was no research at all in your campaign, go to Campaign → Edit Campaign Data → Advanced and untick the Research button under Preferences in the bottom left.

2.4.11.1. Advanced Research Options

By clicking on the Advanced tab in the bottom right, it is possible to fine tune the increments that each level of research will provide. This provides a large amount of flexibility so that different countries can have different abilities. For example, each country's increment per research level attained in Production Technology may be set from 5 to 100%, and for Industrial Technology from 5 to 100%.

The option to set Research Progression (Per Chit) only applies to Majors, so do not change any while you have a Minor country selected as doing so will not affect anything in game.

Minors' armed forces can be set to be Upgradeable by selecting the Minor on the left hand side and ensuring that the Minors button in the top middle
is ticked. They will then be able to upgrade in line with the research success of their Parent Major and their own upgrade limits. The cost of upgrading relative to the cost of upgrading its Parent Major is set using the Relative Cost (%) button.

In the top right is a box entitled Research Sharing (Increases Catch Up Bonus). This is where you can set the ability for fully mobilized Major countries to share research. If you select a Major then the drop down box will display all the friendly Majors that this Major could potentially share research with.

If the box is ticked then it will share research with that country. Sharing can be set to work one way, or both. For it to work both ways, e.g. between the UK and France, then both countries will have to have each others’ box ticked.

Moving to the central area of the Advanced tab, General Research Increments can be set here as follows:

- **Subs** – here you can set the Initial Dive % chance of a Submarine with no upgrades to dive. The Dive Increments are the increase in chance of the Submarine diving when it is attacked, with every upgrade of Buoyancy Tanks that it receives.

- **Anti-Submarine Warfare** – The % set here will be subtracted from the Submarine’s % chance of diving, so its effect will be to reduce the chance of the Submarine diving. It is generally recommended to have Initial ASW set at zero. ASW Increments represent the increase per level of Anti-Submarine Warfare research that will be deducted from enemy Submarines’ chances of diving when they are attacked.

- **Note:** ASW has been set to zero in the default campaigns, and we strongly recommend you do the same if designing a campaign set in the Civil War era. In this game, ASW is tied to the technology slot filled by Fort Modernization, which will need to be replaced if you wish to include ASW in a custom campaign.

- **Resource Bombardment** – here you can set the % chance that a unit that targets resources (e.g. Monitors) can also hit a unit that might be occupying the resource. This % can be increased through upgrading the unit’s primary attack research category, e.g. Naval Weapons.
- **Increments %** – here you can fine tune the % increases that Majors will benefit from by researching these four categories. These refer to the:
  - % bonus to your research that can be gained from Spying & Intelligence, or the decrease in your opponent’s bonus.
  - The decrease in costs gained by Logistics research.
  - The decrease in unit production and reinforcement costs from Production Technology.
  - The increase in home country economic production from Industrial Technology research.

- **Accuracy Loss Beyond Base Range (Per Hex)** – this enables you to make Artillery firing at longer ranges lose effectiveness the further away the target is. This can be useful if research upgrades will increase Artillery ranges, as it may not be desirable for them to have the same potency at (say) a range of 4 hexes that they have at a range of 1 hex.

**Note:** If you change the benefits that any category provides, it will be best to update the Research Tool-tips too for your campaign. To do this, open up the game’s official localization.txt file which can be found within the main installation folder.

Search for `#GAME_RESEARCH_MENU_TEXT` and copy the relevant lines that will need to be changed to your own campaign’s localization.txt file, and amend the details within your file. See *Customize your Campaign* for further details.

**2.4.11.2. Upgrade Data (Per Research Level)**

When in the **Advanced** tab for **Research**, click on the **Upgrades** button in the bottom right. Here you can fine tune specific research categories, costs and the maximum number of levels that each unit type can gain from research. These can be set independently for each Major, and their respective Minors will automatically have the same settings.

Each unit type can be assigned up to 3 research categories. If you have 3 set and wish to remove or change one, tick the **Disabled?** box relevant to the category. This will remove that one, and if you desire you can then click the
tickbox next to the one you want to add from the list below, then tick the Select as replacement box.
You can also re-order the categories as needed by using the Up/Down buttons in the top right.

Important: Resources can only be upgraded with Lighthouses, and with the other unit types, be careful not to apply research categories that really don’t apply to them. For instance, giving an infantry unit the ability to upgrade with Naval Weapons is not likely to help that unit, because changing research categories will not change the fundamental nature of the unit being upgraded.

2.4.11.3. UPGRADE INCREMENTS
To change the specific benefits units receive from upgrades, click on the Upgrade Increments button at the bottom of the screen. Select the country, unit type and upgrade category you wish to amend. You can set the exact increment amounts per category, unit type and country. There are limits, e.g. Attack and Defense values can only increment by a maximum of 10 per level, spotting ranges and Action Points by 25.

Tip! Restore Defaults and Apply Data work in this area too, and the latter may be especially useful here. Click OK when done.

2.4.11.4. AUTOMATIC INCREMENTS
To change the benefits Majors receive from Automatic Upgrades, click on the Automatic Increments button in the bottom right of the Advanced tab. Here you can select the specific upgrade types by country and unit type, as well as setting the increments per level. The customization this allows is very wide-ranging, so take care that too many upgrades won’t combine to inadvertently turn a unit into a really powerful super-unit!

Note: Increases in unit Build Limits from Automatic Research will not show in the Editor, but they will show in the game itself.

2.4.12. CAMPAIGN → EDIT COUNTRY DATA → EDIT DIPLOMACY
Customizing the diplomatic options for a campaign can be accomplished from the Edit Country Data dialog and selecting the Edit Diplomacy option.
Set the maximum number of diplomacy chits between 0 and 100 for each individual Major country.

Set Influence costs from 0 and 1000 MPPs for four different types of diplomatic action:

- Friendly Minor
- Enemy/Neutral Minor
- Friendly Major
- Enemy Major

The Influence % Per Chit is the chance every turn of achieving a diplomatic success, according to the number of chits invested. This can be set from 0 to 100.

The Effect Range % is where you can set the % increase in Mobilization achieved by a diplomatic success. The left hand number sets the minimum increase in Mobilization, and the right the maximum.

The Minor Influence Bonus % (Per Hit) is the chance per diplomatic success that a Minor will receive an extra boost in its Mobilization % beyond the minimum and maximum set in the top row of the Effect Range % area. This chance of a bonus can also be set from 0 to 100.

**Example:** The default influence is 5% per chit with an effect range of 7-10%. If influence against a Minor is successful during a turn, the default Minor Bonus provides a 10% chance that the actual effect of the diplomatic breakthrough will be 27-40%, as the effect range of the bonus is set at 20-30%.

In the Diplomatic Status box you can set the initial number of assigned diplomatic chits for each individual country, as chosen from the Select Country list on the left. Up to the maximum investable limit for each Major can be invested against a country, providing that country doesn’t have a limit on the number of chits that can be invested in it. This can be set in the Diplomatic Chit Assignment Limit (If Applicable) area.

Bear in mind when setting the initial investments that the net % chance of a diplomatic success is the cumulative effect of all the chits invested against it by both sides.

Tick the Block Investment Towards This Country? Box if you wish to prevent a Major from conducting diplomacy against a selected country. This also prevents players from declaring war on that country.
Click on the **OK** button when done.

Just as with research, the option exists for diplomacy chits to remain invested in an area after a diplomatic breakthrough has been achieved, and if you do use this option, you may wish to increase the diplomacy cost per chit invested. To do this go to Campaign → Edit Campaign Data → Advanced and untick the Consumable Diplomacy Chits button.

**Note:** The maximum number of diplomacy chits cannot be less than the currently assigned chits. A warning message will prompt you to reduce assigned chits first.

### 2.4.13. Campaign → Edit Country Data → Edit Production Queue

Here you can select units by country and by type for arrival once the date specified has been reached.

Strength, experience and available research levels can be set for them all.

The Full Research option means that the unit will arrive fully upgraded with whatever applicable technologies have been researched by its production date. If Full Research is selected then it won’t be possible to set individual research levels if any are available at the start of the campaign.

Unit arrival dates can be set for any date, regardless of the Production Delay for that unit type. Whether or not the Production Delay option is selected, units in the Production Queue will arrive once the date specified has been reached. Note that in *American Civil War*, units can only deploy in cities, major cities or capitals by default, however if another resource (e.g. a town) is set here then that unit will still be able to deploy at the chosen location.

A Destination Resource can be set where the unit will deploy. If this Destination falls to the enemy then the unit will deploy at the next best resource.

If you want to edit something that is already in the Production Queue, click on the unit and you can edit its arrival destination, strength, research etc. If any features are grayed out then they cannot be edited.

Click on ‘Add/Edit’ at the bottom of the screen when done, and it will add/update the item on the Production Queue to have the new settings.
**Note:** All new units will deploy with a supply value of 10, though during the end turn sequence the supply of land and air units will then be adjusted according to their proximity to supply sources.

### 2.4.14. Campaign → Edit Country Data → Edit Strength/Reinforce/Reformation Data

In this area you can set a number of unit specific qualities on a country by country basis.

Select the country and unit type you would like to edit. You can amend its Maximum Strength, with values between 1 and 10 being allowed.

Reinforcement and Elite Reinforcement costs can be set as a % of the unit’s base cost in MPPs (i.e. before any research upgrades are added) per strength point they receive as reinforcements. The cost of Elite Reinforcements should generally be set at least as high, if not higher than normal Reinforcements as they represent the incorporation of good quality troops within the unit.

The Reformation area signifies whether or not the unit can be rebuilt if it is destroyed. If the button is ticked, then it can be rebuilt but only if it was destroyed when it had a Minimum Supply value that was at least as high as the number set in the Min Supply box.

The cost to rebuild the unit after its destruction is the % Reformation Cost, as a % of the unit’s base cost in MPPs. The % Reformation Delay dictates the time it will take from paying the MPPs for its reformation and it arriving for deployment, as a % of the time it would take to create a new unit of this type.

### 2.4.15. Campaign → Edit Country Data → Edit Resource Data

Here you can set the economic value of all resources by country, from 0 to 10 MPPs per strength point for every resource type. MPP values per strength point can be set to include quarters, e.g. 0.25, 0.50 and 0.75 as well as whole numbers.

Note that changing the MPP resource value for a City will affect the economic penalties from Convoy raiding as described in Chapter 6 on Movement and Combat.
The Fighting Spirit (FS) value of resources can be set here too, with the value set being the FS points that a Major will gain every turn that it occupies a resource of this type belonging to an active Major. This value automatically equals the per turn penalty that the active Major that has lost the resource suffers. The FS value of these resources can be set on a country by country basis.

The % damage that a resource will suffer from Scorched Earth when it changes hands is also set here. Minimum and maximum values can be set so that there is variability in the damage suffered by resources when they are captured or liberated.

2.4.16. Campaign → Edit Major Country IDs Data
There can be a maximum of 10 Majors in your campaign, and you can select these from any of the countries in the Country List on the left hand side.

To make a country a Major, providing the limit of 10 hasn’t already been reached, select it on the left hand side and click on the >> button.

Click on Set Display Source on the right to select which set of Bitmaps it will use in the campaign. This may save any Bitmaps having to be amended if they can use those belonging to a pre-existing default set. For instance if you want two Majors to use the same unit sprites in game, then by assigning the same Bitmap source they will do so.

Each Major is given an Index number, starting at 1. Use the Up and Down buttons to put the Majors in order, with all Confederate Majors followed by all the Union ones.

Index 1 is automatically the first Confederate Major in the First Confederate Major ID Index. Set the First Union Major ID Index button to the first Union Major.

Important: It is crucial that all Confederate Majors are listed before any Union ones.

You can remove any countries from being Majors by selecting them in the Major Country IDs list and clicking on the << button to remove them.

Click on the OK button when done.

2.4.17. Campaign → Edit Weather Data
Here you can edit Weather Data and set Weather Zone values.
Each area of the map requires a Weather Zone according to its climate, so to add a new Weather Zone, the first thing to do is to click on Set Climate and choose between Temperate, Frozen, Semi-Arid and Arid. Now give your Weather Zone a name, e.g. Florida.

In the Primary and Secondary Seasonal Effects (Land), and the Seasonal Effects (Sea) boxes, you can set the % chance per turn of the weather being of a certain type, in accordance with the season.

For example, it could have a 60% chance of being clear in a winter turn, 10% of being Mud and 30% of being Frozen. A Weather Zone can include both land and sea effects, as it can cover as wide an area as appropriate.

Once you’ve named your Weather Zone and set its effects, click Add at the bottom left. The new Weather Zone will appear in the Zone List on the right.

To edit a Weather Zone, select it from the Zone List, make any desired change, and then click Edit/Update to save your changes.

To delete a Weather Zone, select it from the Zone List on the right and click Remove at the bottom.

To close the Weather Zone Data dialog, click OK.

The cumulative trigger percentages for effects cannot exceed 100% for each season. The default seasonal effect is Clear or Calm if less than 100% is entered for the trigger values. Even so, it is recommended to ensure that the Trigger % for all items within each category add up to 100 as a way of checking that the settings are as intended.

In addition to the four normal seasons, four separate sub-seasons are provided for Late Spring (May 1 to June 20), Early Fall (September 21 to October 14), Late Fall (December 1 to December 20), and Late Winter (March 1 to March 20). These don’t need to be filled in, but if they are then their Trigger % will apply for the periods in question. If they aren’t filled in then the Trigger % for the main seasons will apply during these periods.

2.4.18. CAMPAIGN → EDIT WEATHER DATA → ADVANCED

The Advanced Weather Data screen can be used to advise the game engine which Weather Zones border each other. If this is done then it will make for smoother transitions between different Weather Zones.
For example, if a Weather Zone has a temperate climate and currently has snow, for any adjacent temperate zones where mud is possible its weather will be set to mud, whereas otherwise the latter might have been clear.

2.4.19. CAMPAIGN → EDIT TURN/ECONOMIC DATA

In this area, the Turn Length can be set to be Seasonal, Daily or Numbered.

Seasonal turn lengths are set by default to one week in Summer, two weeks in Spring and Fall, and four weeks in Winter, but these can be adjusted.

Daily turn lengths can be set between 1 and 365 days.

Numbered turns are for campaigns where the date will not change, and instead the campaign will last for as many turns as are listed here, unless any Victory Conditions are achieved prior to then.

Select Turns to be Alternate or Simultaneous. Alternate turns advance the date on each side’s turn, while Simultaneous turns use the same date for both sides’ turns.

Under MPP Collection, if you tick the None box then resources will not provide any income to either side.

Ticking Normalized will equalize production capability over the course of the year if the campaign is set to have seasonal variations in turn lengths. This isn’t used in the default campaigns that come with the game but it can be used with campaigns using seasonal turns to increase production in winter turns and decrease it in summer turns. MPP collection would then be adjusted for Normalized production. All income from resources, including from Convoys are then adjusted to determine the final total of MPPs. Note that income or expenditure due to Decision Events will not be affected by selecting this option.

Caution: A simple change from Alternate to Simultaneous turns will essentially double the number of turns each year, doubling economic production in the process. Beware that this would significantly change a campaign unless costs are increased or resource values are decreased accordingly.

2.4.20. CAMPAIGN → EDIT DEFENSE BONUS DATA

Here you can set or amend the bonuses that defending units receive from the terrain and resources that they are in. The higher the value, the harder it will be for the attacking unit to defeat the defending unit.
Each terrain/resource type can have different Defense Bonuses set according to all the different attacking unit types, ranging from -1 to 8. The negative defense bonus means that land units occupying that hex type have their attack values halved, so in effect it becomes a Defense Bonus for the unit not in this terrain type when it is attacked by a unit that is in this terrain type.

Terrain and resource data are generic and apply to all unit types for all countries.

Note: The Resource map layer takes precedence over the Terrain map layer for a hex’s Defense Bonus. So a City on a Mountain will only get the Defense Bonus for a City, not for a Mountain or for a Mountain plus a City.

2.4.21. Campaign → Edit Movement Cost Data

In the left side of this area, entitled Set Movement Costs, you can set additional movement costs for each terrain type. These additional costs can be from 0 to 8 Action Points, or they can be set as impassable by using the downwards scroll arrow. You can also set additional movement cost penalties for crossing enemy rivers. Movement costs are generic and apply to all unit types for all countries.

Clear hexes default to costing 1 Action Point to move into or out of, so they aren’t included in the editable list. For Terrain types that you would like to cost no more than clear hexes, set their extra cost values to zero. Otherwise a positive value signifies the additional Action Point cost of entering or leaving this hex type.

These editable movement costs start at River and end at Storms, two thirds of the way down the second column. The remainder of the categories in the second column represent MPP costs as a proportion of a unit’s Purchase cost for operating or transporting the unit. Note that operating air units costs double that of land units.

The three Fixed Cost categories at the bottom are set MPP costs that will be charged for carrying out any of these activities. If MPP costs are set here, as well as in the % costs sections above them, then both will be charged. So you can set either or both to apply, in accordance with the following formula:

Total Cost = Unit Cost * % Cost + Fixed Cost

The Action Points Multiplier for Forced March and Naval Cruise can be edited in the bottom left hand corner.
2.4.22. 1. Editing Zone of Control Effects

On the right we have an editable list where units can be set as Front Line, Support, or exerting No Zone of Control. You can also edit the exact parameters of Front Line and Support units to determine the Action Point penalty for enemy units coming within their Zone of Control, and the number of units required to be adjacent to these enemy units for the Zone of Control to have any effect.

Examples:

- If Front Line units impose a penalty of 1, and 1 unit is required to effect the penalty, then the presence of any front line units will impose that penalty.
- If Front Line units impose a penalty of 1, and 2 units are required to effect the penalty, then the presence of 2 or more front line units will impose that penalty.
- If Front Line units impose a penalty of 1, and 2 units are required to effect the penalty, while 4 Second Line units are required to exert the same penalty, then:
  - 1 Front Line unit will not impose the penalty.
  - 1-3 Second Line units will not impose the penalty.
  - But 2 Front Line, or 1 Front Line and 3 Second Line units will impose the penalty.

2.4.23. Campaign → Edit Combat Data

In this section the following things can be edited:

- Experience Point Allotment from combat.
- Max Unit Experience.
- Combat Losses (essentially the die rolls that modify combat results).
- Naval Supply Losses from combat.
- The Penalties for attacking across watercourses.
- The % chance of Amphibious units suffering casualties on landing.
- The chance of units retreating when attacked, according to the position they occupy.
- The distance retreating units can potentially retreat.
All of these things can be edited for each unit type, so that for instance, experience gains for artillery can be different to those for infantry and tank units, or cavalry units can be set to retreat more hexes than infantry.

2.4.24. CAMPAIGN → EDIT NAVAL DAMAGE DATA
This section is where you can amend the % chance of all types of naval unit receiving some sort of damage when there are storms at sea. The damage can either be in strength point losses, unit morale losses, or both.

As the minimum and maximum Strength and/or Morale Losses can be set to zero, this allows for full customization, whereby some unit types could be made invulnerable to storms, while other types can be set to suffer.

2.4.25. CAMPAIGN → EDIT MORALE DATA
Here the morale penalties and bonuses that units receive in the following situations can be edited:

- When a friendly country is liberated, with separate editable entries for land and naval units (air units as classed as land units).
- When a friendly country surrenders, with separate editable entries for land and naval units (air units as classed as land units).
- The unit morale penalty for Operating (Rail Moving) a unit.
- The unit morale penalty for using Forced March.
- The unit morale penalty for swapping units.
- The initial unit morale of new units.

2.4.26. CAMPAIGN → EDIT PENALTIES/ BONUSES DATA
Here you can set combat penalties and bonuses that units will receive simply by being in a certain terrain or resource type.

For example, Partisans can be set to have increased defensive bonuses if they are occupying Mountains or Forests. Conversely, Cavalry units could be set to have lower defensive abilities if they are defending an urban area against attacks by Soft or Infantry target types.

Tip! There are innumerable options here, but be careful to ensure that players will understand them, otherwise confusion could arise.
2.4.27. **Campaign → Edit AI Scripts**
See Chapter 3: Scripts, the AI and General Advice

2.4.28. **Campaign → Edit Event Scripts**
See Chapter 3: Scripts, the AI and General Advice

2.4.29. **Campaign → Replicating Layers**
The following four functions copy the layer in question to the new one.

- Replicate Road Layer To Rail Layer
- Replicate Rail Layer To Road Layer
- Replicate Resource Names To Text Layer
- Replicate Text Layer To Resource Names

The aim of this is to save you time in designing a map, so that you can for instance, just draw the rail network, replicate it to the Road Layer, and then all you need to do is adjust the Road Layer if you don’t want it to be an identical copy of the Rail Layer.

The Replicate Resource Names To Text Layer function will not overwrite any pre-existing Text Layer entries.

In contrast, the Replicate Text Layer To Resource Names function will overwrite pre-existing Resource names, so if you update the Text Layer and then want to update the Resource Layer with the new name at the Resource location it will do so.

2.5. **Go To → Select Map Position**
Input the co-ordinates of where you would like to be taken to on the map, and click OK.

2.6. **View**
2.6.1. **View → Mini-Map**
Toggle the mini-map on/off. Clicking on the mini-map is a very useful way of moving quickly to a different location on the map.
2.6.2. **View → Text**
This turns the Text Layer On/Off.

Turning the Text Layer off enables you to see the map in its natural state, which can be useful when trying to fine tune the position of an element, or checking that something is as aesthetically pleasing as possible.

Note that if the Text Layer is on, the text will temporarily disappear when you scroll the map.

2.6.3. **View → Sprite Indexes**
Every image sprite relating to the graphics used in the Editor has a sprite index number. You can turn these on for the current Layer you have selected by clicking on View → Sprite Indexes. This can be very useful as an aid in fine tuning your design.

2.6.4. **View → Grid**
Toggle the hex style grid on/off.

2.6.5. **View → Borders**
Toggle national borders on/off.

2.6.6. **View → All Layers**
Toggle all map layers on/off.

With this set to off, the map only displays the layers defined by the current edit mode. This action is dependent on the hierarchy of the map layer selected. For example, the Edit Terrain Layer Mode will only display the hex, river and terrain layers, but no Resources, units or weather.

Selecting the Resource layer and then using this function to turn off other layers is very useful, as it will show the map pretty much how it will appear in the game without any units showing.

2.6.7. **View → National Colors**
You can toggle national colors on/off. This is useful for checking the look of the map as some players may play with National Colors on, while others might
turn them off, and ensuring the map looks as good as possible in both styles is useful.

### 2.6.8. View → Double Selection Columns

Here you can turn Double Selection Columns on/off. This is a very useful tool when editing as it doubles the options showing on the screen of the currently selected layer.

**Tip!** Right clicking on the map while in Draw Mode will take you to the currently selected sprite of the currently selected layer, in the right hand column of sprites.

### 2.7. Preferences

**Border Style** – Select White, Orange or Black for national borders.

**Unit Style** – Select 3-D or NATO counter styles.

**Unit Counter Style** – This only applies when 3-D units are shown, and is a simple on/off toggle.

**Unit Research Level Style** – Switch between the two ways of showing unit upgrades, either as incremental icons or as numbers.

### 2.8. Language

**Interface Text** – Choose between English and Spanish.

### 2.9. Mods

Here you can select and de-select any installed Mods.

### 2.10. Help

Pressing **Help Topics...** opens an online Help file.

### 2.11. Menu Buttons - Second Row

Many of these are shortcuts to items included in the first row, so for these their explanations can be found in the above section.

They are listed in order, starting from the left, as follows:
- New
- Open Default Campaign
- Open User Campaign
- Save
- Undo
- Redo
- Lock Scroll
- Unlock Scroll
- Draw
- Select Item(s)
- Remove Item(s)
- Edit Hex Layer
- Edit Terrain Layer
- Edit River Layer
- Edit Road Layer
- Edit Rail Layer
- Edit Resource Layer
- Edit Symbol Layer
- Edit Text Layer
- Edit Unit Layer
- Edit Weather Layer
- View Mini-Map
- Toggle Text
- Toggle Sprite Indexes on Map
- Toggle Grid
- Toggle Borders
- View All Layers
- View National Colors
- View Double Selection Columns

2.11.1. ZOOM IN/OUT

The two buttons on the extreme top right are zoom functions that can be useful to see how your design looks on a grander scale, and then you can zoom back in to see things at their normal level.
3. SCRIPTS, THE AI & GENERAL ADVICE

3.1. EDITING EVENT SCRIPTS

To edit Event scripts, select Campaign and then Edit Event Scripts from the Main Menu bar.

Select the script to edit and then click Open/Edit. Your default text editor should open with the script file. Notepad, WordPad and Notepad++ which all support UTF-8 character encoding should work fine (the game supports Unicode (UTF-8) and over 650 languages for modding).

Each script file may contain multiple events, separated by a blank line.

After editing the script, save the text file and then go back to the Script window in the Editor. You will notice that the name of the script type you have edited now has an * next to it, and this is to show that the script needs to be updated in order to check that all the scripts in the file are correctly formatted.

3.1.1. UPDATING SCRIPTS

Click Update in the Script window. If the scripts are correctly formatted, after a little while (the time taken will depend on how many scripts there are) the update should complete. If it is successful, the * will disappear and each separate event name will appear in the Event List box as a reference for the selected script.

If there are any errors, the Editor should give you an error message as well as some detail including indication of the problem and the affected line number. To correct the error, go to the relevant line number in the text file, check and correct the issue, and then repeat the Update process. Keep repeating the process until the error asterisk no longer appears in the Script dialog.

There are two other Update buttons:

- Update All may be used to force a manual update of all scripts.
- Update * which should be used if you are confident that your script changes don’t include any formatting errors. This will update them but if any are incorrectly formatted it won’t highlight the specific location of the error.

It is not necessary to update every time you make a change, but you must do so before playing your campaign for these Event scripts to work properly. The Editor will also prompt you to update scripts as you make changes on the map, and the same advice applies: only update when necessary, i.e. before playing your campaign.

The event scripts for individual campaigns are saved in their Events sub-directory.

**Example:** The 1861 Blue and Gray campaign has a sub-directory named _1861 Blue and Gray. This is where the specific scripts for 1861 Blue and Gray are stored. These files may also be copied or edited directly with any text editor, though editing the originals will amend the default campaign.

### 3.1.2. Script Templates

The basic structures for each type of event script can be found in the game’s Templates folder (do not amend the contents of this file). When you save a new campaign, it will save with these script templates in its new folder. If you open an existing campaign and click on File → Save As, then the scripts from the campaign you have open will be saved into your new campaign’s folder.

### 3.1.3. Script Flags

Scripts can be turned on or off using the #FLAG command line. If you want the event to be active in the campaign then set #FLAG= 1, otherwise set it to be #FLAG= 0. This can be useful in testing, or for leaving optional scripts in a campaign that players can turn on or off as they desire in the game’s options.

### 3.1.4. Failsafe Dates

These are present for use in some script types, e.g. Unit, Belligerence and Resource. The way they work is that if all other conditions required for the
event have been reached apart from the Trigger %, then once the Failsafe Date is reached then the event will fire if it didn’t fire before. If you don’t want the event to fire unless the Trigger % is reached, then set the Failsafe Date to be beyond the campaign’s end date.

3.1.5. CONDITION POSITIONS
If you don’t want a Condition Position to be involved in the trigger for a script, then set it as follows:

dummy condition position (always satisfied)
#CONDITION_POSITION= 0,0 [0,0] [0,0] [0] [0]

Script Types
A general description of the different types of events found in the game is provided below.

3.1.6. CONVOY
This event transfers MPPs from a source Port in an owner country to a destination Port in a recipient country. The owner and recipient countries must have similar leanings (i.e. they must both be pro-Union or pro-Confederate).

In addition, both source and destination Ports must have a strength level of at least 5 in order to have a fully functioning Convoy. If the owner is a Minor, then the recipient must be its parent Major. The trigger values for both countries are related to their Mobilization Value. A percentage value establishes the amount of MPPs transferable via Convoy, subject to possible seasonal reductions and Convoy raiding.

Multiple scripts may be set for the same #SENDER_ID= and/or #RECIPIENT_ID= to allow for several Convoys between countries. However, there can only be one active Convoy at a time from each country. Should a destination Port no longer be available due to enemy occupation or having a strength level less than 5, then the engine will search for an alternative Convoy script that it can use.

Convoy routes can be defined by setting Waypoints. Convoys start at a Source Port, pass through each Waypoint in the order specified, and end at a Destination Port. A path of valid Sea or Land/Sea hexes between Waypoints
is required. The game code will calculate the most direct path between Waypoints, and the Convoy will be marked with arrows to show its direction.

Waypoints can be set to include hexes on the edge of the map, with the next Waypoint being a sea hex also on the edge. This enables a convoy to “sail” beyond the edge of the map for a portion of its journey, e.g. sailing around Africa from the Atlantic to the Red Sea, where only Northern Africa is represented on the map. When doing so, Waypoints along the bottom most hexes need to be set to an “odd” x position in order to function properly.

If the Convoy route passes through a friendly Port while en route to its destination, and the Port is either damaged to below strength 5 or captured, then the Convoy will be disrupted.

For Convoys between Major powers, players have the option to decide how much will be transferred each turn. The transfer amount remains locked in until changed by the player via the Convoy Map, where an up and down arrow for the selected Convoy can be used to adjust the transfer value.

### 3.1.7. RESOURCE
This event is used to mobilize resources. Resource positions included in these scripts will be inactive at the start of the campaign, with supply and MPP values of zero. Only when the Resource script’s trigger condition is satisfied will they commence production, with their strength values and MPP values relative to their strength, rising by 1 point per turn.

### 3.1.8. SUPPLY
This event causes resource positions to suffer strength reductions. Among other potential triggers, supply events can be set to be seasonal.

### 3.1.9. STRENGTH
This event can be used to generate Strength and Morale losses for units within a specified range. For example, this event can be used to simulate the effect of yellow fever epidemics on American forces in the Caribbean, or due to large scale desertions.
### 3.1.10. Unit

This event causes new units to appear in destination resource positions, either in response to a Decision or when a trigger condition is satisfied. Note that the new units will arrive with either no research if `#FULL_RESEARCH=0`, or their current maximum research levels already applied if `#FULL_RESEARCH=1`.

Unit scripts set to fire when a country reaches 100% Mobilization will immediately deploy if the relevant country is declared war upon and all other triggers are met.

There is a Private setting that can be used to make it so that only the owner’s side will see any mention of a unit deploying. This is to avoid giving the enemy information that they shouldn’t have.

Defenses are the only unit type that can be set to arrive at any friendly hex. All others have to arrive at friendly Resources. Note that units can be set to deploy at ANY resource via script, not just cities or capitals as is the case when they are purchased.

Multiple `#DESTINATION_POSITION=` are supported, simply add further ones beneath so that they will be alternatives if the first one isn’t available when the units are due to deploy.

All units need to be able to be placed at a desired `#DESTINATION_POSITION` and if not the engine will move on to the next one on the list, if there is one. If they all fail, i.e. not all units can be placed at at least one of the `#DESTINATION_POSITION=`, then the event fails.

### 3.1.11. Free Unit

This event will allow Land and Air units of a surrendering country to continue fighting when their own country surrenders, providing they are outside their own borders and in territory controlled by a friendly power. Naval units of the surrendering country may become free wherever they are.

Free units will now be controlled by the receiving country, who is responsible for their reinforcements and upgrades.
3.1.12. PARTISAN

This event triggers partisan activity at specified map locations. These locations can be either resources, including Mine and Oil hexes, or terrain elements. Partisans cannot trigger in clear hexes.

Partisan activity can either be simply disruptive, whereby resources receive strength losses due to their activity, or actual Partisan units can appear on the map.

The field #ADD_UNIT= can accept the following values:

(values range [0, 2]; False= 0; True= 1; True (if <= build limit)= 2)

If True= 0 then no unit will be deployed, if True = 1 then a unit will deploy, and if True= 2 then a unit will only deploy if the Partisan Build Limit has not already been reached. This means that you can prevent excessive Partisan units being deployed if you feel that such a circumstance could arise.

3.1.13. TERRITORY

This event causes territory to be transferred from one country to another when triggered, and it can also be used to have new states appear on the map.

The first #MAP_POSITION= will be chosen as the new Capital if this is used to form a new state.

The #REMOVE field allows you to specify if you would like to remove enemy units from within the territory when the event fires.

If the #COUNTRY_ID and #RECIPIENT_ID are the same, TERRITORY scripts can be used to move a nation’s capital (for example, the Confederacy moving its capital from Montgomery AL to Richmond VA). To do this, the first #MAP_POSITION should be the location of the new capital, and the second #MAP_POSITION the current capital. Note that this will set the old capital to be an alternate capital.

3.1.14. ANNEXATION

This event causes a whole country’s territory to be annexed by another. The annexed country will not produce any partisans to fight the country that annexes them. The annexed country’s former Capital will be transformed into a Primary Supply Center for its new owner, while Primary Supply Centers and Industrial Centers will retain their former status.
3.1.15. SURRENDER #1
This event causes a country’s territory to be transferred to another country when the country losing the territory surrenders.

The transfer of territory may be to a newly created country with a new Capital, or to the conquering country. This is different than a normal surrender where the conquering country merely occupies the conquered territory, which can potentially be liberated at a later date. This event makes the territory an inherent part of the country that receives it.

This script type can also be used to transfer territory to the surrendering country itself, and the use of this feature would be to form an active “Government in exile”, e.g. the British transferring their Capital to Canada in WWII.

3.1.16. SURRENDER #2
This event can be used to force the surrender of a given country on a specified date. An example would be the ability to simulate the defeat of the Apaches in the Battle of the Apache Pass, to make way for the California Column’s arrival in New Mexico.

3.1.17. WAR ENTRY
This event allows a neutral country to fully mobilize and enter the war when a specific trigger condition is satisfied.

3.1.18. MOBILIZATION #1
This event allows Declarations of War to trigger neutral countries to have their Mobilization Values moved towards either the Union or Confederates.

3.1.19. MOBILIZATION #2
This event allows a neutral country to have its Mobilization Value moved towards either the Union or Confederates when a specified condition is satisfied. This Mobilization script type is ideally suited for mobilizing countries in response to the presence, or absence, of units in a given location, or within a specified range of a given location.
3.1.20. MOBILIZATION #3
This event allows a neutral country to have its Mobilization Value moved towards either the Union or Confederates, either on a set date, when certain political conditions have been met, or in response to a Decision Event.

3.1.21. MOBILIZATION #4
This event allows penalties or bonuses to be applied to countries when Declarations of War are made. Essentially, the purpose of this script is to punish ahistoric declarations of war, and it can be used to directly punish or boost a Major’s Fighting Spirit, or to trigger events in the same way that Decision Events do.

If the #DECISION field has been completed, i.e. with a Decision Number, then providing the #COUNTRY_ID= is a fully mobilized country when the Declaration of War is made, any Events that are set to be triggered by the Decision Number can now fire.

3.1.22. BELLIGERENCE
This event is used to set countries at war with each other in certain circumstances, such as ensuring the UK and Union are at war after the British recognize the Confederacy.

3.1.23. LOOP
This event allows a country’s units to move off-map between start and finish positions with a specified number of turns to delay completion of the Loop. If the Loop fails due to the presence of enemy units at the finish positions, then units will be returned to their start positions. The Loop script will only initiate on a moving unit’s turn. Units in a Loop will be lost if the parent country surrenders.

- If COUNTRY_ID = 0 then all countries of the completed ALIGNMENT_ID can use the LOOP, i.e. either all Union or all Confederate countries can use this LOOP.
- If COUNTRY_ID = 0 and ALIGNMENT_ID = 0 [i.e. Neutral] then any unit can use the LOOP, i.e. Neutral, Union or Confederate.
- If COUNTRY_ID is not equal to 0, then only that country can use the LOOP, and only if that COUNTRY_ID has the matching alignment value as specified in ALIGNMENT_ID.

Use the Symbol Layer to place a suitable symbol on the map to indicate where Loops start and finish. These do not have any other effect on play, they are just there to inform players of the hexes where a Loop starts.

You should also use the Text Layer to add a brief description on the map of all Loops’ destination and its Delay value, so that players know how long their units will be off-map when using Loops.

It is best practice to ensure that every Loop has at least 2 finish locations, unless it is inappropriate in a specific case for there to be more than one.

- If there is a #FRIENDLY_POSITION= specified (no matter what position) then the arrival land hex must be friendly controlled.
- If there is no #FRIENDLY_POSITION= specified, then units using Loops will be able to arrive and take control of the destination hexes, even if they are under enemy control.

Note: Starting hexes at sea are not defined as part of any Weather Zone, to prevent weather effects from interfering with movements.

3.1.24. VICTORY

This event defines Union and Confederate Victory Conditions based on the control of map positions, as well as any that might be triggered by Decision Events. For instance, Decision Events can be used for negotiations to see if one side has the will to continue the fight, triggering a relevant Victory Condition if it hasn’t.

3.1.25. POPUP

This event displays a text message based on specific trigger conditions or on or after a specified date. The message is for information only and has no effect on game play.

The #MESSAGE= field can support the following special characters:
- %N = newline or carriage return
- %T = horizontal tab
- %R = right align text, must be applied at the beginning of a newline, otherwise ignored
- %C = center align text, must be applied at the beginning of a newline, otherwise ignored
- %B = bold text, must be applied for each word you wish to bold
- %V = italic text, must be applied for each word you wish to italicize

Multiple #ALIGNMENT_POSITION= can be set, or this field can be left empty if it isn’t applicable.

There is a Private setting that can be used to make it so that only the event owner’s side will be aware of a message.

Popup Scripts can also be used to display symbols from the Symbol Layer on the map, if certain conditions are met, for instance the colored hexes used to signify Loop locations that can only be used by one side in 1861 Blue and Gray. This can be done by setting #DISPLAY_STYLE= 2.xx where x is the number of the image in the Symbol layer. As an example, #DISPLAY_STYLE= 2.7 would display the 7th image in the Symbol layer.

When this function is used, the #POPUP text will be shown as an on-screen popup (similar to those seen over convoy lines), when you mouse over the hexes indicated by #MAP_POSITION in your script.

**Viewing PopUp Events in the Editor**

Once you’ve added or amended any PopUp Events, providing you Update the script you can then see these scripts as they would appear in the game by selecting PopUp and clicking on the View Button that appears in the bottom right of the screen where you Update the scripts (Campaign → Edit Event Scripts).

If you edit any PopUp scripts while you are viewing them, when you left click on the viewing panel it will refresh to show you the latest version of the relevant script.

Any on-map Symbols associated with Popup scripts will automatically display on the map in the Editor upon Updating the script. If multiple such
scripts are used to display symbols on a single hex, only the one associated with the latest script in the Popup script file will be visible.

### 3.1.26. Fighting Spirit

This event is used to add or subtract Fighting Spirit points when triggered. Multiple #ALIGNMENT_POSITION= can be set, or this field can be left empty if it isn't applicable.

### 3.1.27. Decision

This event provides the player with a choice, the consequences of which can be used to trigger other scripts.

The details of the Decision should be spelled out in the #MESSAGE field, though to avoid having too much text in that area, some details can also be put in the #NOTES field.

You can select coordinates on the map by filling in the #NOTES_POSITION= field. When a player is presented with the Decision and they click on the 'View Map' button, they will then be taken to the location designated in that field. This allows players to view the location most relevant to that Decision. This field can be left empty if there isn't a specific location relevant to the Decision.

Decision Events that do not contain a #MESSAGE entry are treated as an automatic 'YES' decision selection. This can be useful in campaign design as a trigger for events when it would be inappropriate to offer players an actual decision. They can also be used to either add or deduct MPPs from a country, e.g. to represent a temporary increase or decrease in the military budget.

To assist with the fine tuning of Decision Events, multiple #ALIGNMENT_POSITION= can be set, or this field can be left empty if it isn't applicable.

With the #TYPE= field, the engine works through events in the following sequence:

- The Decision Event fires
- The engine works through all events looking for scripts to be triggered by this Decision Event.
- The engine fires the next DECISION event in the list of events whose trigger has been met.
When this process has been completed, any Decisions that were TYPE=2 will be reset to a null state, waiting to be triggered again on each and every subsequent turn when their conditions are met.

The #MESSAGE= field can support the following special characters:

- %N = newline or carriage return
- %T = horizontal tab
- %R = right align text, must be applied at the beginning of a newline, otherwise ignored
- %C = center align text, must be applied at the beginning of a newline, otherwise ignored
- %B = bold text, must be applied for each word you wish to bold
- %V = italic text, must be applied for each word you wish to italicize

Viewing Decision Events in the Editor

Once you’ve added or amended any Decision Events, providing you Update the script you can then see these scripts as they would appear in the game by selecting Decision and clicking on the View Button that appears in the bottom right of the screen where you Update the scripts (Campaign → Edit Event Scripts).

If you edit any Decision scripts while you are viewing them, when you left click on the viewing panel it will refresh to show you the latest version of the relevant script.

3.2. Editing Artificial Intelligence Scripts

To edit Artificial Intelligence (AI) scripts for the computer opponent, select Campaign and then Edit AI Scripts from the Main Menu bar. This will allow you to edit all of the AI’s specific script types.

As with editing Event scripts, select the AI script to edit and then click Open/Edit. If you open them, each one has a small write-up about what they do and how to use them.

After editing the script, save the text file and update the script(s) like you would with Event files.
The default AI script templates are located in the game’s Templates\AI directory. The AI scripts for individual campaigns are saved in the Scripts\AI sub-directory created for each campaign in the Campaigns directory.

A general description of the different types of AI events found in the game is provided below.

### 3.2.1. GUARD
This event handles AI requirements for guarding places on the map.

### 3.2.2. FORTIFICATION
This event handles the AI’s construction of Fortifications.

### 3.2.3. OFFENSIVE
This event handles AI requirements for preparing and executing operations such as launching a Union offensive into neutral Kentucky.

Generally the AI can manage offensives without requiring scripts once it is at war with a country, providing it has built up the necessary units and any resources of lesser importance are added to the AI’s Exclusion Lists.

To view and amend the AI’s Exclusion Lists, click on Campaign \ Edit AI Scripts and then click on the Advanced button in the bottom right. Resources can then be excluded or included from each side’s lists, and it is recommended to start by excluding everything, and then when you run your tests, study the results as you selectively remove important resources from the Exclusion List.

**Info:** The AI will not declare war on neutral countries when the weather in the region is Rain, Snow or Sandstorms.

### 3.2.4. AMPHIBIOUS
This event handles the AI’s launching of amphibious landings, and the AI will automatically try to assign a HQ to this script.

### 3.2.5. TRANSPORT
This event handles the AI’s transporting of units from Port to Port on the map, and the AI will automatically try to assign a HQ to this script.
3.2.6. Amphibious Minor
This event handles the AI’s launching of amphibious landings, but without using a HQ.

3.2.7. Transport Minor
This event handles the AI’s transporting of units from Port to Port on the map, but this will not move HQs.

3.2.8. Fleet
This event handles the AI’s naval movements and offensives.

3.2.9. Purchases
This event handles AI purchases on a turn-by-turn basis.

Units that have been destroyed will only be rebuilt if there is a matching Purchase script entry for this unit type. However, if there are no Purchase scripts for the country whose unit has been destroyed, then this rule doesn’t apply, for instance you don’t need to create Purchase scripts for all Minors in the game, as the AI can attempt to rebuild their destroyed units without a script being in place for that Minor.

3.2.10. Diplomacy
This event handles AI diplomacy allocation on a turn-by-turn basis.

3.2.11. Research
This event handles AI research allocation on a turn-by-turn basis.

3.3. Suggestions For Creating a New Campaign
The Editor is a powerful tool not only for adjusting the current campaigns, but also for creating brand new ones. You can try your hand at reproducing old favorites or developing completely new campaigns using the Strategic Command game engine. The possibilities are virtually endless!

This game's mechanics for combat, economics, diplomacy and research can be applied to a very wide range of conflicts. The Editor is flexible enough to
allow a significant amount of customization for other time periods, and for virtually any scale and scope.

### 3.3.1. Develop a Design

The first step for creating a new campaign is to decide what the fundamental elements of your design are going to be. You may already have an idea about the time period, the location, and the forces involved.

Now you need to decide on some specifics for your game. How big do you want your map to be? How long should each game turn last? What size should your combat units be: Corps or Divisions for operational campaigns, or something smaller for tactical battles? How complex your game will be and how long it may take to play will depend on what you decide at the outset.

Once you determine how large your map needs to be, start a new campaign by selecting File → New as described above in the Creating a New Campaign section. Here you can define your new map size and begin filling in the various map layers using the instructions and tips provided.

You may also want to use the Import Data menu to select items and settings from a pre-existing campaign for re-use in your own campaign, since editing existing data is generally easier than starting from scratch. Save your new campaign with its own name to create a new sub-directory for it with its own campaign.ini file.

### 3.3.2. Customize Your Campaign

Once you’ve saved your new campaign, in the Campaigns directory there will be a sub-directory for your new campaign, and within this sub-directory you will find a campaign.ini file containing the lines:

```ini
#CUSTOM_BITMAPS=1
#CUSTOM_INTERFACE=1
#CUSTOM_SOUND=1
#CUSTOM_MUSIC=1
#CUSTOM_FONTS=1
#CUSTOM_LOCALIZATION=1
```

The setting of = 1 means that the campaign will automatically use any
custom files and localization that you add to it. Changing any to = 0 means that the campaign would not use any custom settings for the relevant field.

#CUSTOM_BITMAPS= 1

To use custom bitmaps you will need to create a Bitmaps sub-directory within your custom campaign directory for your customized items. Then copy the original default Bitmaps file(s) that you wish to amend, pasting them into your campaign's own Bitmaps sub-directory, and amend the new file. The game will then use these customized items instead of the default image files.

Caution: Be very careful when editing image files, as you do not want to amend the original files that come with this game. Make sure that you are editing copies, rather than the originals themselves. Making backups as you work is also recommended.

#CUSTOM_INTERFACE= 1

You can customize the images used in the game interface, such as having alternate flag_sprites for the Major countries involved in your campaign or just changing the appearance of the interface. You will need to create an Interface sub-directory within your custom campaign directory for your customized items. Copy over the original files that you wish to amend from the game's interface folder and paste them into this new sub-directory. The game will then use these customized items instead of the default ones.

#CUSTOM_SOUND= 1

To use custom sound files you will need to create a Sound sub-directory within your custom campaign directory for your customized items. Place your edited .ogg files there. The game will then use these customized items instead of the default .ogg files.

#CUSTOM_MUSIC= 1

To use custom music you will need to create a Music sub-directory within your custom campaign directory for your customized items. Place your edited .ogg files there. The game will then use these customized items instead of the default .ogg files.

#CUSTOM_FONTS= 1

To use custom fonts you will need to create a Fonts sub-directory within your custom campaign directory for your customized items. Place your custom
.ttf or .otf files there. You may need to right click and install these fonts onto your system and then the Editor will list these customized items when editing the text layer of the campaign. The customized fonts will then show in game when you load the campaign.

**Note:** A warning message will let you know if you have done something wrong when attempting to load a campaign using any of the above customizations.

#CUSTOM_LOCALIZATION=1

Custom localization means that you will be able to rename many of the game’s elements, including the names of countries, unit types, research categories, etc.

To do this you will need to create a new localization.txt file within the custom campaign sub-directory for your customized items.

You can do this by copying some or all of the original localization.txt file from the game’s main directory into your custom campaign sub-directory. The “#NAME=” items are all names used by the game engine code itself and cannot be edited, but any or all of the text names to the right of the “=” sign can be edited.

It is strongly recommended to only include entries in your localization.txt file where you are using an edited entry, as otherwise the load time for turns could increase unnecessarily if more entries are included than are needed. The game will then use these customized items instead of the default text names.

**Example:** Consider a Roman game with Rome instead of the Union, and Legions instead of Cavalry. In the combat target dialog and properties dialog sections of the localization.txt file, change Cavalry Attack to Legion Attack. In the terrain dialog, change Cavalry Defense to Legion Defense. In the Country IDs, change Union to Rome. In the Unit IDs, change Cavalry to Legion. In the Research IDs, change Cavalry Equipment to Legion Equipment, and so on.

### 3.3.3. ADD YOUR OWN MEDIA

Adding images to the campaign to provide historical ambience or information for players can be very useful, and the image guidelines are as follows:
- Save all image files as .png files
- The size of the image should be 732 x 412 pixels
- Save them in a Media folder inside the subfolder for your campaign
- Type the name of the image you wish to use, including the file extension (i.e. .png) into the relevant script's row #IMAGE=. More than one image name can be typed here, separating them with a comma, and the engine will choose at random an image to show whenever the script fires.

Use the images within the default Media folder, found within the installation folder, as a guide. Any suitable images can be re-used in your own campaign.

Adding sound to the campaign can also be useful, and the sound guidelines are as follows:
- Save all sound files as .ogg files
- Save them in a Media folder inside the subfolder for your campaign
- Type the name of the sound you wish to use, including the file extension (i.e. .ogg) into the relevant script's row #SOUND=. More than one sound name can be typed here, separating them with a comma, and the engine will choose at random a sound to play whenever the script fires.

3.3.4. Playtest Your Campaign
Getting your map and unit counters to look good is easy enough if you have some artistic skills, and even if you aren’t very artistic, you might be surprised at how much you can do!

Getting your new game design to work smoothly will require some more effort, especially if you are making significant changes to the default values of the original game.

A good rule of thumb is to start simple, and then gradually add desired complexity. First verify that your basic features work as desired and then slowly build in more advanced features. If you try to do too much too fast, it may be very difficult to determine how to resolve a complex problem with your game design.

So, if designing a new campaign totally from scratch, it’s best to start with just one section of the map roughly worked out. Use this area as a combat
testing ground to check that things like the map scale, the unit density you have in mind and the essential combat values of those units are in line with your desired result.

Once your game is running smoothly and you have had time to evaluate its strengths and weaknesses, further adjustments for play balance and variability can be made. Take your time and have some fun with the game design process!

If there are any special instructions or information a player will need to know about your campaign, it will be best to include a separate readme.txt file containing these in your Campaign’s folder.

3.4. FURTHER ADVICE & INFORMATION

3.4.1. TEXT ON THE MAP EDGE

On the left edge of the map (the y axis) there is a restriction in place to prevent any text being added that couldn’t be read by the game engine, as it would be outside the readable area.

3.4.2. UNUSED TERRAIN SPRITES

Some terrain sprites have not been utilized for this release, and these have a large red X through them within the sprite file. These sprites are available for modding use, and will be used in future expansions as our range of official graphics is expanded.

3.4.3. DESIGN PARAMETERS

As previously discussed in the above sections, the Campaign Editor does have some parameters for campaign design. In summary:

- The minimum map size is 10x10 hexes. The maximum map size is 512x256 hexes.
- As a minimum requirement, there MUST be at least one fully activated Union or Confederate Major country. Also, all Minor countries MUST have both a Union and Confederate parent defined.
The game will support a maximum of 120 countries, of which 10 can be Majors, the rest being Minors, and their names can be defined in the localization.txt file.

All countries represented on the map MUST have a Capital, and they can only have one active Capital at a time during a game.

Campaigns may be set to run through any dates from year 0 to 9999, and the campaign end date must be greater than the start date.

3.4.4. Testing the AI in Game

There are 3 standard features available via the F1, F2, and F3 keys that can be used when developing and testing AI scripts in game.

F1 creates a DEBUG subfolder in the “SAVE” directory that creates saved game files for each turn played by both you and the AI. This can be a useful reference for when you see the AI do something unexpected, as you can easily use the save file to load up the turn again to re-watch the AI’s maneuvers in action.

These files will be saved in the following folder:
\Users\<username>\Documents\My Games\Strategic Command American Civil War\Save\DEBUG

F2 creates a DEBUGLOGS folder with files that keeps track of AI Planning, Research and Diplomacy investments as well as turn-by-turn Weather information. In addition, it creates a summaries.log file which lists all the losses, military activity, and research activity for each turn for easy reference.

These files will be saved in the following folder:
\Users\<username>\Documents\My Games\Strategic Command American Civil War\DEBUGLOGS

F3 triggers the AI to play against itself. This is very handy whenever you would like to see just how balanced your AI scripts are for both sides and/or if you quickly want to observe your AI planning from both sides. This button can be turned on before or during game play. If you press it before selecting any campaigns then the AI will play itself right from the very first turn, and you can sit back and watch or just review its progress periodically to see if things are roughly in line with your expectations.
4. BEYOND THE CIVIL WAR

Due to the less advanced technology available to the combatants, warfare during the 19th century requires less variety in units when compared to the conflicts of the 20th century.

Strategic Command American Civil War was developed from the same engine used to create the earlier titles in the Strategic Command 3 series, and players familiar with the previous games will notice that there are a number of mechanics used in those games that have not been used in the default content for American Civil War: there’s not much use for Fighters or Tanks when neither would be invented until half a century later. Fortunately, we have sought to keep as many of these mechanics in the game engine as possible in case they prove useful to other scenario designers who would like to take advantage of the new features offered in American Civil War.

Note that all of the leftover mechanics in this section have been carried over directly from WWII: War in Europe and will behave exactly as in that game except where otherwise noted. To keep this manual focused on the mechanics seen in American Civil War specifically, ‘leftovers’ such as air units will not be described in this manual, and you are encouraged to read the manual for WWII: War in Europe for further information on these.

In the script files for 1861 Blue and Gray and the other default campaigns, there may be occasional references to ‘Axis’ and ‘Allied’ nations. This is merely a consequence of Strategic Command’s origins as a WWII game, and will not adversely affect gameplay or scenario design in any way. In 1861 Blue and Gray, we have used the ‘Axis’ (that is, blue or “1”) side to represent the Union, and the ‘Allied’ (red/”2”) side for the Confederacy.

4.1. UNUSED UNITS

The following unit categories have not been used in the American Civil War game and retain the same characteristics as they had in WWII: War in Europe. Note all Unit IDs listed here are the same as those used in the game’s scripts and localization files (eg. HQ is 0, Regiment is 1 etc).
- 15= Anti-Air
- 16= Rocket Artillery
- 21= Rockets
- 22= Reconnaissance
- 24= Anti-Tank
- 25= Light Tanks
- 26= Tanks
- 27= Heavy Tanks
- 29= Fighters
- 30= Tactical Bombers
- 31= Medium Bombers
- 32= Strategic Bombers

American Civil War also introduced new Target Type categories, as well as rendering some unnecessary for this game, which have been renamed as `-`. Around line 2050 in the game’s localization file, those unused categories can be reintroduced to the game with the following names:

- #TARGET_TYPE_TANK= Tank
- #TARGET_TYPE_FIGHTER= Fighter
- #TARGET_TYPE_BOMBER= Bomber
- ...
- #TARGET_TYPE_ANTI-AIR= Anti-Air

The Anti-Air category will be used by Unit ID 15, the Tank category by 21, 22, 24, 25, 26 and 27, the Fighter category by 29, and the Bomber category by 30, 31 and 32. Note that Unit ID 16 uses the Artillery category (which it shares with some default American Civil War units).

Note that the former aircraft carrier category is also referenced in the localization file, however there are no units associated to this category and the American Civil War engine does not allow for aircraft carrier units. Similarly, Unit ID 9, which represented Paratroops in War in Europe, and Unit ID 34, which represented Kamikazes, cannot be used in this way in American Civil War as they have been replaced with the Indian and Cruiser units respectively and the associated functionality removed.
4.2. Convoy Raiders

In both WWII: War in Europe and American Civil War, some types of naval units can be used to raid convoy routes. In American Civil War, all naval units have this functionality, although some (such as Submarines) do not take advantage of this by default, it is possible to enable raiding for any of the naval units included in American Civil War by adjusting their Raid Multiplier (MPPs), which can be found in the Combat Target Data menu, which is accessed through Country Data. This is also true for those naval unit types whose Unit IDs did not correspond to naval units in previous games, such as Battleships and Cruisers.

4.3. Research Changes

Although American Civil War includes a wide range of new technology types to research, there have been no changes to the underlying research system in this game, and it remains theoretically possible to change all technologies in the game to behave exactly as they did in WWII: War in Europe by editing the various values in Research Data and its sub-menus. While it is not the role of this section to detail every change that would need to be made to do so, the following may be of particular interest to designers wishing to use some of the options offered on the Advanced Research Data screen (which is found by accessing Research Data, then ‘Advanced’):

‘Subs’ refers to the chance that subs will dive for each level of the technology assigned to RESEARCH_ID 7. In American Civil War this is the Buoyancy Tanks upgrade, while in War in Europe it was called Advanced Subs.

ASW refers to the reduction of the chance that an enemy sub will dive per each level of the technology assigned to RESEARCH_ID 12. In American Civil War this slot is used by the Fort Modernization upgrade (and in the default campaigns it is set to zero as it is not relevant to the game). In War in Europe this was the Anti-Submarine Warfare tech.

The four options listed under ‘Increments’ behave identically to their War in Europe counterparts.

The six units under the Accuracy Loss section, reading down and then to the right, are Unit IDs 16, 17, 18, 19, 20 and 21.
5. CREDITS

FURY SOFTWARE

Game Design
Hubert Cater

Associate Game Design
Bill Runacre, Ryan O’Shea

Programmer
Hubert Cater

Assistant Programmer
Bill Macon

Campaign and Scenario Design
Ryan O’Shea

Development Testers
Dan Fenton, Michael Kollmann, Beriand, Old Crow Balthazor, JWW, Parat, redrum68, The Land, lionel1957, Fafnir, gwgardner

User Manual and Layout
Ryan O’Shea, Bill Runacre, Myriam Bell

Editing
Bill Runacre

Sounds
Matt Faller

Music
Daniel Sadowski

Artwork and Graphic Design
Jean-Vincent Roy, Wastelands Interactive, Adriana Bienati

Special Thanks
Coral Bliss, Eddie Cater, Sophia Cater, Claudia Petracca
Matrix Games

CEO
Iain McNeil

CFO
JD McNeil

CMO
Marco A. Minoli

Technical Director
Philip Veale

Creative Director
Richard Evans

CEO, Matrix Games LLC
Erik Rutins

Executive Producer
David Sharrock

Producers
Mark Hardisty, Neil McKenna

Project Manager
Josh Fan

Associate Producers
Jenny Zsibrita, Sam O’Neill

Assistant Producer
Anny Sims

Senior Brand Manager
Giulia Sellitto, Alberto Casulini

Brand Manager
Roberto Neri

Junior Brand Manager
Marco Tonello

Social Media Strategist
Vincenzo Fallara
**E-commerce Manager**
Giulia Costa

**Media Relations**
Paolo Paglianti

**Production Design**
Adriana Bienati

**Lead Artist**
Pat Ward

**Artist**
Koen Bikkema

**Manual Layout**
Myriam Bell

**Operations Lead**
Matthew Ravenwood

**Operations Team**
Joseph Stephenson, Callum Morris

**Head of Accounts**
Dean Walker

**Admin Assistant**
Richard Baker

**HR Manager**
Kayleigh Lawrence

**Customer Support Staff**
Paulo Costa, Joseph Miller

**Web Development**
Valery Vidershan, Andrea Nicola, Fernando Turi, Yurri Shmeloyv